Information in this manual is subject to change without notice and does not represent a commitment on the part of Cutler-Hammer, Inc. The software described in this manual is furnished under a license agreement. The software may be used or copied only in accordance with the terms of the agreement. It is against the law to copy the software on any medium except as specifically allowed in the agreement. No part of this manual may be reproduced or transmitted in any form or by any means, electronic, mechanical, photocopying, recording or otherwise, without prior written permission of Cutler-Hammer, Inc.

REstricted Rights LEGend

Use, duplication, or disclosure by the Government is subject to restrictions set forth in paragraph (b)(3)(B) of the Rights in Technical Data and Computer Software clause of DAR 7-104.9(a). Contractor/Manufacturer is Cutler-Hammer, P.O. Box 6166, Westerville, OH 43086-6166.

TRADEMARKS

AcceleratI/On is a trademark of Cutler-Hammer, Inc.
TouchPanel is a trademark of Cutler-Hammer, Inc.
PowerBlink is a trademark of Cutler-Hammer, Inc.
PowerAnimation is a trademark of Cutler-Hammer, Inc.
PowerGraphics is a trademark of Cutler-Hammer, Inc.
PanelMate is a registered trademark of Cutler-Hammer, Inc.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
Modbus is a trademark of Schneider Automation Inc.
Remote I/O, DH-485, Data Highway, and Data Highway Plus are trademarks of Allen-Bradley Company, Inc.
GEnergy I/O is a trademark of GE Fanuc Automation North America, Inc.
DCS-NET is a trademark of Reliance Electric Company.

Commercial names of products from other manufacturers or developers that appear in this manual are registered or unregistered trademarks of those respective manufacturers or developers, which have expressed neither approval nor disapproval of Cutler-Hammer products.

Copyright Cutler-Hammer, Inc. 1997. All rights reserved.

Printed in the United States of America.

P/N 01-00384-00
# Table of Contents

**PREFACE** .......................................................................................................................... I

ABOUT THIS MANUAL ........................................................................................................ II

Purpose ....................................................................................................................... II

What’s Inside .......................................................................................................... II

**SUPPORT SERVICES** .................................................................................................. III

1. INSTALLING THE CONFIGURATION SOFTWARE ................................................. 1

INSTALLING THE CONFIGURATION SOFTWARE .................................................. 2

PRODUCT OPTIONS .............................................................................................. 3

2. MAIN SCREEN ........................................................................................................... 5

MAIN SCREEN ......................................................................................................... 6

FILE MENU ............................................................................................................ 7

Open Database ..................................................................................................... 9

Upgrade Database .......................................................................................... 10

Backup Database ........................................................................................... 11

Save As ............................................................................................................. 12

Conversion ....................................................................................................... 13

Verify Application ............................................................................................ 15

Import ............................................................................................................... 16

Export .............................................................................................................. 18

Export As ......................................................................................................... 19

Configuration Editor Reports ............................................................................. 26

EDIT MENU .......................................................................................................... 31

OBJECT MENU ................................................................................................... 33

Object Properties ............................................................................................ 35

Make Symbol .................................................................................................. 39

VIEW MENU ...................................................................................................... 41

WINDOW MENU .................................................................................................. 42

HELP MENU ....................................................................................................... 43

About PanelMate Configuration Editor .............................................................. 44

TOOLBAR ......................................................................................................... 45

COLOR SELECTION PALETTE ........................................................................... 47

STATUS BAR ....................................................................................................... 48
<table>
<thead>
<tr>
<th>TOOL PALETTE</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection Tool</td>
<td>50</td>
</tr>
<tr>
<td>Reshape Tool</td>
<td>50</td>
</tr>
<tr>
<td>Line Tool</td>
<td>51</td>
</tr>
<tr>
<td>Rectangle Tool</td>
<td>51</td>
</tr>
<tr>
<td>Ellipse Tool</td>
<td>51</td>
</tr>
<tr>
<td>Arc Tool</td>
<td>51</td>
</tr>
<tr>
<td>Polygon Tool</td>
<td>52</td>
</tr>
<tr>
<td>Text Tool</td>
<td>52</td>
</tr>
<tr>
<td>Symbol Tool</td>
<td>52</td>
</tr>
<tr>
<td>Select Symbol</td>
<td>53</td>
</tr>
<tr>
<td>Bitmap Tool</td>
<td>54</td>
</tr>
<tr>
<td>Indicator Template Tool</td>
<td>55</td>
</tr>
<tr>
<td>Readout Template Tool</td>
<td>55</td>
</tr>
<tr>
<td>Bar Template Tool</td>
<td>55</td>
</tr>
<tr>
<td>Bar Trend Template Tool</td>
<td>55</td>
</tr>
<tr>
<td>Table Template Tool</td>
<td>56</td>
</tr>
<tr>
<td>Line Trend Template Tool</td>
<td>56</td>
</tr>
<tr>
<td>Display Template Tool</td>
<td>56</td>
</tr>
<tr>
<td>Variable-Sized Indicator Template Tool</td>
<td>56</td>
</tr>
<tr>
<td>Variable-Sized Bar Template Tool</td>
<td>57</td>
</tr>
<tr>
<td>Variable-Sized Readout Template Tool</td>
<td>57</td>
</tr>
<tr>
<td>Variable-Sized Display Template Tool</td>
<td>57</td>
</tr>
<tr>
<td>Variable-Sized Graphic Template Tool</td>
<td>57</td>
</tr>
<tr>
<td>Variable-Sized Control Button Tool</td>
<td>57</td>
</tr>
</tbody>
</table>

3. DATABASE TREEVIEW WINDOW ................................................. 59

<table>
<thead>
<tr>
<th>DATABASE TREEVIEW WINDOW</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Configuration</td>
<td>60</td>
</tr>
<tr>
<td>New Configuration Page</td>
<td>62</td>
</tr>
<tr>
<td>Configuration Properties</td>
<td>65</td>
</tr>
<tr>
<td>Page Properties</td>
<td>69</td>
</tr>
</tbody>
</table>

4. FONT EDITOR ................................................................. 77

<table>
<thead>
<tr>
<th>FONT EDITOR</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>English Font</td>
<td>78</td>
</tr>
<tr>
<td>Danish1 Font</td>
<td>81</td>
</tr>
<tr>
<td>French1 Font</td>
<td>83</td>
</tr>
</tbody>
</table>
French2 Font.................................................................87
German1 Font ............................................................89
Spanish1 Font............................................................91
Swedish1 Font............................................................93
Graphic Font...............................................................95

5. SYMBOL LIBRARY .................................................................................97

  SYMBOL LIBRARY .................................................................................98
  Symbol Properties.................................................................100
  Symbol Origin........................................................................103

6. SYSTEM PARAMETERS ........................................................................107

  SYSTEM PARAMETERS ........................................................................108
  System Parameters – General Tab...........................................109
  System Parameters – Password Tab........................................113
  System Parameters – Communications Tab.............................117
  System Parameters – Remote Tab............................................120

7. PLC NAME AND PORT TABLE ..............................................................125

  PLC NAME AND PORT TABLE .........................................................126
  Port Settings............................................................................130
  Unsolicited Device................................................................131
  Generic Protocol....................................................................132
  AB DH-485 Maximum Node Address.......................................133
  Allen-Bradley Remote I/O Setup .............................................134
  GE Fanuc Genius I/O................................................................138
  Reliance DCSNet Interface Drop.............................................139
  DeviceNet Setup....................................................................140

8. MESSAGE LIBRARY ..............................................................................143

  MESSAGE LIBRARY ............................................................................144
  REGISTER REFERENCES WITHIN MESSAGES.................................148

9. SYSTEM ONLINE LABELS .................................................................157

  SYSTEM ONLINE LABELS .................................................................158
  System Online Labels – Miscellaneous Soft Key Prompts..........160
  System Online Labels – Maintenance Template Soft Key Prompts....162
  System Online Labels – User Entry Soft Key Prompts...............163
10. TEMPLATES ................................................................. 179

  INDICATOR TEMPLATE .......................................................... 180
  Indicator Template – Indicator Attributes Tab ................................ 181
  Indicator Template – Indicator States Tab .................................... 183
  Indicator Template – Control Definitions Tab ................................. 186

  READOUT TEMPLATE ............................................................ 188
  Readout Template – Readout Attributes Tab ................................ 189
  Readout Template – Expressions Tab .......................................... 191
  Readout Template – Control Definitions Tab .................................. 195

  BAR TEMPLATE ......................................................................... 200
  Bar Template – Bar Attributes Tab ............................................. 201
  Bar Template – Expression Tab ................................................. 203
  Bar Template – Control Definitions Tab ....................................... 207

  TABLE TEMPLATE .................................................................... 212
  Table Template – Table Attributes Tab ....................................... 213
  Table Template – Table Entries Tab ........................................... 217

  BAR TREND TEMPLATE .......................................................... 220
  Bar Trend Template – Bar Trend Attributes Tab ............................. 221
  Bar Trend Template – Expressions Tab ........................................ 225
  Bar Trend Template – Control Definitions Tab ............................... 230

  LINE TREND TEMPLATE ......................................................... 235
  Line Trend Template – Line Trend Attributes Tab ........................... 236
  Line Trend Template – Pen Definitions Tab ................................... 240
  Line Trend Template – Control Definitions Tab .............................. 244

  DISPLAY TEMPLATE ............................................................. 247
  Display Template – Display Attributes Tab ................................... 248
  Display Template – Expressions Tab .......................................... 250
  Display Template – Control Definitions Tab ................................... 254
11. VARIABLE-SIZED TEMPLATES ............................................................... 257

Variable-Sized Indicator Template ............................................................ 258
Variable-Sized Indicator Template – VS Indicator Attributes Tab ............... 259
Variable-Sized Indicator Template – VS Indicator States Tab ..................... 261

Variable-Sized Bar Template ................................................................. 264
Variable-Sized Bar Template – VS Bar Attributes Tab ............................... 265
Variable-Sized Bar Template – Expressions Tab ...................................... 267
Variable-Sized Bar Template – Control Definitions Tab ............................ 271

Variable-Sized Readout Template ............................................................ 277
Variable-Sized Readout Template – VS Readout Attributes Tab ................. 278
Variable-Sized Readout Template – Expression Tab ................................. 281
Variable-Sized Readout Template – Control Definitions Tab .................... 284

Variable-Sized Display Template ........................................................... 291
Variable-Sized Display Template – VS Display Attributes Tab .................. 292
Variable-Sized Display Template – Expressions Tab ............................... 294
Variable-Sized Display Template – Control Definitions Tab ..................... 299

Variable-Sized Graphic Template ............................................................ 301
Variable-Sized Graphic Template – VS Graphics Attributes Tab ................. 302
Variable-Sized Graphic Template – VS Graphic States Tab ....................... 304
Variable-Sized Graphic Template – Control Definitions Tab .................... 307

Variable-Sized Control Button Template .................................................. 310
Variable-Sized Control Button Template – VS Control Button Attributes Tab 312
Variable-Sized Control Button Template – Control Definitions Tab ............ 314

APPENDIX A: CONDITIONAL EXPRESSION OPERATORS............................. 317

Conditional Expression Operators ........................................................... 318
Conditional Expression Examples ............................................................ 319

APPENDIX B: COMMUNICATION DRIVER HELP FILES.............................. 323

Communication Driver Help Files ............................................................ 324

APPENDIX C: PLC COMMUNICATION GUIDELINES................................... 325

Plc Communication Guidelines ................................................................. 326

APPENDIX D: WORD AND BIT REFERENCES............................................ 327

Word and Bit References ............................................................................. 328
Plc Word References .................................................................................... 328
Plc Bit References ....................................................................................... 331
Preface

Welcome to Cutler-Hammer’s PanelMate Power Series/PC Configuration Editor User’s Guide. This chapter describes the contents of this manual and provides information on Support Services.
About This Manual

Purpose

This manual focuses on describing the features of the PanelMate Power Series and PanelMate PC Configuration Software.

What’s inside

This manual is organized in the following way:

Preface
Chapter 1: Installing the Configuration Software
Chapter 2: Main Screen
Chapter 3: Database Treeview Window
Chapter 4: Font Editor
Chapter 5: Symbol Library
Chapter 6: System Parameters
Chapter 7: PLC Name and Port Table
Chapter 8: Message Library
Chapter 9: System Online Labels
Chapter 10: Templates
Chapter 11: Variable-Sized Templates
Appendix A: Conditional Expression Operators
Appendix B: PLC Driver Help Files
Appendix C: PLC Communication Guidelines
Appendix D: Word and Bit References
Appendix E: Using Graphics from other Software
Appendix F: Editing Graphics
Appendix G: Configuration Editor Problems
Support Services

It is Cutler-Hammer’s goal to ensure your greatest possible satisfaction with the operation of our products. We are dedicated to providing fast, friendly, and accurate assistance. That is why we offer you so many ways to get the support you need. Whether it’s by phone, fax, modem, or mail, you can access Cutler-Hammer support information **24 hours a day, seven days a week**. Our wide range of services include:

**Technical Support** 1-800-809-2772

If you are in the U.S. or Canada, you can take advantage of our toll-free line for technical assistance with hardware and software product selection, system design and installation, and system debugging and diagnostics. Technical support engineers are available for calls during regular business hours (8 am - 5:30 pm EST) by calling 1-800-809-2772. International calls can be made to either the Tech Line at 1-800-809-2772 (toll call) or the Cutler-Hammer main business line at 614-882-3282.

**Emergency Technical Support** 1-800-809-2772

Because machines do not run on a nine-to-five schedule, we offer emergency after-hours technical support. A technical support engineer can be paged for emergencies involving plant down situations or safety issues. Emergency support calls are automatically routed directly to our answering service after-hours (5:30 pm - 8 am EST) and weekends. For emergency technical support, call 1-800-809-2772.

- Does not currently include product repairs or shipping outside normal business hours.

**Technical Support Fax** 614-882-0417

You can also contact our technical support engineers by faxing your support requests directly to APSC Westerville at 614-882-0417.

**Information Fax-Back Service** 614-899-5323

The latest Cutler-Hammer product information, specifications, technical notes and company news is available to you via fax through our direct document request service at 614-899-5323. Using a touch-tone phone, you can select any of the info faxes from our automated product literature and technical document library, punch in a fax number and receive the information immediately.
Bulletin Board Service 614-899-5209

Parameters: 8 data bits, 1 stop bit, parity none, 9600-28.8K baud.

If you have modem access, you can dial in directly to our electronic bulletin board service for the latest product and company information. File sharing, product software downloads and our user message service are just a few of the things you will find online at 614-899-5209.

Website and E-mail Address http://www.cutler-hammer.eaton.com
CSC@idt.ch.etn.com

If you have Internet capabilities, you also have access to technical information via our website at http://www.cutler-hammer.eaton.com. The website includes technical notes, frequently asked questions, release notes, and other technical documentation. This direct technical support connection also offers you the ability to request assistance and exchange software files electronically. Technical support messages and files can be sent to CSC@idt.ch.etn.com.

Software Update Service 1-800-809-2772
FAX 614-899-4141

We also offer you the opportunity to take advantage of software upgrades, advanced software notices, and special software promotions through our Software Update Service. When you register your software, you will receive one-year of free or reduced-price upgrades along with all the other benefits of membership, including 48-hour shipping of software upgrades. Contact the Software Update Service at 1-800-809-2772 or fax 614-899-4141.

Repair and Upgrade Service 614-882-3282 ext. 7601
FAX 614-882-3414

Our well-equipped Customer Service department is ready to assist you with repairs, upgrades, and spare parts services. If a situation arises where one of these services is needed, just call 614-882-3282 x7601 or fax 614-882-3414.

Product Ordering Service 614-882-3282
FAX 614-882-6532

Authorized Cutler-Hammer distributors may place product orders directly with our Order Processing department by calling 614-882-3282 x406 or faxing 614-882-6532. For information on your local distributor, call the Cutler-Hammer Tech Line.
Customer Support Center
1-800-356-1243

Authorized Cutler-Hammer distributors and Cutler-Hammer sales offices can get assistance for Cutler-Hammer standard and component product lines through the Customer Support Center. Call the Customer Support Center for the following assistance:

1. Stock availability, proof of shipment, or to place an order.
2. Expedite an existing order.
3. Product assistance and product price information.
4. Product returns other than warranty returns.

For information on your local distributor or sales office, call the Cutler-Hammer Tech Line at 1-800-809-2772.

Correspondence Address
Cutler-Hammer
173 Heatherdown Drive
Westerville, OH 43081
Installing the Configuration Software

In this chapter, you will learn:

- How to install the Configuration Software
- About the Product Options
Installing the Configuration Software

The Software Kit contains either a CD-ROM or floppy disks. For CD-ROM installation instructions, refer to the Install.txt file on the CD-ROM. For floppy disk installation instructions, refer to the paragraphs that follow.

Note that before installing the configuration software, make sure that you close all open applications.

The Configuration Software contains an installation program named Setup. Setup is on the diskette labeled “Configuration Software Disk 1”.

To install the Configuration Software on your hard disk, insert the diskette in your personal computer. If you are using Microsoft Windows, open the File Menu and select Run in the Program Manager. If you are using Microsoft Windows 95 or Microsoft Windows NT, press the Start button and select Run.

In the Run dialog box, type:

```
drive:\SETUP
```

in the Command Line entry field, where drive is the letter of the floppy drive that contains the diskette. Choose the OK button.

When the Welcome dialog box appears, read the message and press the Continue button. In the next dialog box, register the software by entering your name and your company name and press the Continue button.

In the Installation Options dialog box, you can change the installation directory and perform a full or custom installation. If you wish to change the installation directory, press the Change Directory button. If you wish to customize the installation, you may de-select any of the subcomponents you do not wish to install.

Subcomponent files that can be selected or de-selected for a custom installation are:

- Configuration Software files
- Configuration Database files
- Transfer Utility files
- Executive Firmware files
- PanelMate PC Runtime files

After selecting the directory and subcomponent files to install, press the Install button. When the installation is finished, press the Yes button in the Question dialog box to view the readme.txt file. The readme.txt file will list all the issues addressed from the previous version of software, list the enhancements to the current version of software, and list new issues with the current version of software. After viewing the readme.txt file, press the OK button in the Installation Complete dialog box.

Tip
A custom installation will reduce both the amount of disk space consumed and the time required for installation.

Tip
Cutler-Hammer recommends that you reboot your system after the software installation is completed.
Product Options

The following product options can be purchased from Cutler-Hammer. If you have purchased the option, the option must be selected in the **New Configuration** dialog box or the **Page Properties** dialog box in the configuration software.

**Color Display**

The Color Display Option allows you to select a color configuration.

The Color Display option is a standard feature for the PanelMate Power Series 4000, PanelMate Power Series 5000, and PanelMate PC unit.

**High Capacity Unit**

The High Capacity Unit option allows you to create a larger number of pages and messages than permitted in the Standard Capacity PanelMate unit. Refer to the table below.

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Number of Pages</th>
<th>Number of Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelMate Power Series 1500</td>
<td>10</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 1500 High Capacity</td>
<td>50</td>
<td>2500</td>
</tr>
<tr>
<td>PanelMate Power Series 2000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 2000 High Capacity</td>
<td>100</td>
<td>2500</td>
</tr>
<tr>
<td>PanelMate Power Series 3000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 3000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate Power Series 4000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 4000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate Power Series 5000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 5000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate PC</td>
<td>100</td>
<td>5000</td>
</tr>
</tbody>
</table>

The High Capacity Unit option is a standard feature for the PanelMate PC unit.

**Advanced Trending Template**

The Advanced Trending Template option allows you to configure Advanced Trending Templates which display a history of a reference’s value over a period of time. Advanced trending features 6 pens that can be triggered by time or event.

For information on configuring an Advanced Trending Template, refer to the **Line Trend Template** topic.

The Advanced Trending Template option is a standard feature for the PanelMate PC unit.
Allen-Bradley DH-485
The Allen-Bradley DH-485 option allows you to communicate to the Allen-Bradley DH-485 Highway.

The Allen-Bradley DH-485 option is not available for the PanelMate PC at this time.

Modicon Modbus
The Modicon Modbus option allows you to communicate to Modicon PLCs via the Modicon Modbus.

The Modicon Modbus option is not available for the PanelMate PC at this time.

Dynamic Graphics
The Dynamic Graphics option allows symbols to change colors and shapes dynamically on PanelMate Power Series 1500 models.

256 Greyscale/Color (Model 1555/1575)
The 256 Greyscale/Color (Model 1555/1575) option enhances the PanelMate Power Series 1500.

If you have a PanelMate Power Series 1500 (Model 1555) and you install the 256 Greyscale/Color option, you will have 16 shades of gray (instead of the standard 8 shades), PowerAnimation, and PowerBlink.

If you have a PanelMate Power Series 1500 (Model 1575) and you install the 256 Greyscale/Color option, you will have a 256 color palette (instead of the standard 16 colors), PowerAnimation, and PowerBlink.

PowerAnimation allows you to create animation by defining a series of graphic objects that blink in sequence and PowerBlink allows you to create graphic objects that blink at different rates.

The 256 Greyscale/Color option is only available for the PanelMate Power Series 1500.
Main Screen

In this chapter, you will learn:

• About the Main Screen
• About the File Menu selections
• About the Edit Menu selections
• About the Object Menu selections
• About the View Menu selections
• About the Window Menu selections
• About the Help Menu selections
• About the Toolbar selections
• About the Color Selection Palette
• About the Status Bar
• About Tool Palette selections
Main Screen

The Main Screen appears when you run the PanelMate Configuration Editor.

The Database TreeView Window will appear on the Main Screen. For more information about the Database TreeView Window, refer to the Database Treeview Window topic.
Chapter 2: Main Screen

File Menu

Tip

When the database is open, the Database Treeview Window will appear.

The File menu varies depending upon whether the database is open.

If the database is not open, the following File Menu will appear.

If the database is open, the following File Menu will appear.
The selections in the File Menu are described below. Note that some of the selections are available from the toolbar. Refer to the toolbar topic for more information.

**Open Database:** Opens the Open Database dialog box and allows you to select a database.

**Backup Database:** Opens the Backup Database dialog box and allows you to backup your database.

**Close:** Closes the database.

**Save:** Saves the highlighted configuration to the database.

**Save As:** Opens the Save As dialog box. This selection is used if you wish to save a configuration to the database under a new name.

**Convert:** Opens the Conversion dialog box. This selection is used if you wish to convert a configuration from one model to another (e.g., PanelMate Power Series 2000 to PanelMate Power Series 3000).

**Verify:** Opens the Verify Application dialog box. This selection checks all PLC references and expressions.

**Import:** Opens the Import dialog box. This selection allows you to import the selected configuration file into the database.

**Export:** Opens the Export dialog box. This selection allows you to export the selected configuration file from the database to a current version configuration file.

**Export As:** Opens the Export As dialog box. This selection will export the selected configuration file from the database to an earlier version configuration file (e.g., V2.1X).

**VCP Transfer:** Executes the PanelMate Transfer software. This selection allows you to transfer configuration files, execute firmware, and drivers to and from the PanelMate unit.

**Print:** Opens the Configuration Editor Reports dialog box. This selection allows you to print a hard copy of the current configuration.

For information on printing an image of a configuration page, refer to the Printing a Configuration Page topic.

**Exit:** Ends the PanelMate Configuration Editor session.
Open Database

When you choose the Open Database dialog box from the File Menu, the Open Database dialog box will appear.

The Open Database dialog box allows you to select a PanelMate database. The default database (named model) is created during the installation process. The model database is actually a group of files located in the model subdirectory under the PanelMate Configuration Editor directory (c:\pmconfig by default). Many files (over a 100) make up a PanelMate database.

Other PanelMate databases can be accessed from the Open Database dialog box by selecting the drive and folder in which a valid PanelMate database resides. A single file from the database (pmconfig.db) indicates that the folder contains a viable database. Once a folder is selected which has a valid database and the OK button is clicked, the Configuration Editor will open the database, display the Database Treeview Window, and allow you to create or edit a configuration.

If you install new configuration software that has an upgraded database and attempt to open an earlier version of the database, the Upgrade Database dialog box will appear. (Note that not every new configuration software version will have an upgraded database.) The Upgrade Database dialog box allows you to upgrade any earlier version of the database to be compatible with the new configuration software. For more information on upgrading the database, refer to the Upgrade Database topic.

See the Configuration Editor Problems topic if problems are encountered when attempting to open a database.
Upgrade Database

If you install new configuration software that has an upgraded database and attempt to open an older version of the database, the Upgrade Database dialog box will appear. (Note that not every new configuration software version will have an upgraded database.)

The Upgrade Database dialog box allows you to upgrade any earlier version of the database to be compatible with new configuration software. The default upgrade directory is created by adding the subdirectory \backup\v320cfgs to your current database directory. Make sure you store the original database to a directory other than the standard backup directory used in the Backup Database dialog box. To change the upgrade directory, click on Directory to upgrade database button and enter the directory pathname.

Press the Upgrade button to upgrade your database. When completed, a Print button will appear to allow you to print the upgrade progress.
Backup Database

When you choose the **Backup Database** dialog box from the File Menu, the **Backup Database** dialog box will appear.

The **Backup Database** dialog box allows you to backup your database. The default backup directory is created by adding the subdirectory `\backup\v330cfgs` to your current database directory. To change the backup directory, click on **Directory to backup database** button and enter the directory pathname.

Press the **Backup** button to backup your database. When completed, a **Print** button will appear to allow you to print the backup progress.
Save As

When you select a configuration filename in the Database Treeview Window and choose the Save As selection from the File Menu or click on the Save button in the tool palette, the Save As dialog box will appear.

The Save As dialog box allows you to save a configuration file. This selection is used if you are saving a new configuration or if you wish to save a configuration under another name.
Conversion
When you select a configuration filename in the Database Treeview Window and choose the Convert selection from the File Menu, the Conversion dialog box will appear.

This Conversion dialog box allows you to convert a configuration file from one PanelMate hardware model to another (e.g., PanelMate Power Series 2000 to PanelMate Power Series 3000). If there are any conversion issues between PanelMate models, a dialog box will appear which will state the issues and ask if you wish to continue with the conversion. If you press the Yes button to continue, be aware of the issues noted in the dialog box.
When converting a PanelMate Power Series 2000, PanelMate Power Series 3000, PanelMate Power Series 4000, PanelMate Power Series 5000, or PanelMate PC configuration to a PanelMate Power Series 1500 configuration, note the following items.

- If your configuration has PowerGraphics, the graphics cannot be converted unless the PanelMate Power Series 1500 has the PowerGraphics option installed.

- If your configuration exceeds the capacity of the standard PanelMate Power Series 1500, but does not exceed the capacity of the expanded PanelMate Power Series 1500, the Capacity Expansion Kit option will be selected in the New Configuration dialog box for the converted configuration.

- If your configuration exceeds the capacity of the expanded PanelMate Power Series, an error message will be displayed and the configuration will not be converted.

- The standard PanelMate Power Series 1500 does not have the Capacity Expansion Kit option.

- The expanded PanelMate Power Series 1500 does have the Capacity Expansion Kit option.

Tip

Refer to the Product Options topic for more information about the Capacity Expansion Kit.
Verify Application
When you select a configuration filename in the Database Treeview Window and choose the Verify selection from the File Menu, the Verify Application dialog box will appear.

The Verify selection checks all PLC references and expressions in all configured dialog boxes and lists all invalid or illegal PLC references and expressions which would prevent a valid export.
Import

When you choose the Import selection from the File Menu, the Import dialog box will appear.

The Import dialog box allows you to import a configuration file into the database. Note that earlier PanelMate Power Series configuration files and PanelMate Series V2.1X configuration files may also be imported.

PanelMate Series V2.1X configuration files will have one of the following extensions:

- PanelMate Series 2000 Grayscale .PC1 or .PC2
- PanelMate Series 2000 Color .PC5 or .PC6
- PanelMate Series 3000 Grayscale .PC1 or .PC2
- PanelMate Series 3000 Color .PC5 or .PC6
- PanelMate Series 4000 .PC3 or .PC4
The Import selection and Export selection in the File Menu may be used to copy configurations from one personal computer to another. After export, a configuration (.PPS file) can be copied to another computer and imported into another PanelMate database. When using this method to copy configurations, please note the following issues:

- Test message numbers in Display Templates and Variable-Sized Display Templates are not exported. Therefore, all test message numbers in an imported configuration are set to zero (0).
- Group attributes are not exported. If a configuration had groups prior to export, the imported configuration would show all objects ungrouped.
- The displayed states for Indicator, Variable-Sized Indicator, and Variable-Sized Graphic Templates are not exported. On import, the selected state of Variable-Sized Indicators is set to state one (1), and Indicator Templates and Variable-Sized Graphic Templates are set to state five (5).

An alternate method for copying configurations from one system to another is by copying all database files to a new database directory on the target system. Shareware, zip, and unzip utilities are available to easily do this via floppy disk. This method will retain all Configuration Editor information including test messages, groups, and indicator selections.

**Tip**

Once the configuration file is imported, it can be exported to a current configuration file, to an earlier PanelMate Power Series configuration file, or to a PanelMate Series V2.1X configuration file. Refer to the Export and Export As topics for more information on exporting configurations.
Export

Note that configuration files must be exported before being transferred to the PanelMate unit.

When you select a configuration filename in the Database Treeview Window and choose the Export selection from the File Menu, the Export dialog box will appear.

The Export dialog box allows you to export a configuration file for the current Configuration Editor software version.

The Export selection and Import selection in the File Menu may be used to copy configurations from one personal computer to another. After export, a configuration (.PPS file) can be copied to another computer and imported into another PanelMate database. When using this method to copy configurations, please note the following issues:

- Test message numbers in Display Templates and Variable-Sized Display Templates are not exported. Therefore, all test message numbers in an imported configuration are set to zero (0).
- Group attributes are not exported. If a configuration had groups prior to export, the imported configuration would show all objects ungrouped.
- The displayed states for Indicator, Variable-Sized Indicator, and Variable-Sized Graphic Templates are not exported. On import, the selected state of Variable-Sized Indicators is set to state one (1), and Indicator Templates and Variable-Sized Graphic Templates are set to state five (5).

An alternate method for copying configurations from one system to another is by copying all database files to a new database directory on the target system. Shareware, zip, and unzip utilities are available to easily do this via floppy disk. This method will retain all Configuration Editor information including test messages, groups, and indicator selections.

Tip

If you wish to export to an earlier PanelMate Power Series configuration file or to a PanelMate Series V2.1X configuration file, refer to the Export As topic for more information.
Export As

Note that configuration files must be exported before being transferred to the PanelMate unit.

When you select a configuration filename in the Database Treeview Window and choose the Export As selection from the File Menu, the **Export As** dialog box will appear.

The **Export As** dialog box allows you to export to an earlier PanelMate Power Series configuration file or to a PanelMate Series V2.1X configuration file for earlier Configuration Editor software versions.

Before the configuration file is exported, the configuration file will be verified. The verification process checks for the following:

- Number of messages
- Number of pages
- Presence of PowerGraphics
- Compatibility issues

Tip

*If you wish to export to a current PanelMate Power Series configuration file, refer to the Export topic for more information.*

Tip

*For guidelines to consider before exporting to a V2.1X configuration, refer to the V2.1X Export Guidelines topic.*
If you select to export to a PanelMate Series V2.1X configuration file, a V2.11 Options dialog box will appear.

You can check the Graphics Option box to set the graphics option in the V2.1X configuration file. If the Graphics Option box is not checked, the variable-sized graphics and symbols will not be exported.

After the V2.11 Options dialog box appears, the configuration file will be verified and the results of the verification will be displayed in the Verification Status dialog box. Refer to the Verification Status topic for more information.

For more information about the verification process for exporting, see the V2.1X Export Guidelines topic or the V2.1X Export Errors topic.
Chapter 2: Main Screen

Verification Status
If you choose to export to a V2.1X configuration file in the Export As dialog box, the configuration file will be verified and then the Verification Status dialog box will appear.

![Verification Status dialog box]

The Verification Status dialog box displays the configuration options of the file, the items that will not be exported, and the reason for not exporting the items.

Note that if you correct any errors, you must export the configuration file again. If you leave the Verification Status dialog box open while making changes to your configuration, the changes will not be exported. The configuration is always exported exactly as it appears in the Verification Status dialog box. For more information about the verification process for exporting, see the V2.1X Export Errors topic or the V2.1X Export Guidelines topic.

The selections on the Verification Status dialog box are described below.

Continue: Exports the configuration according to the results listed in the Verification Results list.

Cancel: Closes the dialog box without exporting the configuration.

Print: Prints a hard copy of the verification list on the default printer.
V2.1X Export Guidelines
When exporting to a V2.1X configuration, the following guidelines should be considered.

- **Text strings are decomposed into individual character elements.**  
  V2.1X does not support text strings.  
  All text elements on a page are used to create a single V2.1X Static Page Symbol that is made up of individual character elements. You can place and edit the Character Elements individually.

- **The Auto-Centering attribute is lost during export.**  
  V2.1X does not support auto centering. Everything is exported as left justified.

- **The Direct Select (Touchscreen Only) field is lost during export.**  
  The Direct Select (Touchscreen Only) in the System Parameters field is not supported by V2.1X.

- **Colors are converted to their closest match.**  
  V2.1X configurations contain up to eight colors. Some PanelMate Power Series configurations contain up to 256 colors.

- **Blinking foreground colors are lost during export.**  
  Blinking foreground colors are not supported by V2.1X.

- **The default label Reset PLC Comm is changed to Enable Fault Relay.**  
  PanelMate Power Series 1500 is exported as PanelMate Series 2000/PanelMate Series 3000 when going to V2.1X. The default label Reset PLC Comm does not exist.

- **Maintenance Template options Allow on Page, Enable Writes, and Protection are lost during export.**  
  Maintenance Templates are not supported by V2.1X.
• **Some System Parameter fields are converted during export.**

Scan Delays (Screen, Alarm, Message, and Trend) are exported as part of the PLC Name and Port Table.

The Screen Blanking Inactivity Period is rounded to the nearest 20 minute interval.

The Control Bit Reset Delay is rounded to the nearest 250 mSec interval.

The Password Protection Time Out is rounded to the nearest five minute interval.

• **The Maintenance Template Soft Key Prompts, Contrast Adjustment Soft Key Prompts, Touchscreen Button Templates, Touchscreen Keypad Entry Labels, Touchscreen Control Keys, and the Switch To Two Column Keypad and Switch to Three Column Keypad labels from the Setup Page are lost during export.**

These Online Labels are not supported by V2.1X.

• **The Refresh Background Graphics Online feature on the Variable-Sized Graphics Template - VS Graphics Attributes Tab dialog box is not exported.**

This option is not supported by V2.1X.
## V2.1X Export Errors

Before the configuration file is exported, the configuration file is checked for features not supported by V2.1X configuration software. If there are features that cannot be exported, you will see one or more of the following error messages:

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Reason for Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any element is not on a character boundary (X, Y).</td>
<td>X must be a multiple of 8. Y must be a multiple of 16.</td>
</tr>
<tr>
<td>Symbol offset is not on a character boundary (X, Y).</td>
<td>X must be a multiple of 8. Y must be a multiple of 16.</td>
</tr>
<tr>
<td>Any element overlaps another element.</td>
<td>Overlapping elements are not allowed in V2.1X.</td>
</tr>
<tr>
<td>The Graphics Option is not set.</td>
<td>Set this option on the V2.1X Options dialog box if graphics are used.</td>
</tr>
<tr>
<td>PowerGraphics are included.</td>
<td>Symbols and static graphics containing PowerGraphics are not supported by V2.1X. PowerGraphics include lines, rectangles, polygons, ellipses, and arcs.</td>
</tr>
<tr>
<td>PanelMate Power Series templates are included.</td>
<td>PanelMate Power Series templates such as Line Trend and Variable-Sized Control Button are not supported by V2.1X.</td>
</tr>
<tr>
<td>Any element is positioned on the top or bottom row, or the right hand column.</td>
<td>PanelMate Power Series units have an additional row at the top and bottom of the display, and an additional column at the left side.</td>
</tr>
<tr>
<td>Any element is not an even character height.</td>
<td>The pixel height of all V2.1X elements must be a multiple of 16 (16, 32, 48, etc.).</td>
</tr>
<tr>
<td>Any element is not an even character width.</td>
<td>The pixel width of all V2.1X elements must be a multiple of 8 (8, 16, 24, etc.).</td>
</tr>
<tr>
<td>Error Message</td>
<td>Reason for Error</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If the page number or message number in a PanelMate Power Series configuration exceeds the maximum page number or maximum message number allowed in the V2.1X configuration software, the page or message will not be exported. For example, if a PanelMate Power Series configuration has pages numbered 90 through 95 and you export the configuration to a PanelMate Series 2000 un-expanded unit which can contain 10 pages (numbered 0-9), no pages will be exported because all page numbers are greater than 9.</td>
<td>The PanelMate Series 2000 and PanelMate Series 3000 can have a maximum limit of 10 pages (numbered 0-9) and 100 messages (numbered 1-100). The PanelMate Series 2000 Expanded and the PanelMate Series 3000 Expanded can have a maximum limit of 30 pages (numbered 0-29) and 500 messages (numbered 1-500). The PanelMate Series 4000 can have a maximum limit of 10 pages (numbered 0-9) and 250 messages (numbered 1-250). The PanelMate Series 4000 Expanded can have a maximum limit of 30 pages (numbered 0-29) and 500 messages (numbered 1-500).</td>
</tr>
<tr>
<td>More than 10 PLCs are configured. V2.1X supports up to 10 PLCs.</td>
<td></td>
</tr>
<tr>
<td>A PLC configured on port 1, port 2, or I/O is not supported by V2.1X.</td>
<td>PanelMate Power Series supports a number of PLCs which V2.1X does not.</td>
</tr>
<tr>
<td>A device driver associated with the default device name (in the PLC Name And Port Table) is not supported by V2.1X.</td>
<td>In the PLC Name And Port Table, if no device name is given to a PLC, the PLC assumes the default device name. If the driver associated with the default name is not supported by V2.1X, the default device name will not be exported.</td>
</tr>
<tr>
<td>A Symbol name is too long. V2.1X Symbol names can be no longer than six characters.</td>
<td></td>
</tr>
</tbody>
</table>
Configuration Editor Reports

When you select a configuration filename in the Database Treeview Window and choose the Print selection from the File Menu or click on the Print button from the tool palette, the Configuration Editor Reports dialog box will appear.

The fields in the Configuration Editor Reports dialog box are described below.

Report Type: Allows you to select the type of report you wish to print.

<Report Options ...>: Opens the Configuration Editor Report Options dialog box. This selection allows you to select the report options.
**Pages**: Allows you to select the pages you wish to print, or click the **<Select All Pages>** button.

**<Select AllPages>**: Allows you to select all pages listed in the Pages box for printing.

**<Print Reports>**: Allows you to print the Configuration Report you have configured.

**<Printer Setup>**: Allows you to view the standard Microsoft Windows **Print Setup** dialog box. The options you see may vary depending upon the type of printer installed in your system.

**<Exit>**: Closes the dialog box without printing.

**<Help>**: Calls for online help.
Configuration Editor Reports Options

When you press the **Report Options** button on the **Configuration Editor Reports** dialog box, the **Configuration Editor Report Options** dialog box will appear.

The **Configuration Editor Report Options** dialog box allows you to select which options will appear on your printed report.

The fields in the **Configuration Editor Reports Options** dialog box are described below.

**Configuration Header:** Prints information contained in the **Configuration Properties** dialog box.

**System Parameters:** Prints information from the **System Parameters** dialog boxes for the selected configuration.

**PLC Name and Port Table:** Prints information from the **PLC Name and Port Table** dialog boxes for the selected configuration.

**Directory of Configuration Pages:** Prints a list of all pages and page properties.
Message Library: Prints the contents of the Message Library.

Template Data: Prints all template property information (in text format) for all templates (both fixed and variable-sized) found on the selected pages.

Graphic Data: Prints all object property information (in text format) for all static graphics found on the selected pages.

Note that the Print function does not support graphic printing of PanelMate pages. In order to print pixel image copies of PanelMate pages, use the built-in Windows clipboard feature to copy a bitmap image of the page to the clipboard (Print Screen key or Alt and Print Screen keys). Then use a standard bitmap editor, such as Windows Paintbrush, to edit and/or print an image of the page to a printer. Refer to the Printing a Configuration Page topic for more information.

Check the desired report options then click the OK button to return to the Configuration Editor Reports dialog box.
Printing a Configuration Page

For information on printing a configuration page from the PanelMate software, refer to the steps below.

1. Open the configuration page you wish to print and maximize the page.

2. Create a rectangle the size of the entire page. The rectangle should have a white fill and white pen. Move the rectangle to the back. (This step is optional and is intended to provide a white background for templates and graphics if your printer does not print solid black well.)

3. Hold the Alt key and press the Print Screen button on your keyboard to place an image of the configuration software screen in the Windows clipboard. (Note that any graphics software package can be used to edit and print the image by choosing the Paste selection within the graphics software package. The following steps use the Paintbrush software as an example.)

4. Minimize the PanelMate software to an icon.

5. Open the Paintbrush software and maximize the screen.

6. Under the View Menu in Paintbrush, deselect the Tools and Linesize and Palette selections. (This step allows the entire configuration page to be displayed.)

7. Under the Edit Menu, choose the Paste selection and the configuration page image will be pasted from the Windows clipboard.

8. You may edit the configuration page image or print the page as it appears.

For information on editing the configuration page image in the Paintbrush software, refer to the steps below.

1. Select the Cutout tool and outline the desired part of the page you wish to print.

2. Under the Edit Menu, choose the Cut selection to cut the desired part of the page.

3. Under the File Menu, choose the New selection to start a new session.

4. Under the Edit Menu, choose the Paste selection to paste the contents of the clipboard on the new screen.

5. Print the page.
Edit Menu

Tip
Graphics can be pasted from other software packages onto a configuration page. Refer to the Using Graphics from Other Software topic for more information.

Tip
Complex objects pasted into a configuration should be re-sized using the software package in which the drawing was created. Copying objects to the clipboard from other software packages tends to multiply the number of objects. Attempting to resize these objects in the Configuration Editor may cause a General Protection Fault.

The Edit Menu is shown below.

Object(s) can be edited using keys on the keyboard. For information on editing objects using the keyboard, refer to the Editing Graphics topic.

The selections in the Edit Menu are described below. Note that some of the selections are available from the toolbar. Refer to the toolbar topic for more information.

**Undo:** Reverses the last operation you performed. For example, if you cut an object, Undo makes it re-appear. There are several levels of Undo (the exact number depends upon your memory resources).

**Redo:** Reverses the effect of the last Undo command. There are several levels of Redo (the exact number depends upon your memory resources).

**Cut:** Erases a selected object(s) from the screen and places the object(s) on the Windows clipboard.

**Copy:** Copies a selected object(s) to the Windows clipboard, but does not erase the object(s) from the screen.

**Paste:** Copies object(s) from the Windows clipboard into the current configuration page.

It is not recommended to copy and paste bitmaps to and from the clipboard. To insert a bitmap, use the bitmap tool on the tool palette.
Delete: Erases selected object(s) from the screen and does not place the object(s) in the Windows clipboard.

Select All: Selects all objects in the current configuration page.

Select Next: Selects the next object - in the order in which objects were created.

Select Previous: Selects the previous object - in the order in which objects were created.

Note that the keyboard keys used to select, resize, move, select next, or select previous objects will not function on a configuration page when another window has been selected. For example, if an object is selected and the cursor is placed inside of the color selection palette and the Arrow keys are used to select different colors on the palette, the Arrow keys cannot be used to move the selected object unless the configuration page and the object are re-selected. This also applies when an object is selected and the cursor is placed inside of the Select Font box or the Pen Width box on the toolbar.

Snap To Grid: If this item is checked, objects are automatically aligned with an invisible on-screen grid when existing objects are moved or new objects are placed on the page. The grid is set up on 8x16 pixel boundaries for character-based alignment. The Snap To Grid is intended to facilitate development of V2.1X configurations.

Note that resize does not function on a group if the snap-to-grid feature is enabled.
Object Menu

The Object Menu is shown below.

<table>
<thead>
<tr>
<th>Object Menu Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Properties...</td>
</tr>
<tr>
<td>Group</td>
</tr>
<tr>
<td>Ungroup</td>
</tr>
<tr>
<td>Bring to Front</td>
</tr>
<tr>
<td>Send to Back</td>
</tr>
<tr>
<td>Align</td>
</tr>
<tr>
<td>Distribute</td>
</tr>
<tr>
<td>Make Equal Size</td>
</tr>
<tr>
<td>Reghape</td>
</tr>
<tr>
<td>Make Symbol</td>
</tr>
<tr>
<td>Break Symbol</td>
</tr>
</tbody>
</table>

Objects can be edited using keys on the keyboard. For information on editing objects using the keyboard, refer to the Editing Graphics topic.

The selections in the Object Menu are described below. Note that some of the selections are available from the toolbar. Refer to the toolbar topic for more information.

**Properties...:** Opens the Object Properties dialog box for the selected object. Use this selection to edit specific object information. You can also use the F2 key as a shortcut key.

**Group:** Joins selected objects together into a group object. The group object is contained within a single bounding rectangle and can be moved, resized, etc. Note that you can group objects (lines, rectangles, etc.), but you cannot group templates.

**Ungroup:** Separates a group object into its individual component objects.

**Bring To Front:** Brings the selected object(s) to the front (top) of a stack of objects. If more than one object is selected, the objects maintain their relative position in the stack.

**Tip**

When configurations containing groups are imported, the objects within those groups will appear as individual objects and not part of a group. Since groups have no function in the online configuration, the exported file does not maintain group attributes.
**Send To Back:** Sends the selected object(s) to the back (bottom) of a stack of objects. If more than one object is selected, the objects maintain their relative position in the stack.

**Align:** Opens a pop-up menu that allows you to select the type of alignment you prefer. All selected objects will be aligned with the last object selected. Note that you can align objects (lines, rectangles, etc.), but you cannot align templates.

**Lefts:** Aligns the objects along their left edges.

**Centers:** Aligns the objects along their vertical centerlines.

**Rights:** Aligns the objects along their right edges.

**Tops:** Aligns the objects along their top edges.

**Middles:** Aligns the objects along their horizontal centerlines.

**Bottoms:** Aligns the objects along their bottom edges.

**Distribute:** Distributes or evenly spaces three or more selected objects vertically and horizontally. Note that you can distribute objects (lines, rectangles, etc.), but you cannot distribute templates.

**Vertically:** Distributes the objects along their vertical centerlines.

**Horizontally:** Distributes the objects along their horizontal centerlines.

**Make Equal Size:** Makes two or more selected objects equal in size to the last object selected. Note that you can make objects (lines, rectangles, etc.) equal size but you cannot make templates equal size.

**Width:** Makes the objects equal in width.

**Height:** Makes the objects equal in height.

**Both:** Makes the objects equal in both width and height.

**Reshape:** Displays vertical box handles on the selected polygon or arc. Drag the handles to re-shape the object.

**Make Symbol:** Opens the Make Symbol dialog box. This selection will make a symbol from a group of selected objects (lines, rectangles, etc.).

**Break Symbol:** Breaks a symbol into the original component objects.
Object Properties

When you choose the Properties selection under the Object Menu or double click on any object on a page, the **Object Properties** dialog box for that object will appear.

Object Properties is a set of three tabbed dialog boxes used to select the object’s attributes, location, size, and visibility. The dialog boxes are listed below.

- **Object Properties - Attributes Tab**
- **Object Properties - Location And Size Tab**
- **Object Properties - Visibility Tab**

Note that it is not possible to resize a fixed template with the size handles. To resize a fixed template, you must use the **Object Properties** dialog box.
Object Properties - Attributes Tab

The Object Properties - Attributes Tab dialog box is shown below.

![Object Properties - Attributes Tab](image)

The Object Properties - Attributes Tab dialog box allows you to change the color and pen width of a selected object.

The fields in the Object Properties - Attributes Tab dialog box are described below.

**Colors**

- **Pen**: Allows you to select the foreground color or intensity for the object. The Pen button will display the standard Color Selection Palette.
- **Fill**: Allows you to select the background color or intensity for the object. The Fill button will display the standard Color Selection Palette.

**Pen Width**: Allows you to enter a pen width for the selected object.
**Object Properties – Location and Size Tab**

The **Object Properties - Location and Size Tab** dialog box is shown below.

The **Object Properties - Location and Size Tab** dialog box allows you to change the pixel location and size of a selected object.

The fields in the **Object Properties - Location and Size Tab** dialog box are described below.

**Location in Pixels**

- **X**: Allows you to move the object to the left or right on the configuration page. The value entered in the X field determines the distance in pixels from the left edge of the page.

- **Y**: Allows you to move the object up and down on the configuration page. The value entered in the Y field determines the distance in pixels from the top of the page.

**Size In Pixels**

- **Height**: Allows you to enter the height in pixels of the selected object. Note that you can re-size and re-shape an object by dragging one of the selection handles with the selection tool.

- **Width**: Allows you to enter the width in pixels of the selected object. Note that you can re-size and re-shape an object by dragging one of the selection handles with the selection tool.

**Tip**

*Objects can be resized using keys on the keyboard. For information on editing objects using the keyboard, refer to the Editing Graphics topic.*
Tip

The Object Properties - Visibility Tab dialog box only appears when you double click on a Text object.

Object Properties - Visibility Tab

Note that a Text object that has the Refresh Affected Graphics Online field or the Enable Conditional Visibility field checked cannot be made into a symbol.

The Object Properties - Visibility Tab dialog box is shown below.

The Object Properties - Visibility Tab dialog box allows you to configure the refresh graphics and visibility features.

The fields in the Object Properties - Visibility Tab dialog box are described below.

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and graphics that lie within the area of the Text object to be refreshed to properly reflect the layering of objects on the page whenever the symbol is updated.

Enable Conditional Visibility: Allows you to determine if the Text object will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the Text object will always appear on the page.

It is important to note that an text object that is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the text object is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the Text object will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the Text object will appear and all template updating will be activated when in Run Mode.
Make Symbol

A symbol is a collection of graphic objects grouped together and given a name. The allowable objects for a symbol are lines, rectangles, ellipses, arcs, polygons, text, and bitmaps. If there are any fixed templates, variable-sized templates, variable-sized control buttons, or symbols in the collection of objects you wish to make into a symbol, the Make Symbol selection in the Object Menu will be disabled. Also note that if you have a Text object selected and the Refresh Affected Graphics Online field or the Enable Conditional Visibility field is checked in the Object Properties - Visibility Tab dialog box, the Make Symbol selection will be disabled.

When a group of allowable objects are selected on a configuration page and you choose the Make Symbol selection from the Object Menu, the Make Symbol dialog box will appear.

The Make Symbol dialog box allows you to create symbols.
The fields in the **Make Symbol** dialog box are described below.

**Symbol Name:** Allows you to enter the name of the symbol you wish to create. Note that when a symbol has been created, the symbol name will appear in the Database Treeview Window under the Symbol Library selection. For more information on the Symbol Library, refer to the **Symbol Library** topic.

**Symbol Origin Offset:** Displays the symbol’s origin offset (in pixels). The default Symbol Origin Offset for X and Y is 0 and 0 (no offset).

**X:** Displays the X origin offset in pixels.

**Y:** Displays the Y origin offset in pixels.

**Preview:** Displays the selected symbol in the Preview box if the Show Preview box is selected.

**Show Preview:** Allows the selected symbol to be shown in the Preview box.

Once a symbol has been created, you may double click on the symbol to view the **Symbol Properties** dialog box. Refer to the **Symbol Properties** topic for more information.

Note the following items:

- The objects that make up a symbol cannot be edited. If you wish to change an object within a symbol, you must select the symbol on the configuration page and choose the Break Symbol selection under the Object Menu to break the symbol into the original separate objects. The objects may be edited and then you may choose the Make Symbol selection from the Object Menu again.

- If you create a symbol that contains a circle, the circle may be displayed slightly out of position (1 pixel in X or Y dimension) in Run Mode compared to what is displayed in the Configuration Software.
View Menu

The View Menu is shown below.

<table>
<thead>
<tr>
<th>View</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓ Toolbar</td>
<td>✓ Status Bar</td>
</tr>
</tbody>
</table>

The selections in the View Menu are described below.

**Toolbar**: Shows or hides the toolbar at the top of the screen. When the toolbar is visible, a check mark appears beside this menu item.

**Status Bar**: Shows or hides the status bar at the bottom of the screen. When the status bar is visible, a check mark appears beside this menu item.

**Tool Palette**: Shows or hides the tool palette. When the tool palette is visible, a check mark appears beside this menu item.
Window Menu

The Window Menu is shown below.

<table>
<thead>
<tr>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td></td>
</tr>
<tr>
<td>Tile</td>
<td></td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
</tr>
<tr>
<td>&quot;C:\PMCONF\MODEL Database&quot;</td>
<td></td>
</tr>
</tbody>
</table>

The selections in the Window Menu are described below.

**Cascade:** Arranges all open windows so they overlap. The title bar of all windows remains visible so you can easily select a window.

**Tile:** Arranges all open windows side-by-side so there is no overlap.

**Arrange Icons:** Arranges all icons in orderly rows. To reduce a configuration window to an icon, click its button.

**1 Configurations:** Lists all open windows, including those that have been reduced to icons. To make a window active, select its name from the list.
Help Menu

The Help Menu is shown below.

<table>
<thead>
<tr>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents</td>
</tr>
<tr>
<td>Using Help</td>
</tr>
<tr>
<td>About...</td>
</tr>
</tbody>
</table>

The selections in the Help Menu are described below.

**Contents**: Goes to the first topic of the Configuration Editor help file.

**Using Help**: Provides general information about using help. This is the standard Windows help file.

**About PM Config**: Displays the About PanelMate Configuration Editor dialog box and lists system information.
About PanelMate Configuration Editor

When you choose the About PM Config selection in the Help Menu, the About PanelMate Configuration Editor dialog box will appear.

The information in the About PanelMate Configuration Editor dialog box is listed below:

- Name of the Configuration Editor, version number, and copyright information.
- Amount of free memory
- Presence of math co-processor
- Amount of free disk space
Toolbar

When the Toolbar selection is checked under the View Menu, the Toolbar will appear on the Main Screen.

You can use the Toolbar buttons to perform many of Configuration Editor’s standard operations. The Toolbar buttons are described below.

- **Save**: Saves the current configuration to disk.
- **Print**: Prints a hard copy of the current configuration.
- **Cut**: Removes the selected object from the configuration, and places it on the Windows clipboard.
- **Copy**: Places a copy of the selected object on the Windows clipboard, but does not remove it from the configuration.
- **Paste**: Pastes the contents of the Windows clipboard into the current configuration.
- **Undo**: Un-does the previous operation.
- **Redo**: Re-does the operation previously un-done.
- **Bring To Front**: Brings a selected object to the front (top) of a stack of objects.
- **Send To Rear**: Sends a selected object to the rear (bottom) of a stack of objects.
- **Align Left**: Aligns all selected objects along the left edge of the last object selected.
- **Align Center**: Aligns all selected objects along the vertical centerline of the last object selected.
Align Right: Aligns all selected objects along the right edge of the last object selected.

Double High Select Font: Select a font for the selected text object.

Fill Colors: This button consists of two parts. Click the paint can icon to fill the selected object with the color shown in the box. Click the arrow icon to display the Color Selection Palette.

Pen Colors: This button consists of two parts. Click the pencil icon to set the pen color of the selected object to the color shown in the box. Click the arrow icon to display the Color Selection Palette.

Pen Width: Choose a pen width for the selected object. Note that the Pen Width value in the Toolbar is not fully visible when using a large font video driver.

Help: Makes context-sensitive help available. When you click this button, the cursor displays a question mark. Then, click most on-screen features for context-sensitive help.
Color Selection Palette

When you click the down arrow buttons on the Pen Color button or Fill Color button in the toolbar, the Color Selection Palette will appear.

The Color Selection palette allows you to select pen color (or shade) and fill color (or shade). You can choose:

- Colors (on color units only)
- Blinking colors (on color systems only)
- Shades of gray
- Blinking shades of gray

Note the following Color Palette items:

- You can move the Color Selection Palette by clicking the left mouse button and dragging the palette to the desired position on the screen. The Color Selection Palette will then have a small title and icon that will indicate whether it is the Pen Color or Fill Color palette.
- If the 256 Greyscale/Color option is installed on the PanelMate Power Series 1500, additional colors or shades of gray will be available.
- In order for the color palette to accurately represent the color and blink characteristics of the PanelMate online unit, the video driver selected from the Windows Control Panel must be a 256 color driver. If the video driver is not a 256 color driver (either 16 color or more than 256 color), the color palette shown in the Configuration Editor will not match that of the online unit.
Status Bar

When the Status Bar selection is checked under the View Menu, the Status Bar will appear on the Main Screen.

```
For Help, press F1
```

The Configuration Editor uses the Status Bar at the bottom of the window to display messages and information about the current status of the application.
Tool Palette

When the Tool Palette is selected in the View Menu, the Tool Palette will display when you open a page.

The Tool Palette buttons are listed below.

- Selection
- Reshape
- Line
- Rectangle
- Ellipse
- Arc
- Polygon
- Text
- Symbol
- Bitmap
- Indicator Template
- Readout Template
- Bar Template
- Bar Trend Template
- Table Template
- Line Trend Template
- Display Template
- VS Indicator Template
- VS Bar Template
- VS Readout Template
- VS Display Template
- VS Graphic Template
- VS Control Button
Selection Tool
The Selection tool allows you to select objects on the current page. A selected object is enclosed in a bounding box having handles (small squares) at the corners of the bounding box, and at the center of every side. Use the Selection tool to drag the handles to re-size or re-shape the object.

To select more than one object, press the Shift key while you click the desired objects. You can also use the Selection tool to draw a dotted selection box (marquee) around multiple objects to select them.

Reshape Tool
The Reshape tool allows you to re-shape selected arcs and polygons.

To reshape an arc or polygon ...
1. Select the Reshape tool.
2. Click the object you wish to reshape. An arc displays two handles (squares) and a polygon displays a handle at the ends, and at each vertex (corner).
3. Place the cursor over a handle and it changes to a cross.
4. Drag the handle to reshape the object.

To add a node (vertex) to a polygon ...
1. Press the Ctrl key.
2. Place the cursor on the line where you wish to add a node. A plus sign (+) appears.
3. Click and drag the cursor away, then release the Ctrl key.

To delete a node on a polygon ...
1. Place the cursor on the node you wish to delete. A plus sign (+) appears.
2. Press the Ctrl key and click once to delete the node.

Tip
If the reshape tool is used on an arc and the cursor is inside the arc, the arc is converted to a pie shape or a chord.
Line Tool
The Line tool allows you to place a line object on the page. Place the cursor on the configuration page, press the mouse button, and drag to create a line. While using this tool, press the Shift key to constrain the line to a $45^\circ$ angle.

Rectangle Tool
The Rectangle tool allows you to place a rectangle object on the page. Place the cursor on the configuration page, press the mouse button, and drag to create a rectangle. While using this tool, press the Shift key to constrain the rectangle to a square.

Ellipse Tool
The Ellipse tool allows you to place an ellipse object on the page. Place the cursor on the configuration page, press the mouse button, and drag to create an ellipse. While using this tool, press the Shift key to constrain the ellipse to a circle.

Arc Tool
The Arc tool allows you to draw an arc, chord, or pie-shaped object on the page. Place the cursor on the configuration page, press the mouse button, and drag to create an arc. While using this tool, press the Shift key to constrain the arc to a circular shape.

To draw a chord or pie shape ...
1. Draw an arc.
2. Reshape it using the Reshape tool. For information on the Reshape tool, refer to the Reshape Tool topic.
Polygon Tool
The Polygon tool allows you to place a polyline (a jagged line) or a closed polygon (multi-sided figure) on the configuration page.

To create a polyline ...
1. Select the polygon tool.
2. Click to place the first point, then release the mouse button. As you move the mouse, a rubber band line follows the cursor.
3. Click to place the next point.
4. Continue until the polyline is complete.

To create a polygon ...
1. Perform steps 1-3 (under Creating A Polyline) to draw the polygon shape.
2. Place the last point very near the first one. It is not necessary to place it exactly on top. The polygon is automatically completed.

Note that you may use the Reshape tool to reshape a polyline or a polygon. For more information on the Reshape tool, refer to the Reshape Tool topic.

Text Tool
The Text tool allows you to place a text object on the page.

Symbol Tool
The Symbol tool allows you to place a symbol object on the page. When the Symbol tool is selected from the tool palette and you click on the configuration page, the Select Symbol dialog box will appear. For more information on the Select Symbol dialog box, refer to the Select Symbol topic.

Note that graphics can be pasted from other software packages onto a configuration page and made into a symbol. Refer to the Using Graphics from Other Software topic for more information.
Select Symbol

When you select the Symbol tool or the Variable-Sized Graphic Template tool from the tool palette and click on a configuration page, the Select Symbol dialog box will appear.

The Select Symbol dialog box is used to select an existing symbol to place on a configuration page.

The fields in the Select Symbol dialog box are described below.

Symbol Name: Displays the lists of symbol names. Note that you may scroll through the symbol name list and preview each symbol if the Show Preview box is selected.

Symbol Origin Offset: Displays the symbol’s origin offset (in pixels).
X: Displays the X origin offset in pixels.
Y: Displays the Y origin offset in pixels.

Preview: Displays the selected symbol in the Preview box if the Show Preview box is selected.
Show Preview: Allows the selected symbol to be shown in the Preview box.
Bitmap Tool

The Bitmap tool allows you to place a bitmap object (picture) on the page. When this tool is selected and you click a configuration page, a standard Open Bitmap File dialog box will appear.

Bitmaps are used for backgrounds or other objects it is not easy or convenient to draw. Bitmaps reside in disk files having a .BMP extension.

Graphics can be pasted from other software packages onto a configuration page. Refer to the Using Graphics from Other Software topic for more information.

Open Bitmap File

When you select the Bitmap tool from the tool palette and click on a configuration page, the Open Bitmap File dialog box will appear.

The Open Bitmap File dialog box will allow you to select the bitmap you wish to use.

Tip

Bitmaps use a lot of memory. The larger the bitmap, the more memory is consumed.
**Indicator Template Tool**
The Indicator Template tool allows you to place an Indicator Template on the page. Indicator Templates are the lights and buttons of a control panel. They indicate and control the status of devices by turning them on or off. Refer to the Indicator Template topic for more information.

**Readout Template Tool**
The Readout Template tool allows you to place a Readout Template on the page. Readout Templates are designed to replace numeric and digital readout devices found on a conventional control panel, and to supply the functionality often provided by CRT-based devices. Refer to the Readout Template topic for more information.

**Bar Template Tool**
The Bar Template tool allows you to place a Bar Template on the page. Bar Templates are the analog meters and face plates of a control panel. They indicate a value in analog fashion using a bar graph that shows these values in graphical form:

- Current value
- Steeping
- High and low alarm levels

Refer to the Bar Template topic for more information.

**Bar Trend Template Tool**
The Bar Trend tool allows you to place a Bar Trend Template on the page. Bar Trend Templates collect, store, and display data to provide a historical perspective on how:

- A single data point has changed
- A data point may behave in the future

Refer to the Bar Trend Template topic for more information.
Table Template Tool
The Table Template tool allows you to place a Table Template on the page. Table Templates display a table of values and accept numeric entry for all the items in the table. Refer to the Table Template topic for more information.

Line Trend Template Tool
The Advanced Trending Template box must be selected in the New Configuration dialog box or in the Configuration Properties dialog box before a Line Trend Template can be created.

The Line Trend Template tool allows you to place a Line Trend Template on the page. Line Trend Templates collect, store, and display data to provide a historical perspective on how:

- A single data point has changed
- A data point may behave in the future

Refer to the Line Trend Template topic for more information.

Display Template Tool
The Display Template tool allows you to place a Display Template on the page. Display Templates are used like standard LED or LCD message units or displays. Refer to the Display Template topic for more information.

Variable-Sized Indicator Template Tool
The Variable-Sized Indicator Template tool allows you to place a Variable-Sized Indicator Template on the page. Variable-Sized Indicator Templates let you use small indicators to create high-density status displays on your page. Refer to the Variable-Sized Indicator Template topic for more information.
Variable-Sized Bar Template Tool
The Variable-Sized Bar Template tool allows to place a Variable-Sized Bar Template on the page. Variable-Sized Bar Templates are the analog meters and face plates of a control panel. They indicate a value in analog fashion using a bar graph that shows these values in graphical form:

• Current value
• Setpoint
• High and low alarm levels

Refer to the Variable-Sized Bar Template topic for more information.

Variable-Sized Readout Template Tool
The Variable-Sized Readout Template tool allows you to place a Variable-Sized Readout Template on the page. Variable-Sized Readout Templates are designed to replace numeric and digital readout devices found on a conventional control panel, and to supply the functionality often provided by CRT-based devices. Refer to the Variable-Sized Readout Template topic for more information.

Variable-Sized Display Template Tool
The Variable-Sized Display Template tool allows you to place a Variable-Sized Display Template on the page. Variable-Sized Display Templates are designed to replace LED or LCD message units or display readouts. Refer to the Variable-Sized Display Template topic for more information.

Variable-Sized Graphic Template Tool
The Variable-Sized Graphic tool allows you to place a Variable-Sized Graphic Template on the page. Variable-Sized Graphic Templates consists of one or more symbols and are used to indicate the status of a device and to control the device (e.g., by turning it ON or OFF). Refer to the Variable-Sized Graphic Template topic for more information.

Variable-Sized Control Button Tool
The Variable-Sized Control Button tool allows you to place a Variable-Sized Control Button Template on the page. Variable Sized Control Button Templates are used to provide momentary control to the PLC or to issue a local page change command. Refer to the Variable-Sized Control Button Template topic for more information.
Database Treeview Window

In this chapter, you will learn:

- About the Database Treeview Window
- How to open a New Configuration
- How to open a New Configuration Page
- How to set the Configuration Properties
- How to set the Page Properties
Database Treeview Window

The Database Treeview Window appears on the Main Screen.

The Database Treeview Window allows you to create and edit configuration pages and is the main interface used to access the Configuration Software. This window displays the database in a tree-like structure similar to the Microsoft Windows File Manager.

To expand and contract the database tree, you may double-click on the icons or click once on the + or - symbol next to the icons. Note that if an icon does not have a + or - symbol, there are no additional levels.
The buttons on the Database Treeview Window are described below.

**New:** Opens the **New Configuration** dialog box or the **New Configuration Page** dialog box depending on which icon is selected.

If you have the Configurations icon, a PanelMate model icon, or a configuration name icon selected and click the **New** button, the **New Configuration** dialog box will appear.

If you have the Configurations Pages icon selected and click the **New** button, the **New Configuration Page** dialog box will appear.

**Open:** Opens or expands the currently selected icon in the database tree. For example, if you select a configuration page name and click the **Open** button, the configuration page will open. If you select the Symbol Library icon and click the **Open** button, the symbol names (if configured) will appear. (You must select the symbol name and click the **Open** button to view the **Symbol Library** dialog box.)

**Delete:** Allows you to delete a selected configuration or a selected configuration page.

**Properties:** Opens the **Configuration Properties** dialog box or the **Page Properties** dialog box depending on which icon is selected.

If you have a configuration name selected and press the **Properties** button, the **Configuration Properties** dialog box will appear.

If a configuration page is selected and press the **Properties** button, the **Page Properties** dialog box will appear.
New Configuration

When the Configurations icon, a PanelMate model icon, or a configuration name icon is selected and the New button is clicked in the Database Treeview Window, the New Configuration dialog box appear.

The New Configuration dialog box allows you to create a new configuration.

The fields in the New Configuration dialog box are described below.

**Product Type:** Allows you to select the product for which the configuration is being created.

**Preview:** Displays a generalized view of the selected product type.

**Configuration**

**Name:** Allows you to enter the name of the configuration.

**Description:** Allows you to enter a brief description of the configuration.
Product Options

The following Product Options can also be selected in the Configuration Properties dialog box.

**Color Display:** Allows you to select a color configuration. If this box is not checked, the configuration will be grayscale.

The Color Display option is a standard feature for the PanelMate Power Series 4000, PanelMate Power Series 5000, and PanelMate PC unit.

**High Capacity Unit:** Allows you to create a larger number of pages and messages than permitted in the Standard Capacity PanelMate unit. Refer to the table below.

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Number of Pages</th>
<th>Number of Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelMate Power Series 1500</td>
<td>10</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 1500 High Capacity</td>
<td>50</td>
<td>2500</td>
</tr>
<tr>
<td>PanelMate Power Series 2000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 2000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate Power Series 3000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 3000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate Power Series 4000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 4000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate Power Series 5000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 5000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate PC</td>
<td>100</td>
<td>5000</td>
</tr>
</tbody>
</table>

The High Capacity Unit option is a standard feature for the PanelMate PC unit.

**Advanced Trending Template:** Allows you to configure Advanced Trending Templates which display a history of a reference’s value over a period of time. Advanced trending features 6 pens that can be triggered by time or event.

For information on configuring an Advanced Trending Template, refer to the Line Trend Template topic.

The Advanced Trending Template option is a standard feature for the PanelMate PC unit.
**Allen-Bradley DH-485**: Allows you to communicate to the Allen-Bradley Data Highway.

The Allen-Bradley DH-485 option is not available for the PanelMate PC at this time.

**Modicon Modbus**: Allows you to communicate to Modicon PLCs via the Modicon Modbus.

The Modicon Modbus option is not available for the PanelMate PC at this time.

**Dynamic Graphics**: Allows symbols to change colors and shapes dynamically on PanelMate Power Series 1500 models.

**256 Greyscale/Color (Model 1555/1575)**: Enhances the PanelMate Power Series 1500.

If you have a PanelMate Power Series 1500 (Model 1555) and you install the 256 Greyscale/Color option, you will have 16 shades of gray (instead of the standard 8 shades), PowerAnimation, and PowerBlink.

If you have a PanelMate Power Series 1500 (Model 1575) and you install the 256 Greyscale/Color option, you will have a 256 color palette (instead of the standard 16 colors), PowerAnimation, and PowerBlink.

PowerAnimation allows you to create animation by defining a series of graphic objects which blink in sequence and PowerBlink allows you to create graphic objects which blink at different rates.

The 256 Greyscale/Color option is only available for the PanelMate Power Series 1500.

**Auto Centering**

**Device Names**: Allows you to automatically center all Device Names within templates which have Device Names on all pages of this configuration.

**Indicator Labels**: Allows you to automatically center all Indicator Labels within the Indicator Template label area on all pages of this configuration.

**Control Button Labels**: Allows you to automatically center all Control Button Labels for all templates which have control buttons defined on all pages of this configuration.
New Configuration Page

When the Configurations Pages icon is selected and the New button is clicked in the Database Treeview Window, the New Configuration Page dialog box will appear.

The New Configuration Page dialog box is used to determine features for individual configuration pages and to determine features for the Maintenance Template. For more information about the Maintenance Template, refer to the Maintenance Template topic.
The fields in the **New Configuration Page** dialog box are described below.

**Page**

**Number:** Allows you to enter the page number for the new configuration page.

**Title:** Allows you to enter a title for the new configuration page.

**Protection:** Allows you to control access to a page by selecting a type of protection for the new configuration page. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

The page will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option which may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.

---

**Tip**

*If a page is password protected, but is selected as the startup page in the Startup Page field in the System Parameters - General Tab dialog box, password protection will be ignored on initial bootup.*
Maintenance Templates

Maintenance Templates are designed to replace TCAM (timer/counter access module) and RAP (register access panel) devices that are typically used during the setup and troubleshooting of PLCs.

**Allow On Page**: Allows you to determine if the Maintenance Template will display on the current page.

**Enable Writes**: Allows you to determine if the operator can change the data or just monitor it. If this box is checked, the data is read/write, otherwise the data is read-only.

⚠️ **CAUTION**: Make your selection based on the expertise of operators and maintenance personnel.

**Protection**: Allows you to select a type of protection for displaying Maintenance Templates on the current page. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

The Maintenance Template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option which may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.

For additional information about Maintenance Templates, see the **Maintenance Template** topic.
Flexible Page Layout

The Flexible Page Layout feature is intended for use on touchscreen units only.

If a flexible item appears on top of a template or graphic on your configuration page, the underlying template or graphic will be deleted when the configuration is exported.

**Page Status Banner:** Allows you to determine if the Page Status Banner will appear on the screen of your touchscreen unit. Note that if you do not want the Page Status Banner to appear, you must select the Flexible Page Layout field in the **System Parameters - General Tab** dialog box and de-select the Page Status Banner box.

**Default Buttons:** Allows you to determine if the default buttons will appear on the screen of your touchscreen unit. Note that if you do not want the Default Buttons to appear, you must select the Flexible Page Layout field in the **System Parameters - General Tab** dialog box and de-select the Default Buttons box.

**Alarm Table:** Allows you to determine if alarms will appear on the screen of your touchscreen unit. Note that if you do not want alarms to appear, you must select the Flexible Page Layout field in the **System Parameters - General Tab** dialog box and de-select the Alarms Table box.

**Cancel Key:** Allows you to determine if the CANCEL key will appear on the screen of your touchscreen unit. Note that if you do not want the CANCEL key to appear, you must select the Flexible Page Layout field in the **System Parameters - General Tab** dialog box and de-select the Cancel Key box.
Configuration Properties

When a configuration name is selected in the Database Treeview Window and the Properties button is clicked, the Configuration Properties dialog box will appear.

The Configuration Properties dialog box displays configuration, product options, and auto-centering information.

The fields in the Configuration Properties dialog box are described below.

Product Type: Displays the product type.

Version: Displays the configuration software version number.
Configuration

Name: Displays the name assigned when the configuration was created in the New Configuration dialog box. You may change this name to save the configuration under a new name.

Last Modified Time: Displays the time of the last modification to the configuration.

Last Modified Date: Displays the date of the last modification to the configuration.

Description: Displays the description entered when the configuration was created in the New Configuration dialog box. You can edit the description as required.

Product Options

The following Product Options can also be selected in the Configuration Properties dialog box.

Color Display: Allows you to select a color configuration. If this box is not checked, the configuration will be grayscale.

The Color Display option is a standard feature for the PanelMate Power Series 4000, PanelMate Power Series 5000, and PanelMate PC unit.
**High Capacity Unit:** Allows you to create a larger number of pages and messages than permitted in the Standard Capacity PanelMate unit. Refer to the table below.

<table>
<thead>
<tr>
<th>Product Type</th>
<th>Number of Pages</th>
<th>Number of Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>PanelMate Power Series 1500</td>
<td>10</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 1500 High Capacity</td>
<td>50</td>
<td>2500</td>
</tr>
<tr>
<td>PanelMate Power Series 2000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 2000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate Power Series 3000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 3000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate Power Series 4000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 4000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate Power Series 5000</td>
<td>15</td>
<td>500</td>
</tr>
<tr>
<td>PanelMate Power Series 5000 High Capacity</td>
<td>100</td>
<td>5000</td>
</tr>
<tr>
<td>PanelMate PC</td>
<td>100</td>
<td>5000</td>
</tr>
</tbody>
</table>

The High Capacity Unit option is a standard feature for the PanelMate PC unit.

**Advanced Trending Template:** Allows you to configure Advanced Trending Templates which display a history of a reference’s value over a period of time. Advanced trending features 6 pens that can be triggered by time or event.

For information on configuring an Advanced Trending Template, refer to the Line Trend Template topic.

The Advanced Trending Template option is a standard feature for the PanelMate PC unit.

**Allen-Bradley DH-485:** Allows you to communicate to the Allen-Bradley Data Highway.

The Allen-Bradley DH-485 option is not available for the PanelMate PC at this time.

**Modicon Modbus:** Allows you to communicate to Modicon PLCs via the Modicon Modbus.

The Modicon Modbus option is not available for the PanelMate PC at this time.
**Dynamic Graphics:** Allows symbols to change colors and shapes dynamically on PanelMate Power Series 1500 models.

**256 Greyscale/Color (Model 1555/1575):** Enhances the PanelMate Power Series 1500.

If you have a PanelMate Power Series 1500 (Model 1555) and you install the 256 Greyscale/Color option, you will have 16 shades of gray (instead of the standard 8 shades), PowerAnimation, and PowerBlink.

If you have a PanelMate Power Series 1500 (Model 1575) and you install the 256 Greyscale/Color option, you will have a 256 color palette (instead of the standard 16 colors), PowerAnimation, and PowerBlink.

PowerAnimation allows you to create animation by defining a series of graphic objects which blink in sequence and PowerBlink allows you to create graphic objects which blink at different rates.

The 256 Greyscale/Color option is only available for the PanelMate Power Series 1500.

**Auto Centering**

**Device Names:** Allows you to automatically center all Device Names within templates which have Device Names on all pages of this configuration.

**Indicator Labels:** Allows you to automatically center all Indicator Labels within the Indicator Template label area on all pages of this configuration.

**Control Button Labels:** Allows you to automatically center all Control Button Labels for all templates which have control buttons defined on all pages of this configuration.
Page Properties
When a configuration page is selected in the Database Treeview Window and the Properties button is clicked, the Page Properties dialog box will appear.

The Page Properties dialog box is used to determine features for individual configuration pages and to determine features for the Maintenance Template. For more information about the Maintenance Template, refer to the Maintenance Template topic.
The fields in the **Page Properties** dialog box are described below.

**Page**

**Number:** Allows you to enter a page number for the configuration page.

**Title:** Allows you to enter a title for the page.

**Protection:** Allows you to control access to individual pages. If the operator does not enter the correct password or if operator cannot unlock the security keyswitch wired to the PanelMate unit, the page will not be displayed. The selections available are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B Only

The page will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option which may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.

---

**Tip**

*If a page is password protected, but is selected as the startup page in the Startup Page field in the System Parameters - General Tab dialog box, password protection will be ignored on initial bootup.*
Maintenance Templates

Maintenance Templates are designed to replace TCAM (timer/counter access module) and RAP (register access panel) devices that are typically used during the setup and troubleshooting of PLCs.

**Allow On Page:** Determines if the operator can display the pop-up Maintenance Template over the current page.

**Enable Writes:** Determines if the operator can change the data or just monitor data in the Maintenance Template. If the Enable Writes box is selected, the data is read/write. If the Enable Writes box is not selected, the data is read-only.

⚠️ **CAUTION:** Make your selection based on the expertise of operators and maintenance personnel.

**Protection:** Allows you to select a type of protection for displaying Maintenance Templates on the current page. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

The Maintenance Template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the System Parameters - Password Tab dialog box.

The security keyswitch is an option which may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.

For additional information about Maintenance Templates, see the Maintenance Template topic.
Flexible Page Layout

The Flexible Page Layout feature is intended for use on touchscreen units only.

If a flexible item appears on top of a template or graphic on your configuration page, the underlying template or graphic will be deleted when the configuration is exported.

**Page Status Banner**: Allows you to determine if the Page Status Banner will appear on the screen of your touchscreen unit. Note that if you do not want the Page Status Banner to appear, you must select the Flexible Page Layout field in the **System Parameters - General Tab** dialog box and de-select the Page Status Banner box.

**Default Buttons**: Allows you to determine if the default buttons will appear on the screen of your touchscreen unit. Note that if you do not want the Default Buttons to appear, you must select the Flexible Page Layout field in the **System Parameters - General Tab** dialog box and de-select the Default Buttons box.

**Alarm Table**: Allows you to determine if alarms will appear on the screen of your touchscreen unit. Note that if you do not want alarms to appear, you must select the Flexible Page Layout field in the **System Parameters - General Tab** dialog box and de-select the Alarms Table box.

**Cancel Key**: Allows you to determine if the CANCEL key will appear on the screen of your touchscreen unit. Note that if you do not want the CANCEL key to appear, you must select the Flexible Page Layout field in the **System Parameters - General Tab** dialog box and de-select the Cancel Key box.
Font Editor

In this chapter, you will learn:

- About the Font Editor
- About character sets
Font Editor

When you double click on the Normal, Graphic, Double High, or Quad selection under Screen Fonts in the Database Treeview Window, the **Font Editor** dialog box will appear.

The **Font Editor** dialog box allows you to edit existing characters or create new characters while still viewing the page layout.
The three buttons at the top of the **Font Editor** dialog box are described below.

- ![Set All Pixels to White](image)
  - This button will set all pixels to white in the 8x16 pixel box.

- ![Set All Pixels to Black](image)
  - This button will set all pixels to black in the 8x16 pixel box.

- ![Invert All Pixels](image)
  - This button will invert all pixels to the opposite color (i.e., black pixels to white pixels and white pixels to black pixels) in the 8x16 pixel box.

The 8x16 pixel box gives you the ability to create custom characters by redefining or creating a new character in the 8 x16 pixel bitmap box for each character. The character set may be selected in the Normal Font to Use field and the font may be selected in the Selected Font field.

The fields in the **Font Editor** dialog box are described below.

**Normal Font to Use:** Allows you to select a character set. The character sets are listed below.

- English
- Danish1
- French1
- French2
- German1
- Spanish1
- Swedish1

**Selected Font:** Allows you to select the font to edit. The selections available are Normal, Graphics, Double High, and Quad. To view the Normal characters, refer to the **English Font** topic. To view Graphic characters, refer to the **Graphics Font** topic.

Note that the Double High and Quad fonts are only available if you selected the Redefine Quad Font or Redefine Double High Font fields in the **System Parameters** - **General Tab** dialog box.
The table below lists the fonts and the number of characters that can be edited.

<table>
<thead>
<tr>
<th>Fonts</th>
<th>Number of Standard Font Characters</th>
<th>Number of Extended Font Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>10 ASCII characters 22-31</td>
<td>138 ASCII characters 22-31 and 128-255</td>
</tr>
<tr>
<td>Graphic</td>
<td>26 ASCII characters 101-126</td>
<td>154 ASCII characters 101-126 and 128-255</td>
</tr>
<tr>
<td>Double High</td>
<td>126 ASCII characters 1-126</td>
<td>254 ASCII characters 1-126 and 128-255</td>
</tr>
<tr>
<td>Quad</td>
<td>126 ASCII characters 1-126</td>
<td>254 ASCII characters 1-126 and 128-255</td>
</tr>
</tbody>
</table>

If you have strings using extended font characters and you disable the Enable Extended Fonts field in the System Parameters - General Tab dialog box, the strings will be truncated after and including the first character from the extended area (characters 128-255) of the font when the configuration is exported.

To access the extended fonts, the Enable Extended Fonts field must be selected in the System Parameters - General Tab dialog box.

Note that when redefining a character or editing a character that already exists in a font, the font will be changed on all pages where it is used.

**Selected Character**

**ASCII Char:** Displays the ASCII character number for the character selected in the character selection window.

**Recall Key:** Displays the recall key or combination of keys you must enter to get the character to display.

**Character Selection Window:** Displays characters from the character set you selected in the Selected Font field. When a character has been selected, the character will be displayed in the 8x16 pixel box. You may use the scroll bar to scroll through the character set.
English Font

To enter the following characters, press the recall key(s). Refer to the examples below.

Examples:

To enter the character /, press the recall keys ~Q.

To enter the character C, press the recall key C.

To enter the character ®, press the recall keys ALT+0174.
Danish1 Font

To enter the following characters, press the recall key(s). Refer to the examples below.

Examples:

To enter the character Æ, press the recall keys ~W.

To enter the character C, press the recall key C.

To enter the character Ø, press the recall keys ALT+0174.
French1 Font
To enter the following characters, press the recall key(s). Refer to the examples below.

Examples:
To enter the character É, press the recall keys ~].
To enter the character C, press the recall key C.
To enter the character ®, press the recall keys ALT+0174.
French2 Font

To enter the following characters, press the recall key(s). Refer to the examples below.

Examples:

To enter the character ê, press the recall keys ~.  
To enter the character C, press the recall key C.  
To enter the character ®, press the recall keys AL{T+0174.}
German1 Font

To enter the following characters, press the recall key(s). Refer to the examples below.

Examples:

To enter the character Ü, press the recall keys ~[.  
To enter the character C, press the recall key C.  
To enter the character ®, press the recall keys ALT+0174.

\[ \begin{array}{cccccccc}  \$ & ! & " & # & \$ & \% & \& & \' \\
~A & ~B & ~Ç & ~D & ~E & ~F & ~G \\
~H & ~I & ~J & ~K & ~L & ~M & ~N & ~Ö \\
\} & \} & \} & \} & \} & \} & \} & \} \\
~P & ~Q & ~R & ~S & ~T & ~U & ~V & ~W \\
\} & \} & \} & \} & \} & \} & \} & \} \\
~X & ~Y & ~Z & ~[ & ~\} & ~\} & ~^ & ~_ \\
( & ) & * & + & , & - & . & / \\
0 & 1 & 2 & 3 & 4 & 5 & 6 & 7 \\
8 & 9 & : & ; & \< & \= & \> & ? \\
@ & A & B & C & D & E & F & G \\
H & I & J & K & L & M & N & O \\
P & Q & R & S & T & U & V & W \\
X & Y & Z & [ & \} & ^ & \_ \\
\} & a & b & c & d & e & f & g \\
h & i & j & k & l & m & n & o \end{array} \]
PanelMate Power Series/PC Configuration Editor User's Guide
Spanish1 Font

To enter the following characters, press the recall key(s). Refer to the examples below.

Examples:

To enter the character Ñ, press the recall keys ~Y.

To enter the character C, press the recall key C.

To enter the character ®, press the recall keys ALT+0174.

\[\begin{array}{cccccccccc}
! & " & # & $ & % & & & & & \\
( & ) & * & + & , & - & . & / & & \\
0 & 1 & 2 & 3 & 4 & 5 & 6 & 7 & & \\
8 & 9 & : & ; & < & = & > & ? & & \\
@ & A & B & C & D & E & F & G & & \\
H & I & J & K & L & M & N & O & & \\
P & Q & R & S & T & U & V & W & & \\
X & Y & Z & [ & \ & ] & ^ & _ & & \\
a & b & c & d & e & f & g & h & i & j & k & l & m & n & o
\end{array}\]
PanelMate Power Series/PC Configuration Editor User's Guide
Swedish1 Font

To enter the following characters, press the recall key(s). Refer to the examples below.

Examples:

To enter the character ö, press the recall keys ~X.

To enter the character C, press the recall key C.

To enter the character ®, press the recall keys ALT+0174.
Graphic Font

To enter the following characters, press the recall key(s). Refer to the examples below.

Examples:

To enter the character łuż, press the recall keys ~Q.
To enter the character łuż, press the recall key N.
+  -  p  q  r  s  t  u  v  w
x  y  z  {  |  }  ~  ALT+0127

ALT+0128  ALT+0129  ALT+0130  ALT+0131  ALT+0132  ALT+0133  ALT+0134  ALT+0135
ALT+0136  ALT+0137  ALT+0138  ALT+0139  ALT+0140  ALT+0141  ALT+0142  ALT+0143
ALT+0144  ALT+0145  ALT+0146  ALT+0147  ALT+0148  ALT+0149  ALT+0150  ALT+0151
ALT+0152  ALT+0153  ALT+0154  ALT+0155  ALT+0156  ALT+0157  ALT+0158  ALT+0159
ALT+0160  ALT+0161  ALT+0162  ALT+0163  ALT+0164  ALT+0165  ALT+0166  ALT+0167
ALT+0168  ALT+0169  ALT+0170  ALT+0171  ALT+0172  ALT+0173  ALT+0174  ALT+0175
ALT+0176  ALT+0177  ALT+0178  ALT+0179  ALT+0180  ALT+0181  ALT+0182  ALT+0183
ALT+0184  ALT+0185  ALT+0186  ALT+0187  ALT+0188  ALT+0189  ALT+0190  ALT+0191
ALT+0192  ALT+0193  ALT+0194  ALT+0195  ALT+0196  ALT+0197  ALT+0198  ALT+0199
ALT+0200  ALT+0201  ALT+0202  ALT+0203  ALT+0204  ALT+0205  ALT+0206  ALT+0207
ALT+0208  ALT+0209  ALT+0210  ALT+0211  ALT+0212  ALT+0213  ALT+0214  ALT+0215
ALT+0216  ALT+0217  ALT+0218  ALT+0219  ALT+0220  ALT+0221  ALT+0222  ALT+0223
ALT+0224  ALT+0225  ALT+0226  ALT+0227  ALT+0228  ALT+0229  ALT+0230  ALT+0231
ALT+0232  ALT+0233  ALT+0234  ALT+0235  ALT+0236  ALT+0237  ALT+0238  ALT+0239
ALT+0240  ALT+0241  ALT+0242  ALT+0243  ALT+0244  ALT+0245  ALT+0246  ALT+0247
ALT+0248  ALT+0249  ALT+0250  ALT+0251  ALT+0252  ALT+0253  ALT+0254  ALT+0255
In this chapter, you will learn:

- About the Symbol Library
- About the Symbol Properties
- About the Symbol Origin
Symbol Library

For information on creating symbols, refer to the Make Symbol topic.

When symbols have been created in the configuration and you click on a symbol name under the Symbol Library selection in the Database Treeview Window, the Symbol Library dialog box will appear.

The Symbol Library dialog box allows you to view all symbol names that have been created for your configuration.
Chapter 5: Symbol Library

The fields in the Symbol Library dialog box are described below.

**Symbol Name:** Displays the name of the symbol you selected. Note that you may scroll through the symbol name list and preview each symbol if the Show Preview box is selected.

**Symbol Origin Offset:** Displays the symbol’s origin offset (in pixels). The default Symbol Origin Offset for X and Y is 0 and 0 (no offset).

- **X:** Displays the X origin offset in pixels.
- **Y:** Displays the Y origin offset in pixels.

**Preview:** Displays the selected symbol in the Preview box if the Show Preview box is selected.

**Show Preview:** Allows the selected symbol to be shown in the Preview box.

You may double click on a symbol on a configuration page to view the Symbol Properties dialog box. Refer to the Symbol Properties topic for more information.

The objects that make up a symbol cannot be edited. If you wish to change an object within a symbol, you must select the symbol on the configuration page and choose the Break Symbol selection under the Object Menu to break the symbol into the original separate objects. The objects may be edited and then you may choose the Make Symbol selection from the Object Menu again.
Symbol Properties

When you double click on a symbol on a configuration page, the Symbol Properties dialog box will appear.

The Symbol Properties dialog box allows you to change the pixel location and the X-Y offset of the symbol and preview the selected symbol.
The fields in the **Symbol Properties** dialog box are described below.

**Symbol Name:** Displays the name of the symbol you selected. Note that you may scroll through the symbol name list and preview each symbol if the Show Preview box is selected.

**Symbol Origin Offset:** Displays the symbol’s origin offset (in pixels). The default Symbol Origin Offset for X and Y is 0 and 0 (no offset). The blinking crosshair in the bounding box represents the origin location. All of the objects that make up a symbol are drawn using an offset from the origin.

   - **X:** Displays the X origin offset in pixels.
   - **Y:** Displays the Y origin offset in pixels.

**Preview:** Displays the selected symbol in the Preview box if the Show Preview box is selected.

**Show Preview:** Allows the selected symbol to be shown in the Preview box.

**Pixel Location:** Allows you to change the pixel location for the selected symbol.

   - **X:** Allows you to move the symbol to the left or right on the configuration page. The value entered in the X field determines the distance in pixels from the left edge of the page.
   - **Y:** Allows you to move the symbol up and down on the configuration page. The value entered in the Y field determines the distance in pixels from the top of the page.

**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of the symbol to be refreshed to properly reflect the layering of objects on the page whenever the symbol is updated.
Enable Conditional Visibility: Allows you to determine if the symbol will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the symbol will always appear on the page.

Note that a symbol that is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the symbol is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

It is also important to note that if you attempt to layer more than two symbols and use the Enable Conditional Visibility feature to display different states of a symbol on a PanelMate Power Series 1500 unit, the PanelMate unit’s performance may be sluggish. If this occurs, the Dynamic Graphics option should be installed and Variable-Sized Graphic objects should be used to display the different symbol states.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the symbol will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the symbol will appear and all template updating will be activated when in Run Mode.

<Origin>: Opens the Symbol Origin dialog box. This button allows you to change the selected symbol’s Origin Offset.
Symbol Origin
When you press the Origin button on the Symbol Properties dialog box, the Symbol Origin dialog box will appear.

The Symbol Origin dialog box allows you to change the offset of the selected symbol’s origin.

⚠️ CAUTION: Changing the origin affects ALL occurrences of this symbol in this configuration!
The fields in the **Symbol Origin** dialog box are described below.

**Symbol Origin Offset**: Allows you to change the offset of the symbol’s origin. Note that if you modify the offset, you will be modifying the offset of the actual symbol in the Symbol Library that may be used on several pages throughout the configuration. If you increase the X and Y offsets, the objects in the symbol will move left and down respectively. If you decrease the X and Y offsets, the objects in the symbol will move right and up respectively. The blinking crosshair will remain at a constant position that is the origin location.

The values in the X and Y offsets are added to the original offset of each object from the upper-left corner of the bounding box. If an object in the symbol was originally 20 pixels in X from the blinking crosshair and you modified the X origin offset to be 10, the object would be drawn 30 pixels \((20 + 10 = 30)\) from the blinking crosshair. Likewise, if you modified the X origin offset to be -10, the object would be drawn 10 pixels \((20 + (-10) = 10)\) from the blinking crosshair.

**X**: Allows you to offset the symbol to the left or right.

**Y**: Allows you to offset the symbol up or down.

For more information on the Symbol Origin Offset, refer to the **Symbol Origin Offset Example**.
Symbol Origin Offset Example
A circle has been created with a height of 100 pixels and a width of 100 pixels and made into a symbol. The blinking crosshair that represents the origin appears in the upper-left corner. The X and Y origin offset is 0 and 0. Refer to the figure below.

To offset the symbol so the origin appears in the center of the circle, change the X and Y origin offset to -50 and -50. Refer to the figure below.

Now when symbol is used, the location you click on the configuration page will be at the center of the circle instead of the upper-left corner.
In this chapter, you will learn:

- About the System Parameters - General Tab dialog box
- About the System Parameters - Password Tab dialog box
- About the System Parameters - Communications Tab dialog box
- About the System Parameters - Remote Tab dialog box
System Parameters

When you double click on the System Parameters selection in the Database Treeview Window, the **System Parameters** dialog box will appear.

System Parameters are a set of four tabbed dialog boxes used to edit system parameters. The System Parameters are used by the PanelMate unit while it is in Run Mode. The dialog boxes are listed below.

- System Parameters - General Tab
- System Parameters - Password Tab
- System Parameters - Communications Tab
- System Parameters - Remote Tab
System Parameters – General Tab

The System Parameters - General Tab dialog box is shown below.

The fields in the System Parameters - General Tab dialog box are described below.

Audio Output

Operator Input: Sets the volume of the audio tones used as feedback for operator inputs.

Alarms: Sets the volume of alarm annunciation.
**Inactivity Periods**

**Screen Blanking:** Determines the time the PanelMate unit waits, without operator input, before blanking the screen. This function helps prolong the life of the monitor.

To prevent “screen burn”, the PanelMate unit waits the indicated number of minutes. If there is no operator input during this time, the PanelMate unit displays a screensaver that shows PanelMate units randomly appearing.

Any operator input resets the Screen Blanking timer and recalls the previously displayed page. The page is also recalled automatically if any template or variable-sized template goes into alarm or if an automatic page change occurs.

**Automatic Cancel:** Determines the time the PanelMate unit waits, without operator input, before de-selecting a template. This function helps prevent accidental usage of the control buttons if you leave a template or variable-sized template selected after use.

Any operator input resets the Automatic Cancel timer.

Note that the Automatic Cancel time-out also resets the Screen Blanking timer.

**Fonts**

- **Redefine Quad Font:** Allows you to re-define the Quad Font. When the Redefine Quad Font box is selected, custom characters can be created in the Font Editor. Refer to the Font Editor topic for more information.

- **Redefine Double-High Font:** Allows you to re-define the Double-High font. When the Redefine Double-High Font box is selected, custom characters can be created in the Font Editor. Refer to the Font Editor topic for more information.

- **Enable Extended Fonts:** Allows you to extend the character set from 128 characters to 256 characters. The extended characters can be customized. Refer to table in the Selected Font section in the Font Editor topic for more information.
Chapter 6: System Parameters

**Tip**

If you are creating a V2.1X configuration for a PanelMate unit with 10 pages (numbered 0-9), the Standard selection can be selected if you wish to display all page numbers. The intensity or color of each number will indicate the status of that page.

**Page**

**Startup Page Number:** Allows you to enter the page number of the page to be displayed first when the PanelMate unit enters the Run Mode.

**Control Bit Reset Delay:** Sets the delay between the bit-set and bit-clear commands sent to a PLC from the control buttons. Since control buttons can be pressed (causing bit-set) and released (causing bit-clear) very quickly, some PLC programs need time to sense the bit-set command before receiving a bit-clear command.

**Page Status Line Display:** Determines how the Page Status Line is displayed during Run Mode. The Page Status Line will display only the pages in alarm in a first-in-first-out (FIFO) format.

**Enable Host Display Window:** Allows you to enable an extra page that can receive and display data from a host computer. The Host Display Window uses the entire 3x5 template display area. Data is sent from the host computer via the Generic Protocol.

Refer to the Generic Protocol Driver Manual for more information about the Host Display Window.

Note that if you are creating a PanelMate PC configuration, do not enable the Host Display Window.

**Allow Immediate Page Change:** Determines if a PLC can change the displayed page (through the Page Change Register field) while the PanelMate unit has a template or variable-sized template selected.

If the Allow Immediate Page Change field is selected, the page change can occur even if the operator is in the process of entering information.

If the operator is pressing a control button at the time a page change from the PLC occurs, the CANCEL key will need to be pressed to initiate the page change.

If the Allow Immediate Page Change field is not selected, the page change will not occur until all templates and variable-sized templates are de-selected (such as when the CANCEL key has been pressed).
**Direct Select (Touchscreen Only):** Allows one-touch selection on touchscreen units for variable-sized templates. For example, instead of having to step through multiple objects to get to a variable-sized template, you can touch the object to immediately select it.

The Direct Select feature also enables one-touch operation for the Variable-Sized Control Buttons. For more information about Variable-Sized Control Buttons, refer to the **Variable-Sized Control Button Template** topic.

Note that The Direct Select (Touchscreen Only) feature is intended for use on PanelMate touchscreen units and PanelMate PC units only.

**Flexible Page Layout:** Allows you to use the entire 640 x 464 pixel page for templates and PowerGraphics. When the Flexible Page Layout box is selected, you can determine which flexible items will not appear on the page by de-selecting the Page Status Banner box, Alarm Table box, Cancel Key box, or Default Buttons box in the **New Configuration Page** dialog box or the **Page Properties** dialog box. Refer to the **New Configuration Page** or **Page Properties** topic for more information.

Note that if a flexible item appears on top of a template or graphic on your configuration page, the underlying template or graphic will be deleted when the configuration is exported.
System Parameters – Password Tab

The System Parameters - Password Tab dialog box is shown below.

The fields in the System Parameters - Password Tab dialog box are described below.

Passwords

Password A: Allows you to enter the numeric password definition. Passwords can be used to limit operator access to pages, offline mode, date/time change, and numeric entry from templates.

The default Password A sent with the demonstration screens is 1.
**Overwrite Password A:** Determines whether Password A already set in the PanelMate online unit will be overwritten when a new configuration is downloaded. You may want the operator to learn a pair of passwords that will not change with every new configuration.

If the Overwrite Password A box is not selected, new passwords will be ignored when a new configuration is downloaded.

If the Overwrite Password A box is selected, the passwords saved in the new configuration become active when the configuration is downloaded.

**Allow Password A Change:** Determines whether Password A can be changed during Run Mode.

If the Allow Password A Change box is not selected, the password cannot be changed. Note that the Change Password A template will not appear on the Setup Page in Run Mode.

If the Allow Password A Change box is selected, the password can be changed by an operator having the password. To change the password in Run Mode, select the Change Password A Template on the Setup Page.

**Password B:** Allows you to enter the numeric password definition. Passwords can be used to limit operator access to pages, offline mode, date/time change, and numeric entry from templates.

The default Password B sent with the demonstration screens is 2.

**Overwrite Password B:** Determines whether password B already set in the PanelMate online unit will be overwritten when a new configuration is downloaded. You may want the operator to learn a pair of passwords that will not change with every new configuration.

If the Overwrite Password B box is not selected, new passwords will be ignored when a new configuration is downloaded.

If the Overwrite Password B box is selected, the passwords saved in the new configuration become active when the configuration is downloaded.
Allow Password B Change: Determines whether Password B can be changed during Run Mode.

If the Allow Password B Change box is not selected, the password cannot be changed. Note that the Change Password B Template will not appear on the Setup Page in Run Mode.

If the Allows Password B Change box is selected, the password can be changed by an operator having the password. To change the password in Run Mode, select the Change Password B Template on the Setup Page.

Password Protection

Entry into Offline Mode: Allows you to select a type of protection for entering into the Offline Mode. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

The page will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the Password A and Password B fields.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.
**Set Date/Time:** Allows you to select a type of protection for setting the date and time. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

The page will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the Password A and Password B fields.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.

**Page Password Timeout:** Allows the password to be valid for a defined number of minutes before timing out. Note that a value of 0 (zero) indicates that there is no timeout period.
System Parameters – Communications Tab

The System Parameters - Communications Tab dialog box is shown below.

The fields in the System Parameters - Communications Tab dialog box are described below.

Scan Delay In Seconds

Scan delay is the amount of time the PanelMate unit will wait upon receiving data from the PLC before it requests another update from the PLC.

Note that a value of 0 (zero) causes the PanelMate unit to continually scan. The maximum value is 99.99 seconds. For best performance, set the delay to the longest interval your application will permit. A minimum of 1.0 seconds is recommended.
**Screen**: Sets the scan delay for page updates while in Run Mode. A value of 0 causes the PanelMate unit to update a page as fast as possible. The maximum value is 99.99 seconds.

**Alarm**: Sets the scan delay for updates of all alarms while in Run Mode. A value of 0 causes the PanelMate unit to update background alarms as fast as possible. The maximum value is 99.99 seconds.

All PLC references in the **System Parameters** dialog box will be polled as part of the Alarm Scan.

**Message**: Sets the scan delay for updates from all register references (defined in messages) while in Run Mode. A value of 0 causes the PanelMate unit to update the register values as fast as possible. The maximum value is 99.99 seconds.

**Trend**: Sets the scan delay for updates from the PLC of all register references for Bar Trend Templates and Line Trend Templates while in Run Mode. A value of 0 causes the PanelMate unit to update the register values as fast as possible. The maximum value is 99.99 seconds.

Note that the interval evaluated in the Interval Expression field in the **Bar Trend Template - Bar Trend Attributes Tab** dialog box or the **Line Trend Template - Line Trend Attributes Tab** dialog box should be as long, if not longer, then the Trend Scan Delay.

For information about calculating the trend value sample rate, refer to Interval Expression field in the **Bar Trend Template - Bar Trend Attributes Tab** dialog box or the **Line Trend Template - Line Trend Attributes Tab** dialog box.

**Retry Delay**: Determines if there will be a delay between communication attempts when there is lost communications. When the Retry Delay box is selected, the PanelMate unit will increase the time interval of attempts to re-establish communications as the length of time that the PanelMate unit and the PLC are not communicating increases. If this feature is enabled, it will prevent several PLCs on a network from becoming busy unnecessarily if communications have not taken place over a long period of time. When the Retry Delay box is not selected, the PanelMate unit will immediately and continuously attempt to re-establish communications. If this feature is not enabled, it will prevent any delays that may occur after successfully sending data to the PLC.
**Bit Zero After Comm Fault:** Provides the capability to reset (i.e., write zeroes to) all PLC bits configured in the PLC Bit Reference fields for each control button. The PLC bits will reset when a PLC communication error has been cleared (i.e., communication with the PLC has been re-established) and the Enable Fault Relay control button is pressed. If the Bit Zero After Comm Fault box is selected, the automatic reset of all PLC bits will be enabled. If the Bit Zero After Comm Fault box is not selected, the automatic reset of PLC bit will be disabled.

If Bit Zero After Comm Fault box is selected, the Fault Relay De-energize On Alarm box must be de-selected.

If the fault relay is enabled via the Remote Enable Fault Relay Bit (from the PLC) field, the Bit Zero After Comm Fault field is disabled. The Bit Zeros After Com Fault field is only applicable when the **Enable Fault Relay** control button is pressed.

**Fault Relay De-energize On Alarm:** Allows you to control what happens to the PanelMate unit’s fault relay when a alarm occurs. If the Fault Relay De-energize on Alarm box is selected, the fault relay will be de-energized when a communication error or system error occurs, when power is lost, when an alarm condition is detected, or when the PanelMate unit is put into offline mode. If the Fault Relay De-energize on Alarm box is not selected, the fault relay will only de-energize when a communication error or system error occurs, when power is lost, or when the PanelMate unit is put into offline mode.

If the Fault Relay De-energize On Alarm box is selected, the Bit Zero After Com Fault box must be disabled.
System Parameters – Remote Tab

The System Parameters - Remote Tab dialog box is shown below.

The fields in the System Parameters - Remote Tab dialog box are described below.

Remote Alarm Acknowledge Bit

Only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left blank, the features will be disabled.

To PLC: Allows you to set a bit in the PLC when the Acknowledge All Alarms control button is pressed during Run Mode.

From PLC: Allows you to scan a bit in the PLC and acknowledge all current alarms when the bit is set.

Remote Silence Alarm Horn Bit

Remote Enable Fault Relay Bit

Remote Sending of Passwords

Password A:

Password B:

Hardware Selection:

Reset Clock to 00:00:00 Bit: [ ]

Remote Mode Change: [Never]

 inserts a graphical or diagrammatic representation of the System Parameters - Remote Tab dialog box.
Remote Silence Alarm Horn Bit

Only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left blank, the features will be disabled.

To PLC: Allows you to set a bit in the PLC when the Silence Alarm Horn button is pressed during Run Mode.

From PLC: Allows you to scan a bit in the PLC and silence the alarm horn when the bit is set.

Remote Enable Fault Relay Bit

Only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left blank, the features will be disabled.

To PLC: Allows you to set a bit in the PLC when the Enable Fault Relay control button is pressed during Run Mode.

From PLC: Allows you to scan a bit in the PLC and enable the fault relay when the bit is set.

Page Change Register

For information on changing pages by pressing a control button, refer to the Page Change with Delay Example topic.

Only register references are allowed in these boxes. Expressions may not be entered. If these boxes are left blank, the features will be disabled.

To PLC: Allows you to write the page number of the currently displayed page to a register in the PLC during Run Mode. Note that there are two unique page numbers. The Alarm Page number is 100 and the Setup Page number is 102. All other pages will use the page number defined in the New Configuration Page dialog box or the Page Properties dialog box.
From PLC: Allows you to scan a register in a PLC and change to the page number matching the register value. When a new valid page number is detected in the Page Change Register, the title bar will blink. The page does not change immediately if the operator has selected a control template, but waits until the control template is de-selected. This requirement can be changed if the Allow Immediate Page Change box is selected in the Systems Parameters - General Tab dialog box.

If the Page Change Register receives a valid page number that is the same as the number in the register, it will not change pages.

If the Page Change Register receives an invalid number, it will remain on the current page.

If the operator is pressing a control button at the time a page change from the PLC occurs, the CANCEL key will need to be pressed to initiate the page change.

Note that the Page Change Register will override Page Password Protection. If necessary, use Remote Sending of Passwords and PLC ladder logic to implement a protection scheme.

Remote Sending Of Passwords

Only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left blank, the features will be disabled.

Password A: Allows you to set a bit in the PLC when the operator enters valid passwords during Run Mode. The bit is set when the password is logged-in on the Setup Page during Run Mode.

Password B: Allows you to set a bit in the PLC when the operator enters valid passwords during Run Mode. The bit is set when the password is logged-in on the Setup Page during Run Mode.

Hardware Selection: Allows you to set a bit in the PLC when an external keyswitch is turned on during Run Mode. The bit is set when the hardware contact is closed and the keyswitch is closed (on).
**Reset Clock To 00:00:00 Bit:** Allows you to scan a bit in the PLC and reset the PanelMate unit’s system clock when the bit is set. (The clock will reset each time you change to a page that has the reset clock bit set to 1.)

Note that only bit references are allowed in these boxes. Expressions may not be entered. If these boxes are left blank, the features will be disabled.

The date is changed to the day closest to the current time. The following examples show how the date is affected by the clock synchronization bit.

<table>
<thead>
<tr>
<th>Time/Date Before Reset</th>
<th>Time/Date After Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>23:30:10 December 10, 1997</td>
<td>00:00:00 December 11, 1997</td>
</tr>
<tr>
<td>00:30:10 December 13, 1997</td>
<td>00:00:00 December 13, 1997</td>
</tr>
<tr>
<td>12:00:00 December 24, 1997</td>
<td>00:00:00 December 25, 1997</td>
</tr>
<tr>
<td>11:59:59 December 27, 1997</td>
<td>00:00:00 December 27, 1997</td>
</tr>
</tbody>
</table>

**Remote Mode Change:** Allows the PanelMate unit to accept remote mode changes from Run Mode to Transfer Mode (or vice-versa) from a personal computer over a network. It also determines the manner in which the remote mode change will occur. The selections are listed below.

- **NEVER** A remote mode change is not allowed.
- **IMMEDIATE** The remote mode change will occur instantly.
- **DEFAULT** The remote mode change will occur when the PanelMate unit is in a default state (no templates or symbols are selected on screen).
- **ACCEPT** An operator must accept the remote mode change at the online unit.
Page Change with Delay Example

The ladder program below shows a page change with a time delay.

This ladder program will allow the operator to change pages by pressing a control button on the PanelMate unit. The second move ensures that there will be a change in the register next time I1 is pressed.

Note that the timers can be adjusted to lengthen or shorten the time delay.
In this chapter, you will learn:

- About the PLC Name and Port Table dialog box
- About the Port Settings dialog box
- About the Unsolicited Device dialog box
- About the Generic Protocol dialog box
- About the AB DH-485 Maximum Node Address dialog box
- About the Allen-Bradley Remote I/O Setup dialog box
- About the GE Fanuc Genius I/O dialog box
- About the Reliance DCSNet Interface Drop dialog box
- About the DeviceNet Setup dialog box
PLC Name and Port Table

When you double click on the PLC Name and Port Table selection in the Database Treeview Window, the **PLC Name and Port Table** dialog box will appear.

The **PLC Name and Port Table** dialog box allows you to set communication port parameters, PLC device names, and ID numbers.
The fields in the **PLC Name and Port Table** dialog box are described below.

**Port Parameters**

- **Port/Device Use/Local ID:** Displays the configurable ports installed on your PanelMate unit, the device assigned to the port, and the local ID.

- **Device Use:** Displays the device assigned to the port. You can select various PLC drivers, Serial Printer, or No Usage from the Device Use box. The selection chosen in the Device Use box will appear in the Port/Device Use/Local ID box. Different device drivers will appear in the list for the Device Use box depending on the port you have selected in the Port/Device Use/Local ID box. Note that only device drivers that have been installed from the driver disks will appear.

- **Local ID:** Assigns a number to the PanelMate unit on a PLC network. See the appropriate Communication Driver Manual for PLC-dependent local ID# information.

Do not use the same number for the Local ID and the remote ID.

- **<Port Settings>:** Displays the **Port Settings** dialog box. The **Port Settings** dialog box is used to select the communication parameters for the selected port. Refer to the **Port Settings** topic for more information.

- **<Unsolicited Device>:** Displays the **Unsolicited Device** dialog box. The **Unsolicited Device** dialog box is used to assign a name and a model to an unsolicited device on the I/O port that is the only port that accepts unsolicited messages for communication. Refer to the **Unsolicited Device** topic for more information.

- **<Generic>:** Displays the **Generic Protocol** dialog box. The **Generic** button appears when you select Generic Protocol in the Device Use box. Refer to the **Generic Protocol** topic for more information.

- **<DH-485>:** Displays the **AB DH-485 Maximum Node Address** dialog box. The **DH-485** button appears when you select DH-485 in the Device Use box. Refer to the **AB DH-485 Maximum Node Address** topic for more information.

- **<Remote I/O>:** Displays the **Allen-Bradley Remote I/O Setup** dialog box. The **Remote I/O** button appears when you select Allen-Bradley Remote I/O in the Device Use box. Refer to the **Allen-Bradley Remote I/O Setup** topic for more information.
<Genius I/O>: Displays the Genius I/O dialog box. The Genius I/O button only appears when you select Genius I/O in the Device Use box. Refer to the GE Fanuc Genius I/O dialog box topic for more information.

<DCSNet>: Displays the Reliance DCSNet Interface Drop dialog box. The DCSNet button appears when you select Reliance DCSNet in the Device Use box. Refer to the Reliance DCSNet Interface Drop topic for more information.

<DeviceNet>: Displays the DeviceNet Setup dialog box. The DeviceNet button appears when you select DeviceNet in the Device Use box. Refer to the DeviceNet Setup topic for more information.

PLC Name Parameters

**Item/Name/Port/Model/Remote ID**: Displays the item number, PLC name, port number, model, and remote ID. If you choose the <New Entry> selection, you can configure a new PLC using default values for the Name, Port, Model, and Remote ID fields.

If you select <New Entry>, the **Copy, Paste, and Delete** buttons will be disabled.

**Name**: Allows you to enter names for each PLC to be addressed. This name is used by the PanelMate unit and does not make reference to the PLC directly. This name should be used when specifying word and bit addresses during page development.

**Port**: Allows you to define which ports will be used to communicate to each PLC. If a port has been configured as No Usage or Serial Printer, the port number will not appear in the Port field.

**Model**: Allows you to choose from a list of model types for each device. You should choose the model most closely related to the device being used.

**Remote ID**: Allows you to define the ID or node of each device.

**Add**: Allows you to add a new entry to the Item/Name/Port/Model/Remote ID box. If you select a port in the Port field, select a model in the Model field, and configure the Name and Remote ID fields, you can click the Add button to add a new entry to the Item/Name/Port/Model/Remote ID box.

**Change**: Allows you to change a selected entry in the Item/Name/Port/Model/Remote ID box. If you select an entry in the Item/Name/Port/Model/Remote ID box and make a change to the Name, Port, Model, and Remote ID fields, you can click the Change button to change an entry in the Item/Name/Port/Model/Remote ID box.
<Copy>: Allows you to copy a selected entry in the Item/Name/Port/Model/Remote ID box. If you select an entry in the Item/Name/Port/Model/Remote ID box and you can click the Copy button to copy an entry. After copying, you can use the Paste button to paste a copy of the entry elsewhere in the Item/Name/Port/Model/Remote ID box.

<Delete>: Allows you to remove an entry from the Item/Name/Port/Model/Remote ID box. If you select an entry in the Item/Name/Port/Model/Remote ID box and click the Delete button, the entry will be removed.

<Paste>: Allows you to paste an entry after copying an entry from the Item/Name/Port/Model/Remote ID box. If you select an entry in the Item/Name/Port/Model/Remote ID box and click the Paste button, the entry will be pasted after the entry you selected.

Default PLC Name: Allows you to enter one of the PLC names or Unsolicited Device names. Any word or bit address used in the configuration that does not specifically state the name of a PLC will be assumed to be referring to the default PLC. It is to your advantage to use the name of the PLC most often referenced.

If you delete or change the selected default name, the first name in the Item/Name/Port/Model/Remote ID box will automatically become the Default PLC Name.
Port Settings
When the Port Settings button is clicked on the PLC Name and Port Table dialog box, the Port Settings dialog box will appear.

![Port Settings dialog box]

The Port Settings dialog box is used to select the communication parameters for the selected port.

Note that depending upon the device selected in the Device Use box, some communication parameters may be disabled. If one of the choices is disabled, refer to the appropriate Communication Driver Manual for the settings.

The fields in the Port Settings dialog box are described below.

- **PORT#**: Displays the port selected in the Port/Device Use/Local ID box in the PLC Name and Port Table dialog box.

- **Electrical**: Allows you to set the type of electrical communication for the port. You have three choices: RS232, RS422, and 485.

- **Baud Rate**: Allows you to set the data transfer speed used in communications.

- **Data Bits**: Allows you to set the number of data bits used in communication. You can select 5, 6, 7, and 8 data bits.

- **Stop Bits**: Allows you to set the number of stop bits used in communications. You can select 1, 1.5, or 2 stop bits.

- **Parity**: Allows you to set the parity type used in communication. You can select None, Odd, or Even.
Unsolicited Device

When the Unsolicited Device button is clicked on the PLC Name and Port Table dialog box, the Unsolicited Device dialog box will appear.

The Unsolicited Device dialog box is used to assign a name and model to an unsolicited device.

The fields in the Unsolicited Device dialog box are described below.

PORT#: Displays the port selected in the Port/Device Use/Local ID box in the PLC Name and Port Table dialog box.

Name: Allows you to define names for each PLC to be addressed. You use this name when specifying word and bit addresses that will display unsolicited data only. References specified with an Unsolicited Device Name will not be polled by the PanelMate unit and will only be updated by an unsolicited write from the PLC.

Note that unsolicited references are initialized as zeroes.

Model: Allows you to define the model type of each PLC that supports unsolicited writes.

The PLC model type in the MSG instruction, configured in the PLC ladder logic, must match the PLC type in the Unsolicited Model field.

For more information about unsolicited data, refer to the Allen-Bradley Communication Driver Manual or the Modicon Communication Driver Manual.
Generic Protocol

To configure the **Generic Protocol** dialog box, the following steps must be completed.

1. A port must be selected and Generic must be selected in the Device Use field in the **PLC Name and Port Table** dialog box.
2. Click the **Generic** button and the **Generic Protocol** dialog box will appear.

The **Generic Protocol** dialog box is shown below.

The **Generic Protocol** dialog box is used to configure serial ports that use the Generic Protocol for communication.

The fields in the **Generic Protocol** dialog box are described below.

- **PORT #**: Displays the port selected in the Port/Device Use/Local ID box in the **PLC Name and Port Table** dialog box.
- **Name**: Allows you to define names for each device to be addressed. This name is used when specifying word and bit addresses during page development.
- **Type**: Defines the addressing method (octal or decimal) to be used in the PanelMate unit.
- **ID# included**: Specifies whether the ID number of the PanelMate unit will be used in the communication frames.
- **BCC/Bit# included**: Specifies whether each Generic Protocol frame includes BCC/Bit# error checking for the frame.

For more information about Generic Protocol, refer to the Generic Protocol Driver Manual.
**AB DH-485 Maximum Node Address**

To configure the **AB DH-485 Maximum Node Address** dialog box, the following steps must be completed.

1. The Allen-Bradley DH-485 box must be selected in the **New Configuration** dialog box or the **Configuration Properties** dialog box.

2. A port must be selected and Allen-Bradley Data Highway 485 must be selected in the Device Use field in the **PLC Name and Port Table** dialog box.

3. Click the **DH-485** button and the **AB DH-485 Maximum Node Address** dialog box will appear.

The **AB DH-485 Maximum Node Address** dialog box is shown below.

![AB DH-485 Maximum Node Address Dialog Box](image)

The **AB DH-485 Maximum Node Address** dialog box is used to select the maximum node address of the DH-485 network.

The fields in the **AB DH-485 Maximum Node Address** dialog box are described below.

**PORT#** Displays the I/O port which was selected in the Port/Device Use/Local ID box in the **PLC Name and Port Table** dialog box.

**Maximum Node Address:** Set the maximum node address. This parameter should be set as low as possible to minimize the amount of time used in soliciting data when initializing the link and minimizes the amount of unnecessary token passes.

The Maximum Node Address must match the maximum node address of all other devices on the DH-485.

For more information about Data Highway 485 communication, refer to the Allen-Bradley Communication Driver Manual.
Allen-Bradley Remote I/O Setup

To configure the Allen-Bradley Remote I/O Setup dialog box, the following steps must be completed.

1. The I/O port must be selected and Allen-Bradley Remote I/O must be selected in the Device Use field in the PLC Name and Port Table dialog box.

2. Configure the Name, Port, Model, Remote ID, and Default PLC Name and click the Add button to place the information in the Item/Name/Port/Model/Remote ID box in the PLC Name and Port Table dialog box.

   Note that the selection chosen in the Model field will determine the number of racks that will appear in the Allen-Bradley Remote I/O Setup dialog box. When configuring the I/O port for Allen-Bradley Remote I/O communication, select the PLC-3 model for PLCs with more than seven racks. PLC models (e.g., PLC 5/40, 5/60, 5/80, etc.) that have more than seven racks must use the PLC-3 model selection to address racks above seven.

3. Click the Remote I/O button and the Allen-Bradley Remote I/O Setup dialog box will appear.

The Allen-Bradley Remote I/O Setup dialog box is shown below.
The **Allen-Bradley Remote I/O Setup** dialog box is used to configure the PanelMate unit for remote I/O communication.

The fields in the **Allen-Bradley Remote I/O Setup** dialog box are described below.

**PLC Model:** Displays the PLC model selected in the **PLC Name and Port Table** dialog box.

**Active Rack:** Allows you to define which racks are to be simulated by the PanelMate unit on the network.

- **Rack Size:** Selects the quarter racks. Each full rack can be split into a quarter rack or any multiple of a quarter racks (i.e., ¼, ½, ¾, or full rack).

  A blank entry shows the rack is inactive. A status of ¼, ½, ¾, or F shows the rack to be active and indicates the starting quarter for a fractional rack. A dash (-) indicates this rack is reserved.

  See the **Active Rack Example**.

  Note that when using a PLC 2/30, if the PanelMate unit is configured as active groups within a rack other than the highest group, then the PLC will not scan for any groups higher than those the PanelMate unit is simulating (physical groups or groups simulated on another Accelerat/I/On board). To avoid this situation, make the PanelMate unit the highest active group within a rack and only configure one PanelMate unit active on any one rack.

**Block Transfer Addressing:** Allows you to define the word offset base in all monitored and active Block Transfers as OCTAL or DECIMAL. The default is octal.

The Block Transfer Addressing field only applies to the word offset. Bits within the words are addressed as octal (0-7 and 10-17).
Active Block Transfer Table: Allows you to configure active block transfers between the PanelMate unit and a PLC. You may define up to 16 active block transfers, A through P, each with up to 64 words.

**Direction:** This column defines the direction of the block transfer. The available selections are NONE, READ, WRITE, COMMON, and PASS-THROUGH.

- NONE indicates that there will not be a transfer. Note that when NONE is selected the other boxes in this group are disabled.
- READ allows the PLC to read a block of data from the PanelMate unit.
- WRITE allows the PLC to write a block of data to the PanelMate unit.
- COMMON allows the PLC to read data from and write data to the PanelMate unit.
- PASS-THROUGH indicates that the block transfer is reserved for the pass-through feature. The PASS-THROUGH selection can only configured for one block transfer.

All of the selections describe communication from the PLC’s point of view.

**Rack:** Defines the rack being used by the block transfer. The available selections are determined by the Active Rack Table.

**Group:** Defines the group number within the quarter rack being used by the block transfer. The selections available are 0 through 7.

**Slot:** Defines the slot number within the group being used by the block transfer. The available selections are 0 and 1.

**Size:** Defines the size in 16-bit words of the block transfer. The available selections are decimal numbers from 1 to 64. If the Direction is selected as PASS-THROUGH, the size is fixed at 64.

For more information about Remote I/O, refer to the Allen-Bradley Communication Driver Manual.
Active Rack Example
The example below shows a PanelMate unit simulating a full rack on rack 0, ¾ of rack 1 beginning with quarter 2, and ½ of rack 2 beginning with quarter 1.
GE Fanuc Genius I/O
To configure the GE Fanuc Genius I/O dialog box, the following steps must be completed.

1. The I/O port must be selected and Genius I/O must be selected in the Device Use field in the PLC Name and Port Table dialog box.

2. Click the Genius I/O button and the GE Fanuc Genius I/O dialog box will appear.

The GE Fanuc Genius I/O dialog box is shown below.

The fields in the GE Fanuc Genius I/O dialog box are described below.

- **Port#:** Displays the I/O port that was selected in the PLC Name and Port Table dialog box.

- **Global Data Length:** Specifies the number of bytes of Global Data the PanelMate unit will transmit each bus scan onto the Genius I/O bus. The valid range for Global Data Length is 0 to 128 bytes (0 to 64 words).

For more information about Genius I/O, refer to the GE Fanuc Driver Manual.
Reliance DCSNet Interface Drop

To configure the Reliance DCSNet Interface Drop dialog box, the following steps must be completed.

1. The I/O port must be selected and Reliance DCSNet must be selected in the Device Use field in the PLC Name and Port Table dialog box.

2. Click the DCSNet button and the Reliance DCSNet Interface Drop dialog box will appear.

The Reliance DCSNet Interface Drop dialog box is shown below.

The Reliance DCSNet Interface Drop dialog box is used to configure the PanelMate unit for DCSNet communication.

The fields in the Reliance DCSNet Interface Drop dialog box are described below.

**Port#:** Displays the I/O port that was selected in the Port field in the PLC Name and Port Table dialog box.

**Drop Setting:** Allows you to simulate the thumbwheel switches on the faceplate of a Network module and is the first of a number of consecutive drop numbers that the DCSNet Express Module will simulate. The selectable range of Drop Setting numbers is 1-55.

If the Drop Setting field is not edited, the value will be initialized to 1.

**Drop Depth:** Allows you to define the number of consecutive drops that the DCSNet Express Module will simulate. The selectable range of Drop Depth numbers will be based on the value in the Drop Setting field. The Drop Depth cannot make the last drop number greater than 55. For example, if the Drop Setting field has been set to 24, the Drop Depth field will allow values between 1 and 31.

If the Drop Depth field is not edited, the value will be initialized to 1.
DeviceNet Setup

To configure the DeviceNet Setup dialog box, the following steps must be completed.

1. The I/O port must be selected and DeviceNet must be selected in the Device Use field in the PLC Name and Port Table dialog box.

2. Click the DeviceNet button and the DeviceNet Setup dialog box will appear.

The DeviceNet Setup dialog box is shown below.

Note that when devices are added, changed, copied, or pasted to the Node/Message Type Table, the devices are sorted in ascending order by their MACID and then sorted in alphabetical order of their Label.

The DeviceNet Setup dialog box is used to configure the PanelMate unit for DeviceNet communication.
The fields in the **DeviceNet Setup** dialog box are described below.

**Label**: Allows you to enter a name that is used to reference messages. This field is limited to 13 alphanumeric characters. Note that the first letter must be an alpha character.

You can enter up to 379 labels.

**MACID**: Defines the MACID (node address) embedded in the 11-bit CAN (Controller Area Network) identifier. The valid range is 0 to 63.

In most cases, the MACID will contain the slave address. If the message type is BSC (bit strobe command), the MACID field must contain the master address.

A configuration will typically have only one BSC message type entered in the Node/Message Type Table.

**Message Type**: Allows you to define the type of message. The message types are listed below:

- PC Poll Command
- PR Poll Response
- BSC Bit Strobe Command
- BSR Bit Strobe Response
- CS Change of State
- MCSA Master Change of State Acknowledge
- MCS Master Change of State
- CSA Change of State Acknowledge

**Length**: Defines the length of the message in bytes. The range is 0 to 400 bytes.

**<Add>**: Allows you to add a device to the Node/Message Type Table by configuring the Label, MACID, Message Type, and Length fields and pressing the **Add** button.

**<Change>**: Allows you to change a device that has been selected in the Node/Message Type Table by re-configuring the Label, MACID, Message Type, and Length fields and pressing the **Change** button.

**<Copy>**: Allows you to copy a device that has been selected in the Node/Message Type Table.

**<Paste>**: Allows you to paste a device in the Node/Message Type Table. Note that a device must be copied from the Node/Message Type Table before you can paste a device in the table.

**<Delete>**: Allows you to delete a device in the Node/Message Type Table.

For more information about DeviceNet, refer to the DeviceNet Driver Manual.
In this chapter, you will learn:

- About the Message Library
- About Register References within Messages
Message Library

Note that all messages to be shown in a Display Template or a Variable-Sized Display Template must be defined in the Message Library. It is recommended to define the messages in the Message Library before configuring a Display Template or a Variable-Sized Display Template.

When you double click on the Message Library selection in the Database Treeview Window, the **Message Library** dialog box will appear.

The **Message Library** dialog box allows you to create new messages and edit or replace existing messages in the Message Library.

The fields in the **Message Library** dialog box are described below.

**Preview:** Displays the currently selected message with the selected colors and font.

Markings above the Preview box show the maximum message width for 3-wide, 4-wide, and 5-wide Display Templates. These markings indicate where the right edge of the Display Template will display the last character.
**Msg#/Message/Destination:** Displays the messages (as unformatted text) in the Message Library. The message selected in this box also displays in the Preview box. If more than one message is selected, the last one displays in the Preview box. The Msg#/Message/Destination box has three fields. The fields are described below.

- **Msg#:** Displays the message number. The message number is used to recall the message in the Display Template and Variable-Sized Display Template. All messages appear in numerical order. The number of messages that can be entered will vary depending on the product model and the options installed. Refer to the Capacity Expansion Kit section in the Product Options topic for information about the number of messages you can enter.

- **Message:** Displays the message text. A single message may contain up to five register references and clock or calendar references. (Refer to the Register References within Messages topic or the Clock and Calendar References within Messages topic for more information.) While in Run Mode, the register references are replaced with the numeric register content from the PLC.

- **Destination:** Displays the destination of the message (i.e., Screen, Printer, or Both).

To select one message, place the cursor on the message then click the left mouse button. A selected message displays in the highlight color.

To select a range of messages, select the first message, and then press the **Shift** key while you select the second message. All messages between the two messages will be selected. You can also drag the cursor to select a range of messages. Select the first message, then drag up or down.

To select two or more messages, select the first message, then press the **Ctrl** key while you select the second message. Both messages are selected, but messages in between will not be selected.

**Message:** Allows you to edit an existing message or create a new one. As you type, the message selected in the Msg#/Message/Destination box is updated.

To create a new message, select an unused message number in the Msg#/Message/Destination box. You can type your new message in the Message field.

To edit or replace a message, select a message in the Msg#/Message/Destination box. You can then edit the message in the Message field.
**FG:** Allows you to select the foreground color of the message (or messages) selected in the Msg#/Message/Destination box. Note that you can choose blinking or non-blinking colors.

**BG:** Allows you to select the background color of the message (or messages) selected in the Msg#/Message/Destination box. Note that you can choose blinking or non-blinking colors.

**Font:** Allows you to select a font for the message (or messages). The selections available are Normal, Double High, and Quad.

Note that you should test all message combinations that you expect to use before going online. Each line of text is totally independent, so be careful when making intensity or color and character size selections. Quad or double-high character lines can interfere with each other.

**Destination:** Allows you to select the destination of the message. The selections available are Screen, Printer, or Both. Note that Display Templates containing messages with the Destination field configured as Both or Printer will not print in Run Mode if a screen saver is active. This is not a characteristic of Variable-Sized Display Templates if the Global Message field is configured as Yes in the Variable-Sized Display Template - Expressions Tab dialog box.

**<Copy>:** Copies a selected message (or messages) to the Windows clipboard.

**<Paste>:** Places a message (or messages) from the clipboard to destinations you have selected in the Msg#/Message/Destination box. You can paste messages anywhere into the list, but the number of selected destinations must equal the number of messages on the clipboard.

**<Clear>:** Erases the selected message (or messages) from the Msg#/Message/Destination box, but does not place them on the clipboard.

**<Undo>:** Allows you to undo the previous editing or formatting change.

**<Redo>:** Allows you to redo the previous undo.
<Find>: Opens the Find dialog box. In the Find dialog box, enter the text string you wish to search for in the Find What field, choose the Match Whole Word Only or the Match Case selections if either or both selections apply, and select the direction of the search.

Once you have entered the text string, you may click the Find Next button to find the next occurrence of the text string or press the Cancel button to close the Find dialog box.

The Find and Replace functions start searching from the selected line in the Msg#/Message/Destination box.

<Replace>: Opens the Replace dialog box. In the Replace dialog box, enter the text string you wish to search for in the Find What field, enter the replacement text string in the Replace With field, and then choose the Match Whole Word or Match Case selections if either or both selections apply.

Once you have entered the text strings, you may click the Find Next button to find the next occurrence of the text string, click the Replace button to replace the text string, click the Replace All button to replace all occurrences of the text string, or press the Cancel button to close the Replace dialog box.
Register References within Messages

Within the PanelMate unit, you can reference PLC register locations within a message to display the numeric register content within the message while in Run Mode. You may use the following format to display the contents of the registers.

$tw.d(expression)

You can have up to five register references and clock or calendar references within a message.

The following items need to be noted when putting register references in messages:

- If a value is too large to display in the specified format width, a string of Xs (XXXXX) is displayed for the value. For example, if a message is defined as three characters, but the value from the PLC is four characters, the resultant will be displayed is XXX.

- When the Message Expression is true, embedded references are updated on the screen but not sent to the printer. Messages configured for BOTH or PRINTER are sent to the printer when the Message Expression changes, and also when you change pages.

- If a hard-coded value (e.g., 100) is placed in the Message Expression designated as Global, the message will only print once at bootup.

- A message containing multiple PLC references will print to the screen or printer multiple times—once for each reference in the message.

For more information on register reference formats, refer to the General Format, Decimal-Based Formats, Decimal Place Formats, Binary-Based Formats, or Formatting Examples topic.
**General Format**

A message containing multiple PLC references will print to the screen or printer multiple times—once for each reference in the message.

The general format expression is shown below.

\[ \$tw.d(expression) \]

where ...

- \$ = format indicator
- \( t \) = type of numeric display
  - I - Integer
  - H - Hexadecimal
  - B - Binary
  - E - Exponential
  - D - Floating decimal real value
  - O - Octal
  - F - Fixed decimal real value
  - A - ASCII character
- \( w \) = Total field width including decimal point, negative sign (-), and positive sign (+)
- \( . \) = Separator between width of format and the number of decimal places (used with F or E format)
- \( d \) = Number of decimal places (used with F or E format)

Format type D (floating decimal point) permits the decimal point to float in the display depending on the register’s value. This contrasts with format type F (fixed decimal point) which formats a value with a fixed decimal location. Format type F may be useful when creating a column of values.

Floating decimal point format type should not be confused with floating point mathematics or floating point data types that cannot be read or manipulated in the PanelMate unit.
Each format has a maximum number of characters it can display, and a number cannot be completely displayed if the format description is too small. The following are the width limits for each format type.

- **I11** = Largest Integer value width is 11
- **H8** = Largest Hexadecimal value width is 8
- **O11** = Largest Octal value width is 11
- **B32** = Largest Binary value width is 32
- **D65** = Largest Floating Decimal Point value width is 65
- **F65.d** = Largest Fixed Decimal Point value width is 65
- **E65.d** = Largest Exponential value width is 65
- **A** = Largest ASCII character width is 2. (The least significant 16 bits are used in this order: high byte, low byte). When using both characters, ensure the PanelMate unit’s default format can read numbers that use the high byte. An alternate word reference format may be necessary, i.e., #U16.

- **d** = decimal places

For examples using the General Format Expression, refer to the General Format Expression Examples topic.
Chapter 8: Message Library

General Format Examples

If the message is:

“Current tank level is $I3([123]) gallons.” and the value in register 123 is 567,
the online message will be:

“Current tank level is 567 gallons.”

If the message is:

“Production rate per press is $D5([456]/17) units per hr.” and the value in
register 456 is 7890, the online message will be:

“Production rate per press is 464.1 units per hr.”

If the message is:

“Part name in line 1 is $A([200#U16]).” and the value in register 200 is 16693,
the online message will be:

“Part name in line 1 is A5”

Note that with the #U16 format, the PanelMate unit can read and display the ASCII
equivalent of 16693.
**Decimal-Based Formats**
The decimal-based format types are:

1. Integer
2. Floating decimal point real value
3. Fixed decimal point real value
4. Exponential

All the decimal-based numeric formats are right-justified and padded with leading blanks if necessary.

If a value for a decimal format has too many digits for the specified format size, a string of *s (****) is displayed for the value.

**Decimal Place Formats**
For the fixed decimal point format (F), the number for the total width of the formatted value (w) must be at least one greater than the number of decimal places (d). If negative values will be displayed, “w” must be at least two greater than “d”.

For the exponential format (E), the total width of the formatted value (w) must be at least eight greater than the number of decimal places (d).

**Binary-Based Formats**
The binary-based format types are:

1. Hexadecimal
2. Octal
3. Binary

For binary-based formats, digits are inserted for the entire width of the format size; there is no blank padding. If a value for a binary format has too many digits for the specified format size, the most significant digits of the value are truncated until the number will fit in the size specified.

Example:

```
value = 300

Presentation with H4 format: 012C

Presentation with H2 format: 2C
```
## Formatting Examples

The following table shows examples of the different formatting types. The data type, actual data, and visual appearance are shown. The heading on the column for visual appearance marks 13 column locations to help reference the placement of characters.

<table>
<thead>
<tr>
<th>Type</th>
<th>Data</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>I5</td>
<td>324</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>I4</td>
<td>521</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>I2</td>
<td>-8.73</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>I3</td>
<td>7321</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>I4</td>
<td>824.67</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>D7</td>
<td>421.45</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>D4</td>
<td>23.45</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>H3</td>
<td>255</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>H5</td>
<td>-255</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>H2</td>
<td>300</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>O4</td>
<td>54</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>O3</td>
<td>88.45</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>O1</td>
<td>21</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>B9</td>
<td>100</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>B4</td>
<td>86</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>F5.1</td>
<td>523.46</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>F10.4</td>
<td>253.21</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>F5.2</td>
<td>326.23</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>F8.3</td>
<td>-43.888</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>F5.0</td>
<td>397.52</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>E12.3</td>
<td>-324.1</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>E13.2</td>
<td>0.06734</td>
<td>0 1 2 3 4 5 6 7 8 9 0 1 2</td>
</tr>
<tr>
<td>Type</td>
<td>Data</td>
<td>Columns</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>E9.0</td>
<td>156.2</td>
<td>2 E + 02</td>
</tr>
<tr>
<td>D4</td>
<td>999.89</td>
<td>1 0 0 0</td>
</tr>
<tr>
<td>D6</td>
<td>6245.21</td>
<td>6 2 4 5 . 2</td>
</tr>
<tr>
<td>D1</td>
<td>0.04</td>
<td>0</td>
</tr>
<tr>
<td>D1</td>
<td>9.12</td>
<td>9</td>
</tr>
<tr>
<td>D4</td>
<td>82345.2</td>
<td>* * * *</td>
</tr>
<tr>
<td>D3</td>
<td>-1.444</td>
<td>- 1</td>
</tr>
<tr>
<td>F7.3</td>
<td>619.52</td>
<td>6 1 9 . 5 2 0</td>
</tr>
<tr>
<td>F7.2</td>
<td>619.52</td>
<td>6 1 9 . 5 2</td>
</tr>
<tr>
<td>F6.2</td>
<td>619.52</td>
<td>6 1 9 . 5 2</td>
</tr>
<tr>
<td>F5.3</td>
<td>619.52</td>
<td>- - - -</td>
</tr>
<tr>
<td>F5.1</td>
<td>619.52</td>
<td>6 1 9 . 5</td>
</tr>
<tr>
<td>D7</td>
<td>619.52</td>
<td>6 1 9 . 5 2 0</td>
</tr>
<tr>
<td>D6</td>
<td>619.52</td>
<td>6 1 9 . 5 2</td>
</tr>
<tr>
<td>D5</td>
<td>619.52</td>
<td>6 1 9 . 5</td>
</tr>
<tr>
<td>D4</td>
<td>619.52</td>
<td>6 2 0</td>
</tr>
<tr>
<td>D3</td>
<td>619.52</td>
<td>6 2 0</td>
</tr>
<tr>
<td>E12.4</td>
<td>619.52</td>
<td>6 . 1 9 5 2 E + 0 2</td>
</tr>
<tr>
<td>E12.3</td>
<td>619.52</td>
<td>6 . 1 9 5 E + 0 2</td>
</tr>
<tr>
<td>A</td>
<td>16693</td>
<td>A5</td>
</tr>
</tbody>
</table>
Clock and Calendar References within Messages

Time and date information from the PanelMate unit’s internal clock can be included in messages sent to the screen and/or printer. The Clock and Calendar Access formats are as follows:

- $(mon)$ month
- $(day)$ day
- $(year)$ year
- $(hour)$ hour (24 hour time format)
- $(min)$ minutes
- $(sec)$ seconds
- $(time)$ hour:minute:second
- $(date)$ month/day/year
- $(clk)$ hour:minute:second month/day/year

Note the following items:

- A single message may contain up to five register references and clock or calendar references.
- Parameter names are not case sensitive.
- This information is updated when the page is displayed, but is not updated dynamically.
In this chapter, you will learn:

- About the System Online Labels
System Online Labels

When System Online Labels is selected from the Database Treeview Window, the **System Online Labels** dialog box will appear.

The **System Online Labels** dialog box is used to change the labeling for most of the PanelMate unit screens.

The fields in the **System Online Labels** dialog box are described below.

**Online Options**

**Startup Labels:** Allows you to select the Standard or User labels to display at startup. If you select Standard, the PanelMate unit will display the default label set. If you select User, the PanelMate unit will display the labels you create in the **System Online Labels** dialog box.

**Allow Label Set Switching:** Allows you to switch between the two label sets during online operation if this field is checked. If this field is not checked, only the labels selected in the Startup Labels field will be displayed.

**Preview:** Previews the online label you are working on.
**Label Category To Edit:** Allows you to select the label category you wish to edit. When you select a label category, the user-defined labels will appear in the User Online Label field and the standard labels will appear in the Standard Online Label field.

The following list shows the label categories that may be edited:

- Miscellaneous Soft Key Prompts
- Maintenance Template Soft Key Prompts
- User Entry Soft Key Prompts
- Setup Page
- Error Messages
- Miscellaneous Text
- Display System/Configuration Info
- Alarm Text
- Contrast Adjustment Soft Key Prompts
- Touchscreen Button Templates
- Touchscreen Keypad Entry Labels
- Touchscreen Control Keys

**User Online Label:** Displays user-defined labels for the label category selected in the Label Category to Edit field. If you select a label in this list, the label will display in the Label field where it can be edited.

**Standard Online Label:** Displays default standard labels for the label category selected in the Label Category to Edit field. Most labels that appear in the Standard Online Labels scroll box cannot be edited.

For safety purposes when creating online labels in another language, the Change Online Labels label in the Miscellaneous Soft Key Prompts category will remain in English when User Online Labels are displayed. The user-defined label for Change Online Labels will only be shown when the Standard Online Labels are displayed.

**Label:** Allows you to edit the label selected in the User Online Label scroll box. Any labels the are edited in the Label field will be reflected in the Preview box and in the User Online Label scroll box.

**Font:** Allows you to select a font for the label you are editing. The choices are Normal, Graphic, Double High, and Quad font.

In order to select the Double High or Quad font, the Redefine Double High Font field or the Redefine Quad Font field must be selected in the **System Parameters - General Tab** dialog box. Once one or both fields are selected, the characters must be redefined in the Font Editor before the characters will appear in the Preview field in the **System Online Labels** dialog box.
System Online Labels – Miscellaneous Soft Key Prompts

When Miscellaneous Soft Key Prompts is selected in the Label Category to Edit field, the following dialog box will appear.

![System Online Labels Dialog Box](image)

<table>
<thead>
<tr>
<th>Change Online Labels</th>
<th>Change Online Labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>View or Acknowledge Alarms</td>
<td>View or Acknowledge Alarms</td>
</tr>
<tr>
<td>Get Page</td>
<td>Get Page</td>
</tr>
<tr>
<td>Directory</td>
<td>Directory</td>
</tr>
<tr>
<td>Scroll Up</td>
<td>Scroll Up</td>
</tr>
<tr>
<td>Scroll Down</td>
<td>Scroll Down</td>
</tr>
<tr>
<td>Acknowledge Selected Alarm</td>
<td>Acknowledge Selected Alarm</td>
</tr>
<tr>
<td>Acknowledge All Alarms</td>
<td>Acknowledge All Alarms</td>
</tr>
</tbody>
</table>

Label Options:
- Change
- Online
- Labels

Font Options:
- Normal
- Graphic
- Double High
- Quad
The following set of online labels can be edited in the **System Online Labels** dialog box when Miscellaneous Soft Key Prompts is selected in the Label Category to Edit field.

**Standard Online Labels**
- Change Online Labels
- View or Acknowledge Alarms
- Get Page
- Directory
- Scroll Up
- Scroll Down
- Acknowledge Selected Alarm
- Acknowledge All Alarms
- Get Alarm Page
- Host Display Window
- Silence Alarm Horn
- Enable Fault Relay (PanelMate Power Series 2000, PanelMate Power Series 3000, PanelMate Power Series 4000, PanelMate Power Series 5000, and PanelMate PC)
- Reset PLC Com (PanelMate Power Series 1500)
- Change Value
- Clear
- Home
- Select Table Entry
- Return and Select
- More Buttons
- Setup Page
- Execute
- Set Date
- Set Time
- Yes
- No

**Tip**

*When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.*
System Online Labels – Maintenance Template Soft Key Prompts

When Maintenance Template Soft Key Prompts is selected in the Label Category to Edit field, the following dialog box will appear.

The following set of online labels can be edited in the System Online Labels dialog box when Maintenance Template Soft Key Prompts is selected in the Label Category to Edit field.

**Standard Online Labels**
- Maintenance Template
- Activate
- Deactivate

Tip
When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.
System Online Labels – User Entry Soft Key Prompts

When User Entry Soft Key Prompts is selected in the Label Category to Edit field, the following dialog box will appear.
The following set of online labels can be edited in the **System Online Labels** dialog box when User Entry Soft Key Prompts is selected in the Label Category to Edit field.

**Standard Online Labels**
- Enter Password A:
- Enter Password B:
- Enter Passw. A/B:
- Enter Old Password A:
- Enter Old Password B:
- Enter New Password A:
- Enter New Password B:
- Reenter New Password:
- Enter Date (MM-DD-YY):
- Enter Time (HH-MM-SS):
- Enter New Value:

**Tip**
When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.
System Online Labels – Setup Page

When Setup Page is selected in the Label Category to Edit field, the following dialog box will appear.
The following set of online labels can be edited in the **System Online Labels** dialog box when Setup Page is selected in the Label Category to Edit field.

**Standard Online Labels**
- Change Password A
- Change Password B
- Log-in Password A
- Log-in Password B
- Log-out Password A
- Log-out Password B
- Set Date and Time
- Enter Offline Mode
- Display System/Config. Information
- Switch to Two Column Keypad
- Switch to Three Column Keypad

**Tip**

When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.
System Online Labels – Error Messages
When Error Messages is selected in the Label Category to Edit field, the following dialog box will appear.

The following set of online labels can be edited in the System Online Labels dialog box when Error Messages is selected in the Label Category to Edit field.

Standard Online Labels
- Invalid Entry. Press Any Key to Continue.
- Invalid Entry. Reenter the Password.
- Invalid Entry. Improper Confirmation. Reenter the Password.

Tip
When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.
System Online Labels – Miscellaneous Text

When Miscellaneous Text is selected in the Label Category to Edit field, the following dialog box will appear.
The following set of online labels can be edited in the System Online Labels dialog box when Miscellaneous Text is selected in the Label Category to Edit field.

**Standard Online Labels**
- Directory of Page Titles
- Press Directory for Additional Pages
- ALARM PAGE
- HOST DISPLAY WINDOW
- SETUP PAGE
- PAGE
- <NO CONTROL>
- Current Date:
- Press Page Number Below
- Remote Mode Change Requested OK to Proceed?

**Tip**

*When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.*
System Online Labels – Display System/Configuration Info.

When Display System/Configuration Info. is selected in the Label Category to Edit field, the following dialog box will appear.

<table>
<thead>
<tr>
<th>User Online Label</th>
<th>Standard Online Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>USER CONFIGURATION</td>
<td>USER CONFIGURATION</td>
</tr>
<tr>
<td>EXECUTIVE Firmware</td>
<td>EXECUTIVE Firmware</td>
</tr>
<tr>
<td>INSTALLED DRIVERS</td>
<td>INSTALLED DRIVERS</td>
</tr>
<tr>
<td>Name</td>
<td>Name</td>
</tr>
<tr>
<td>Version</td>
<td>Version</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Free Bytes</td>
<td>Free Bytes</td>
</tr>
<tr>
<td>Used Bytes</td>
<td>Used Bytes</td>
</tr>
</tbody>
</table>

Label:

USER CONFIGURATION

Font:

- Normal
- Graphic
- Double High
- Quad
The following set of online labels can be edited in the **System Online Labels** dialog box when Display System/Configuration Info. is selected in the Label Category to Edit field.

**Standard Online Labels**
- USER CONFIGURATION
- EXECUTIVE FIRMWARE
- INSTALLED DRIVERS
- Name:
- Version:
- Date/Time:
- Free Bytes:
- Used Bytes:
- Options:
- Company/ID:
- Model:
- Product:
- Network:

---

**Tip**

*When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.*
System Online Labels – Alarm Text
When Alarm Text is selected in the Label Category to Edit field, the following dialog box will appear.

The following set of online labels can be edited in the System Online Labels dialog box when Alarm Text is selected in the Label Category to Edit field.

Standard Online Labels
- Clrd
- Ackd
- LOW ALARM
- HIGH ALARM

Tip
When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.
System Online Labels – Contrast Adjustment Soft Key Prompts

When Contrast Adjustment Soft Key Prompts is selected in the Label Category to Edit field, the following dialog box will appear.

The following set of online labels can be edited in the System Online Labels dialog box when Contrast Adjustment Soft Key Prompts is selected in the Label Category to Edit field.

**Standard Online Labels**

- Adjust Contrast
- Invert
- Lighter
- Darker
- Save Setting

**Tip**

When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.
System Online Labels – Touchscreen Button Templates

When Touchscreen Button Templates is selected in the Label Category to Edit field, the following dialog box will appear.

![System Online Labels dialog box](image)

**Tip**

*When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.*

The following set of online labels can be edited in the **System Online Labels** dialog box when Touchscreen Button Templates is selected in the Label Category to Edit field.

**Standard Online Labels**

- Cleaning Mode
- Calibrate Touchscreen
System Online Labels – Touchscreen Keypad Entry Labels

When Touchscreen Keypad Entry Labels is selected in the Label Category to Edit field, the following dialog box will appear.

**Tip**
When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.

The following set of online labels can be edited in the **System Online Labels** dialog box when Maintenance Template Soft Key Prompts is selected in the Label Category to Edit field.

**Standard Online Labels**
- Enter New Reference:
- Enter New PLC Name:
System Online Labels – Touchscreen Control Keys

When Touchscreen Control Keys is selected in the Label Category to Edit field, the following dialog box will appear.
**Tip**

When changing online labels, be aware of the spaces before and after the new label. The spaces will determine the placement of the label when the PanelMate unit enters Run Mode.

The following set of online labels can be edited in the System Online Labels dialog box when Touchscreen Control Keys is selected in the Label Category to Edit field.

**Standard Online Labels**

- DEL
- >>
- <<
- SPACE
- SEL
- CLEAR
- MORE
- DIR
- ENTER
- RSEL
- ALARM
- ACCEPT
- PREV
- NEXT
- RETRN
In this chapter, you will learn:

- About the Indicator Template
- About the Readout Template
- About the Bar Template
- About the Table Template
- About the Bar Trend Template
- About the Line Trend Template
- About the Display Template
Indicator Template

Indicator Templates are designed to be used as the lights and buttons of a control panel and are used to indicate the status of devices and to control them, e.g., by turning them on or off.

The Indicator Template consists of three tabbed dialog boxes that are listed below.

- Indicator Template - Indicator Attributes Tab
- Indicator Template - Indicator States Tab
- Indicator Template - Control Definitions Tab
Indicator Template – Indicator Attributes Tab

The **Indicator Template - Indicator Attributes Tab** dialog box is shown below.

![Indicator Template - Indicator Attributes Tab](image)

The fields in the **Indicator Template - Indicator Attributes Tab** dialog box are described below.

**Device Name:** Allows you to enter a device name. The device name will display in the upper area of the template in the normal font. You may press the **Return** key to insert a carriage return.

The Device Name field has an auto centering capability. If you wish to center the Device Name, check the Device Names box in the Auto Centering field in the **Configuration Properties** dialog box.

Note that the name used in the Device Name field may be part of an alarm message. Be aware that only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. The Device Name field allows you to enter more than 22 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the **Font Editor** topic.
Template Size In Cells

**Height:** Displays the height of the Indicator Template as 1. This value cannot be changed.

**Width:** Allows you to enter the width of the Indicator Template as 1 or 2.

**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of the template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.

**Indicator Label Font:** Defines the font used in the status (lower) area of the template. You can select Normal, Double-High, or Quad font. For maximum readability, choose the largest size that fits in the template.

**Enable Conditional Visibility:** Allows you to determine if the template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

**Visibility Expression:** Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Indicator Template – Indicator States Tab

The Indicator Template - Indicator States Tab dialog box is shown below.

The fields in the Indicator Template - Indicator States Tab dialog box are described below.

**Indicator Label/Conditional Expression/Alm/Ack:** Displays five lines that define various states of the device. This includes indicator label text, conditional expressions, alarm status, and acknowledgment status.
**Conditional Expression:** Allows you to enter a conditional expression. The conditional expression can be a numerical, logical or relational expression that evaluates to true or false. When a numerical expression is evaluated if the result is even (least significant bit = 0), the value is false, and if the result is odd (least significant bit = 1), the value is true.

In Run Mode, if an expression is satisfied (true or false), the characteristics defined for that line are used to display the template. If more than one expression is satisfied at the same time, the line with the highest priority displays. Line 1 has the highest priority and line 5 has the lowest.

When an expression results in an invalid equation (e.g., division by zero, etc.), no value or graphics are displayed.

If a true expression goes false in a later scan, the display for the true expression is erased.

Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

Refer to the list of Conditional Expression Operators for more information.

**Indicator Label:** Allows you to enter a label for the Indicator Template. This field accepts normal-sized characters entered in the Indicator Label box. The Indicator Template will limit the number of characters you can enter depending upon the template size (normal or double-wide) or character size (normal, double high, or quad).

Be sure to view the template on the page to ensure the desired appearance.

The Indicator Label field has an auto centering capability. If you wish to center the Indicator Label, check the Indicator Labels box in the Auto Centering field in the Configuration Properties dialog box.

**FG:** Allows you to select the foreground color or intensity for the control label. The **FG** button will display the standard Color Selection Palette.

**BG:** Allows you to select the background color or intensity for the control label. The **BG** button will display the standard Color Selection Palette.
Alarm

**Alarm:** Allows you to designate any line of the template definition as an alarm state. If the Alarm box is selected and the conditional expression evaluates to be true, an alarm message will be placed in the alarm list and sent to the printer if one is configured.

If the Alarm box is selected, the condition associated with the alarm will be monitored at all times, regardless of the page being displayed. Judicious use of the alarm state is recommended to maximize the response time of the PanelMate unit.

**Acknowledge:** Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.
Indicator Template – Control Definitions Tab

The Indicator Template - Control Definitions Tab dialog box is shown below.

The fields in the Indicator Template - Control Definitions Tab dialog box are described below.

Control Label/PLC Bit Reference: Displays the control labels and PLC bit references and allows you to define the control buttons on the right side of the PanelMate unit. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at a particular location.

If a control button is defined, a small arrow will be displayed in the lower left corner of a template to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., 120 00) to 1. When the button is released, a separate command is sent to set the bit to a 0 (zero), thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.
**Control Label:** Allows you to enter a label for a control button. This field accepts three lines of normal-sized alphanumeric characters. The text does not automatically wrap. Press the **Return** key to insert a carriage return.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the **Configuration Properties** dialog box.

**FG:** Allows you to select the foreground color or intensity for the control label. The **FG** button will display the standard Color Selection Palette.

**BG:** Allows you to select the background color or intensity for the control label. The **BG** button will display the standard Color Selection Palette.

**PLC Bit Reference:** Allows you to enter a PLC bit reference for the control button. This field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. You cannot use expressions or conditional logic.
Readout Template

Readout Templates are designed to be used as numerical readout devices on a control panel and are used to display a digital value. The PanelMate unit also provides two ways for the operator to change a PLC value.

The Readout Template consists of three tabbed dialog boxes that are listed below.

- Readout Template - Readout Attributes Tab
- Readout Template - Expressions Tab
- Readout Template - Control Definitions Tab
Readout Template – Readout Attributes Tab

The **Readout Template - Readout Attributes Tab** dialog box is shown below.

![Readout Template - Readout Attributes Tab dialog box](image)

The fields in the **Readout Template - Readout Attributes Tab** dialog box are described below.

**Device Name:** Allows you to enter a device name. The device name will display in the upper area of the template in the normal font. You may press the **Return** key to insert a carriage return.

The Device Name field has an auto centering capability. If you wish to center the Device Name, check the Device Names box in the Auto Centering field in the **Configuration Properties** dialog box.

Note that the name used in the Device Name field may be part of an alarm message. Be aware that only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. The Device Name field allows you to enter more than 22 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the **Font Editor** topic.

**Template Size In Cells**

- **Height:** Displays the height of the Readout Template as 1. This value cannot be changed.

- **Width:** Allows you to enter the width of the Readout Template as 1 or 2.
Value 1 Font: Allows you to select the font for the characters used in the status (lower) area of the Readout Template. The selections are Normal, Double-High, or Quad. For maximum readability, choose the largest size that fits in the template. Note that redefining the Double-High or Quad fonts limits your character size choices.

The maximum number of digits for a Readout Template is based upon the combination of template size and character size.

- A 1-wide template with normal characters can display 9 digits.
- A 1-wide template with quad characters can display 6 digits.
- A 1-wide template with double high characters can display 9 digits.
- A 2-wide template with normal characters can display 18 digits.
- A 2-wide template with quad characters can display 12 digits.
- A 2-wide template with double high characters can display 18 digits.

Units: Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” or “gals”. The Units field accepts alphanumeric characters. This field is not displayed on a single-width template when Value 2 is displayed.

Decimal Places: Allows you to determine how the number will be formatted when displayed. This field accepts the numbers 0 through 9.

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and graphics that lie within the area of the template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.

Enable Conditional Visibility: Allows you to determine if the Readout Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Readout Template – Expressions Tab

The Readout Template - Expressions Tab dialog box is shown below.

The fields in the Readout Template - Expressions Tab dialog box are described below.

Value 1: Allows you to enter a value expression. The result of this expression will be the value displayed in the Readout Template.

When viewing the Readout Template, Value 1 will be in the center of the template.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.
The following examples of expressions use a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

[123]

The expression can be a single word reference. This example references word 123.

([123]*10)+[124]

This mathematical expression includes PLC references and constants that solve to a value.

[name1,242]+[name2,243]

Information from multiple PLCs can be included in the same expression. In this expression, word 242 in PLC name1 is added to word 243 in PLC name2.

Refer to the list of Conditional Expression Operators for more information.

**Value 2:** Allows you to enter a value expression. The result of this expression will be the value displayed in the Readout Template.

When viewing the Readout Template, Value 2 will be at the bottom of the template. It is most often used as the setpoint for the device.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

Refer to the list of Conditional Expression Operators for more information.
**High Alarm:** Allows you to enter a High Alarm Expression. The results of the High Alarm Expression are compared to the results of the Value 1 Expression. If Value 1 exceeds the High Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the template will be displayed as follows:

- For PanelMate Grayscale units, the template will be displayed with medium intensity characters on a blinking high intensity background.
- For PanelMate Color units, the template will be displayed with white characters on a blinking red background.

The High Alarm Expression can include multiple PLC word and bit references. Mathematical and Boolean expressions may be used including multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.

**Low Alarm:** Allows you to enter a Low Alarm Expression. The results of the Low Alarm Expression are compared to the results of the Value 1 Expression. If Value 1 is less than the Low Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the template will be displayed as follows:

- For PanelMate Grayscale units, the template will be displayed with medium intensity characters on a blinking high intensity background.
- For PanelMate Color units, the template will be displayed with white characters on a blinking red background.

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical and Boolean expressions may be used including multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.
**Deadband Range:** Allows you to enter a number between 0-99 that will represent the percentage of the high alarm value minus the low alarm value that defines the width of the deadband.

The deadband range is an area below the high alarm value and above the low alarm value, that must be crossed before Value is considered to have returned to normal status (go out of alarm). The deadband range prevents multiple alarm messages from being generated when Value is hovering around an alarm threshold.

**Alarm Acknowledge:** Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.
Readout Template – Control Definitions Tab

The Readout Template - Control Definitions Tab dialog box is shown below.

The fields in the Readout Template - Control Definitions Tab dialog box are described below.

Control Type: Allows you to define the control type used for the template. The selections are described below.

- **None**: Allows the template to show a value that the operator cannot control.
- **Buttons**: Requires the operator to use control buttons to change a setpoint value. If you choose Buttons, the dialog box will change. Refer to the Readout Template - Control Definitions Tab with Button Control topic for more information.
- **Numeric**: Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box will change. Refer to the Readout Template - Control Definitions Tab with Numeric Control topic for more information.

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.
**Readout Template – Control Definitions Tab with Button Control**

The **Readout Template - Control Definitions Tab** dialog box with button control is shown below.

The **Readout Template - Control Definitions Tab** dialog box with button control defines the control buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.

The fields in the **Readout Template - Control Definitions Tab** dialog box with button control are described below.

**Control Label/PLC Bit Reference**: Displays the control button labels and the associated PLC Bit Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at that location.
Control Label: Allows you to enter the control button label. The Control Label field accepts three lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the desired location. Note that on the configuration page, the text displayed in the control button will be truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to the next line, you can eliminate a carriage return in some cases.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the Configuration Properties dialog box.

FG: Allows you to select the foreground color or intensity for the control label. The FG button will display the standard Color Selection Palette.

BG: Allows you to select the background color or intensity for the control label. The BG button will display the standard Color Selection Palette.

PLC Bit Reference: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. Expressions or conditional logic cannot be entered.
Readout Template – Control Definitions Tab with Numeric Control

The Readout Template - Control Definitions Tab dialog box with numeric control is shown below.

```
Readout Template

Readout Attributes    Expressions    Control Definitions

Input Value Expression:

Target Word Address:

Password Protection: None

Control Type: Numeric

OK    Cancel    Help
```

The fields in the Readout Template - Control Definitions Tab dialog box with numeric control are described below.

**Input Value Expression:** Allows you to enter any mathematical expression that must be performed on the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is used to designate the operator input. The expression entered here may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples below.

- `([?] - 32) * 5 / 9`
  The operator’s input is changed from Fahrenheit to Celsius.

- `[?] * (if (? >= 0) * (? <= 100) + (? < 0) * [123] + (? > 100) * [123])`
  **Target Word Address is [123]**
  This expression limits entries between 0 and 100 to the PLC register. Any value outside this range has no effect on the value in the register.

Refer to the list of Conditional Expression Operators for more information.
**Target Word Address:** Allows you to define the location of the operator’s input in the PLC as the result of the Input.

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address [364#S16].

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

**Password Protection:** Allows you to lock out access to numeric entry unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

Password protection must be validated each time the template is selected for numeric entry.

The template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.
Bar Template

Bar Templates are designed to be used as the analog meters and faceplates on a control panel and are used to indicate a value in analog fashion, with a bar graph. The bar graph can show current value, setpoint, and high and low alarm levels. The current value and setpoint are also displayed digitally. The PanelMate unit also provides two ways for the operator to change a PLC value.

The Bar Template consists of three tabbed dialog boxes that are displayed below.

- Bar Template - Bar Attributes Tab
- Bar Template - Expressions Tab
- Bar Template - Control Definitions Tab
Bar Template – Bar Attributes Tab

The Bar Template - Bar Attributes Tab dialog box is shown below.

The fields in the Bar Template - Bar Attributes Tab dialog box are described below.

**Device Name:** Allows you to enter a device name. The device name will display in the upper area of the template in the normal font. You may press the Return key to insert a carriage return.

The Device Name field has an auto centering capability. If you wish to center the Device Name, check the Device Names box in the Auto Centering field in the Configuration Properties dialog box.

Note that the name used in the Device Name field may be part of an alarm message. Be aware that only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. The Device Name field allows you to enter more than 22 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the Font Editor topic.

**Template Size In Cells**

- **Height:** Allows you to enter the height of the Bar Template as 2 or 3.
- **Width:** Displays the width of the Bar Template as 1. This value cannot be changed.
**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of the template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.

**Units:** Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” or “gals”. The Units field accepts alphanumeric characters.

**Enable Conditional Visibility:** Allows you to determine if the Bar Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

**Visibility Expression:** Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Bar Template – Expression Tab

The Bar Template - Expressions Tab dialog box is shown below.

The fields in the Bar Template - Expressions Tab dialog box are described below.

**Value 1:** Allows you to enter a value expression. The result of this expression will be the value displayed in the Bar Template.

When viewing the Bar Template, Value 1 will be displayed as follows:

- For PanelMate Grayscale units, Value 1 is displayed as a high intensity bar on the template.
- For PanelMate Color units, Value 1 is displayed as a green bar on the template.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.
The following examples of expressions use a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

\[123\]
The expression can be a single word reference. This example references word 123.

\[(123\times10)+[124]\]
This mathematical expression includes PLC references and constants that solve to a value.

\[\text{name1,242}+\text{name2,243}\]
Information from multiple PLCs can be included in the same expression. In this expression, word 242 in PLC name1 is added to word 243 in PLC name2.

Refer to the list of Conditional Expression Operators for more information.

**Value 2:** Allows you to enter a value expression. The result of this expression will be the value displayed in the Bar Template.

When viewing the Bar Template, Value 2 will be displayed as follows:

- For PanelMate Grayscale units, Value 2 is displayed as a medium intensity horizontal line to the right of the Value 1 bar.
- For PanelMate Color units, Value 2 is displayed as a white horizontal line to the right of the Value 1 bar. It is most often used as the setpoint for the device.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

Refer to the list of Conditional Expression Operators for more information.
**High Alarm:** Allows you to enter a High Alarm Expression. The results of the High Alarm Expression are compared to the results of the Value 1 Expression. If Value 1 exceeds the High Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the bar will be displayed as follows:

- For PanelMate Grayscale units, ALARM! will appear on the template (below the Device Name) in medium foreground intensity on blinking high intensity background. A High Alarm bar is shown in high intensity to the right of the Value 1 bar.
- For PanelMate Color units, ALARM! will appear on the template (below the Device Name) in white on blinking red. A High Alarm bar is shown in red to the right of the Value 1 bar.

The High Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.

**Low Alarm:** Allows you to enter a Low Alarm Expression. The results of the Low Alarm Expression are compared to the results of the Value 1 Expression. If Value 1 is less than the Low Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the bar will be displayed as follows:

- For PanelMate Grayscale units, ALARM! will appear on the template (below the Device Name) in medium foreground intensity on blinking high intensity background. A Low Alarm bar is shown in high intensity to the right of the Value 1 bar.
- For PanelMate Color units, ALARM! will appear on the template (below the Device Name) in white on blinking red. A Low Alarm bar is shown in red to the right of the Value 1 bar.

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.
**Max Calibration:** Allows you to determine the highest point of the Value 1 bar. This value displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed anywhere in the field.

On a 3-high Bar Template, the PanelMate unit will use the Maximum and Minimum Calibrations to calculate the bar’s midpoint and will place that value on the template.

**Min Calibration:** Allows you to determine the lowest point of the Value 1 bar trend. This value displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed anywhere in the field.

On a 3-high Bar Template, the PanelMate unit will use the Maximum and Minimum Calibrations to calculate the bar’s midpoint and will place that value on the template.

**Deadband Range:** Allows you to enter a number between 0-99 that will represent the percentage of the high alarm value minus the low alarm value that defines the width of the deadband.

The deadband range is an area below the high alarm value and above the low alarm value, that must be crossed before Value is considered to have returned to normal status (go out of alarm). The deadband range prevents multiple alarm messages from being generated when Value is hovering around an alarm threshold.

**Alarm Acknowledge:** Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.
Bar Template – Control Definitions Tab

The Bar Template - Control Definitions Tab dialog box is shown below.

The fields in the Bar Template - Control Definitions Tab dialog box are described below.

**Control Type:** Allows you to define the control type used for the template. The selections are described below.

- **None:** Allows the template to show a value that the operator cannot control.
- **Buttons:** Requires the operator to use control buttons to change a setpoint value. If you choose Buttons, the dialog box will change. Refer to the Bar Template - Control Definitions Tab with Button Control topic for more information.
- **Numeric:** Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box will change. Refer to the Bar Template - Control Definitions Tab with Numeric Control topic for more information.

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.
**Bar Template – Control Definitions Tab with Button Control**

The **Bar Template - Control Definitions Tab** dialog box with button control is shown below.

The **Bar Template - Control Definitions Tab** dialog box with button control defines the control buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.

The fields in the **Bar Template - Control Definitions Tab** dialog box with button control are described below.

**Control Label/PLC Bit Reference**: Displays the control button labels and the associated PLC Bit Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at that location.
**Control Label:** Allows you to enter the control button label. The Control Label field accepts three lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the desired location. Note that on the configuration page, the text displayed in the control button will be truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to the next line, you can eliminate a carriage return in some cases.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the **Configuration Properties** dialog box.

**FG:** Allows you to select the foreground color or intensity for the control label. The **FG** button will display the standard Color Selection Palette.

**BG:** Allows you to select the background color or intensity for the control label. The **BG** button will display the standard Color Selection Palette.

**PLC Bit Reference:** Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. Expressions or conditional logic cannot be entered.
Bar Template – Control Definitions Tab with Numeric Control

The Bar Template - Control Definitions Tab dialog box with numeric control is shown below.

The fields in the Bar Template - Control Definitions Tab dialog box with numeric control are described below.

**Input Value Expression**: Allows you to enter any mathematical expression that must be performed on the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is used to designate the operator input. The expression entered here may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples below.


\[(\text{[?] } - 32) \times \frac{5}{9}\]

The operator’s input is changed from Fahrenheit to Celsius.

\[? \times (\text{[?] } \geq 0) \times (\text{[?] } \leq 100) + (\text{[?] } < 0) \times 123 + (\text{[?] } > 100) \times 123\]

Target Word Address is [123]

This expression limits entries between 0 and 100 to the PLC register. Any value outside this range has no effect on the value in the register.

Refer to the list of Conditional Expression Operators for more information.
**Target Word Address:** Allows you to define the location of the operator’s input in the PLC as the result of the Input.

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address [364#S16].

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

**Password Protection:** Allows you to lock out access to numeric entry unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

Password protection must be validated each time the template is selected for numeric entry.

The template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.
Table Template

Table Templates are designed to display a table of values and accept numeric entry for all the items in the table. Table Templates can be used for machine setup, recipe entry, or for any application requiring a high-density display and entry of information.

Table Templates can support up to 50 independent entries. Each entry has a tag name, current value, edit value, and a units field. The Table Template has built-in scroll capabilities to allow you to select the desired entry field. A scroll indicator at left side of the template indicates top and bottom with stop bars. The presence of more items is identified by up or down arrows. The control buttons on the right of the screen permit up/down scrolling, return to home or open a selected field for numeric entry.

The control indicator at the bottom left of the template indicates control is available for a particular entry. You can configure each entry for numeric entry or for display only.

The Table Template consists of two tabbed dialog boxes that are listed below.

- Table Template - Table Attributes Tab
- Table Template - Table Entries Tab
Table Template – Table Attributes Tab

The Table Template - Table Attributes Tab dialog box is shown below.

The fields in the Table Template - Table Attributes Tab dialog box are described below.

**Device Name:** Allows you to enter a device name. The device name will display in the upper area of the template in the normal font. You may press the **Return** key to insert a carriage return.

The Device Name field has an auto centering capability. If you wish to center the Device Name, check the Device Names box in the Auto Centering field in the Configuration Properties dialog box.

Note that the name used in the Device Name field may be part of an alarm message. Be aware that only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. The Device Name field allows you to enter more than 22 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the Font Editor topic.
Template Size In Cells

**Height**: Allows you to enter the height of the Table Template as 1, 2, or 3. The height of the Table Template determines the number of table entries that can be displayed at one time.

- A 1-high template can display 2 table entries.
- A 2-high template can display 9 table entries.
- A 3-high template can display 16 table entries.

**Width**: Allows you to enter the width of the Table Template as 2 or 3.

**Parameters Tag**: Allows you to enter a title for the Parameters column in the Table Template. The Parameters Tag field accepts 12 normal-sized characters in a 2-wide template and accepts 18 normal-sized characters in a 3-wide template.

**Edit Value Tag**: Allows you to enter a title for the Edit Values column in the Table Template. The Edit Value field is enabled only when a 3-Wide template is being configured. The field accepts up to 6 normal-sized characters. These values are the operator’s input. The Edit Value Tag field values remain until the Table Template is re-selected or when the page is first displayed. Refer to the Input Value Expression field in the Table Template - Table Entries Tab topic for more information.

**Current Value Tag**: Allows you to enter a title for the Current Values column in the Table Template. The Current Value Tag field accepts up to 7 normal-sized characters. Refer to the Value Expression field in the Table Template - Table Entries Tab topic for more information.

**Units Tag**: Allows you to enter a title for the Units column in the Table Template. The Units Tag field accepts up to 5 normal-sized characters.
**Password Protection:** Allows you to lock out access to numeric entry unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

Password protection must be validated each time the template is selected for numeric entry.

The template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.

**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of the template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.
Enable Conditional Visibility: Allows you to determine if the Table Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Table Template – Table Entries Tab

The Table Template - Table Entries Tab dialog box is shown below.

The fields in the Table Template - Table Entries Tab dialog box are described below.

**Parameters/Value Expression/Input Value Expression/Target Word Address:** Displays parameters, value expression, input value expressions, and target word address configured for the Table Template. You can configure up to 50 independent display/entry fields.

Line 1 of the table corresponds to the first item, line 2 corresponds to the second line, etc. It is not necessary to use all 50 lines. When the PanelMate unit goes online, the scroll will stop at the last completed entry. You may leave blank lines in the table and use lines for display purposes only.

**Parameters:** Allows you to enter the descriptor for each individual table entry.

The Parameter field information is saved to disk only if there is a number in the Value Expression Column. To save parameter text for test purposes, enter a Value Expression of 1.
Decimal Places: Allows you to determine how the number will be formatted when displayed in the Current Value field and the Edit Value field. This field accepts the numbers 0 through 5.

Value Expression: Allows you to enter a value expression. The result of this expression will be the value displayed in the Table Template. This expression is any mathematical operation to be performed on the monitored value before it is displayed on the screen.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

The following examples of expressions use a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

[123]
The expression can be a single word reference. This example references word 123.

([123]*10)+[124]
This mathematical expression includes PLC references and constants that solve to a value.

[name1,242]+[name2,243]
Information from multiple PLCs can be included in the same expression. In this expression, word 242 in PLC name1 is added to word 243 in PLC name2.

Refer to the list of Conditional Expression Operators for more information.
**Input Value Expression:** Allows you to enter any mathematical expression that must be performed on the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is used to designate the operator input. The expression entered here may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples below.

\[(?)-32)*5/9\]

The operator’s input is changed from Fahrenheit to Celsius.

\[?(?>0)*(?>(?\leq100))+(?<0)*[123]+(?<100)*[123]\]

**Target Word Address is [123]**

This expression limits entries between 0 and 100 to the PLC register. Any value outside this range has no effect on the value in the register.

Refer to the list of Conditional Expression Operators for more information.

If an expression is defined for an individual entry, a small arrow will be displayed in the lower left corner of the template to indicate that numeric entry is available while the template is selected.

**Target Word Address:** Allows you to define the location of the operator’s input in the PLC as the result of the Input.

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address [364#S16].

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

**Units:** Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” or “gals”. The Units field accepts alphanumeric characters.
Bar Trend Template

Bar Trend Templates are designed to collect, store, and represent data in a manner that provides a historical perspective on how a single data point has changed and that provides some insight on how the data point may behave in the future.

The Bar Trend Template shows current value, setpoint, and high and low alarm levels. The current value and setpoint display digitally.

The Bar Trend Template consists of three tabbed dialog boxes that are listed below.

- Bar Trend Templates - Bar Trend Attributes Tab
- Bar Trend Templates - Expressions Tab
- Bar Trend Templates - Control Definitions Tab
Bar Trend Template – Bar Trend Attributes Tab

The Bar Trend Template - Bar Trend Attributes Tab dialog box is shown below.

The fields in the Bar Trend Template - Bar Trend Attributes Tab dialog box are described below.

Device Name: Allows you to enter a device name. The device name will display in the upper area of the template in the normal font. You may press the Return key to insert a carriage return.

The Device Name field has an auto centering capability. If you wish to center the Device Name, check the Device Names box in the Auto Centering field in the Configuration Properties dialog box.

Note that the name used in the Device Name field may be part of an alarm message. Be aware that only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. The Device Name field allows you to enter more than 22 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the Font Editor topic.
Template Size In Cells

**Height:** Allows you to enter the height of the Bar Trend Template as 1, 2, or 3.

**Width:** Allows you to enter the width of the Bar Trend Template as 2 or 3. The width of the Bar Trend Template determines the number of trend samples that can be displayed at one time.

- A 2-wide template can display 16 trend samples.
- A 3-wide template can display 29 trend samples.

**Trigger Type:** Allows you to select the trigger type for the trending. The selections are described below.

**Interval:** Allows you to sample a trend value when a time period has elapsed. The Interval in conjunction with the Trend Scan Delay designates the time interval between trend samples. (The Trend Scan Delay is configured in the System Parameters - Communications Tab dialog box.)

The following equation is used to calculate the time interval between trend samples:

\[ \text{Trend Scan Delay} \times \text{Interval} = \text{Sample Rate} \]

For example, if the Trend Scan Delay is 2 seconds and the Interval is 3, the sample rate will be 6 seconds.

If the Interval trigger type is selected, the Interval Expression field will be displayed.

**Discrete:** Allows you to sample a trend value when an external value (e.g., a bit reference in the PLC) changes resulting in the Interval Expression value changing from false to true. If the Discrete trigger type is selected, the Discrete Expression field will be displayed.

**Change:** Allows you to sample a trend value when the Value 1 Expression (trend value) changes. If the Change trigger type is selected, the Interval Expression field and the Discrete Expression field will not be displayed.
**Interval Expression:** Appears only when the Interval trigger type is selected. The Interval Expression field allows you to enter an expression that will determine the trend value sample rate. The result of the Interval Expression multiplied by the Trend Scan Delay (set in the System Parameters - Remote Tab dialog box) determines the trend value sample rate. The sample rate can range from 1 to 2,147,483 seconds.

For example, if the Trend Scan Delay is configured for 2 seconds and the Interval Expression evaluates to 5, the trend will be updated every 10 seconds. If the resulting sample rate is 0, the data collection for the trend template will be disabled. If the Trend Scan Delay is 0, it is assumed as 1 second when calculating the sample rate.

Note that if an interval is selected that is too rapid for the PanelMate unit or PLC to keep up with the request, a blank bar will appear where any interval has been missed. Low sample values might also cause a blank bar to appear. To distinguish as low sample value from a missed interval, configure the minimum calibration lower than the lowest expected minimum value.

- For PanelMate Grayscale units, Interval is the value that displays as a medium intensity horizontal bar to the right of the Value 1 bar.
- For PanelMate Color units, Interval is the value that displays as a blue horizontal bar to the right of the Value 1 bar.

Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations. Refer to the list of Conditional Expression Operators for more information.

**Discrete Expression:** Appears only when the Discrete trigger type is selected. The Discrete Expression field allows you to enter an expression so that a trend will be sampled when the result of the expression changes from false to true.

**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of the template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.

**Units:** Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” or “gals”. The Units field accepts alphanumeric characters.
Enable Conditional Visibility: Allows you to determine if the Bar Trend Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
**Bar Trend Template – Expressions Tab**

The **Bar Trend Template - Expressions Tab** dialog box is shown below.

The fields in the **Bar Trend Template - Expressions Tab** dialog box are described below.

**Value 1:** Allows you to enter a value expression. The result of this expression will be the value displayed in the Bar Trend Template.

When viewing the Bar Trend Template, Value 1 will be displayed as follows:

- For PanelMate Grayscale units, Value 1 is displayed as a no intensity horizontal bar in the center of the template.
- For PanelMate Color units, Value 1 is displayed as a green horizontal bar in the lower center of the template.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.
The following examples of expressions use a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

\[ [123] \]
The expression can be a single word reference. This example references word 123.

\[ ([123]+10)+[124] \]
This mathematical expression includes PLC references and constants that solve to a value.

\[ [\text{name1},242]+[\text{name2},243] \]
Information from multiple PLCs can be included in the same expression. In this expression, word 242 in PLC name1 is added to word 243 in PLC name2.

Refer to the list of Conditional Expression Operators for more information.

Note that Bar Trend Templates will not update if all references in these templates are unsolicited. If at least one reference in a Bar Trend Template is not unsolicited, then all references will update.

**Value 2:** Allows you to enter a value expression. The result of this expression will be the value displayed in the Bar Trend Template.

When viewing the Bar Trend Template, Value 2 will be displayed as follows:

- For PanelMate Grayscale units, Value 2 is displayed as a high intensity bar to the left of the Value 1 bar.
- For PanelMate Color units, Value 2 is displayed as a white horizontal bar to the left of the Value 1 bar. It is most often used as the setpoint for the device.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

Refer to the list of Conditional Expression Operators for more information.
**High Alarm:** Allows you to enter a High Alarm Expression. The results of the High Alarm Expression are compared to the results of the Value 1 Expression. If Value 1 exceeds the High Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the trend sample will be displayed as follows:

- For PanelMate Grayscale units, the trend sample is displayed in high intensity. The trend sample will continue to be displayed in high intensity as other trend samples are being collected as long as Value 1 exceeds the High Alarm Expression value. A High Alarm bar is shown in high intensity to the left of the Bar Trend Template.

- For PanelMate Color units, the trend sample is displayed in red. The trend sample will continue to be displayed in red as other trend samples are being collected as long as Value 1 exceeds the High Alarm Expression value. A High Alarm bar is shown in red to the left of the Bar Trend Template.

The High Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.
Low Alarm: Allows you to enter a Low Alarm Expression. The results of the Low Alarm Expression are compared to the results of the Value 1 Expression. If Value 1 is less than the Low Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the trend sample will be displayed as follows:

- For PanelMate Grayscale units, the variable-sized template is displayed in high intensity. The trend sample will continue to be displayed in high intensity as other trend samples are being collected as long as Value 1 is less than the Low Alarm Expression value. A Low Alarm bar is shown in high intensity to the left of the Bar Trend Template.

- For PanelMate Color units, the variable-sized template is displayed in red. The trend sample will continue to be displayed in red as other trend samples are being collected as long as Value 1 is less than the Low Alarm Expression value. A Low Alarm bar is shown in red to the left of the Bar Trend Template.

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.

Max Calibration: Allows you to determine the highest point of the line trend. This value displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed anywhere in the field.

Min Calibration: Allows you to determine the lowest point of the line trend. This value displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed anywhere in the field.
**Deadband Range**: Allows you to enter a number between 0-99 that will represent the percentage of the high alarm value minus the low alarm value that defines the width of the deadband.

The deadband range is an area below the high alarm value and above the low alarm value, that must be crossed before Value is considered to have returned to normal status (go out of alarm). The deadband range prevents multiple alarm messages from being generated when Value is hovering around an alarm threshold.

**Alarm Acknowledge**: Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.
### Bar Trend Template – Control Definitions Tab

The Bar Trend Template - Control Definitions Tab dialog box is shown below.

<table>
<thead>
<tr>
<th>Bar Trend Template</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bar Trend Attributes</td>
</tr>
</tbody>
</table>

![Control Definitions Tab](image)

The fields in the Bar Trend Template - Control Definitions Tab dialog box are described below.

**Control Type:** Allows you to define the control type used for the template. The selections are described below.

- **None:** Allows the template to show a value that the operator cannot control.
- **Buttons:** Requires the operator to use control buttons to change a setpoint value. If you choose Buttons, the dialog box will change. Refer to the Bar Trend Template - Control Definitions Tab with Button Control topic for more information.
- **Numeric:** Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box will change. Refer to the Bar Trend Template - Control Definitions Tab with Numeric Control topic for more information.

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.
Bar Trend Template – Control Definitions Tab with Button Control

The Bar Trend Template - Control Definitions Tab dialog box with button control is shown below.

![Control Definitions Tab](image)

The Bar Trend Template - Control Definitions Tab dialog box with button control defines the control buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.

The fields in the Bar Trend Template - Control Definitions Tab dialog box with button control are described below.

**Control Label/PLC Bit Reference:** Displays the control button labels and the associated PLC Bit Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at that location.
**Control Label:** Allows you to enter the control button label. The Control Label field accepts three lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the desired location. Note that on the configuration page, the text displayed in the control button will be truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to the next line, you can eliminate a carriage return in some cases.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the **Configuration Properties** dialog box.

**FG:** Allows you to select the foreground color or intensity for the control label. The FG button will display the standard Color Selection Palette.

**BG:** Allows you to select the background color or intensity for the control label. The BG button will display the standard Color Selection Palette.

**PLC Bit Reference:** Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. Expressions or conditional logic cannot be entered.
Bar Trend Template – Control Definitions Tab with Numeric Control

The Bar Trend Template - Control Definitions Tab dialog box with numeric control is shown below.

![Control Definitions Tab](image)

The fields in the Bar Trend Template - Control Definitions Tab dialog box with numeric control are described below.

**Input Value Expression:** Allows you to enter any mathematical expression that must be performed on the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is used to designate the operator input. The expression entered here may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples below.

- `(?[?]-32)*5/9`
  The operator’s input is changed from Fahrenheit to Celsius.

- `?[?]*(?[?]>=0)*(?[?]<=100)+([?]<0)*[123]+([?]>100)*[123]`
  Target Word Address is [123]
  This expression limits entries between 0 and 100 to the PLC register. Any value outside this range has no effect on the value in the register.

Refer to the list of Conditional Expression Operators for more information.
**Target Word Address:** Allows you to define the location of the operator’s input in the PLC as the result of the Input.

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address \[364#S16\].

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

**Password Protection:** Allows you to lock out access to numeric entry unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

Password protection must be validated each time the template is selected for numeric entry.

The template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.


Line Trend Template

Note that the Advanced Trending option must be installed in the PanelMate unit and the Advanced Trending Template box must be selected in the New Configuration dialog box or in the Configuration Properties dialog box before a Line Trend Template can be created.

Line Trend Templates are designed to collect, store, and represent data in a manner that provides a historical perspective on how a single data point has changed and some insight on how the data point may behave in the future.

The Line Trend Template show current value, setpoint, and high and low alarm levels. The current value and setpoint display digitally.

The Line Trend Template consists of three tabbed dialog boxes that are listed below.

- Line Trend Template - Line Trend Attributes Tab
- Line Trend Template - Pen Definitions Tab
- Line Trend Template - Control Definitions Tab
Line Trend Template – Line Trend Attributes Tab

The Line Trend Template - Line Trend Attributes Tab dialog box is shown below.

![Line Trend Template - Line Trend Attributes Tab dialog box]

The fields in the Line Trend Template - Line Trend Attributes Tab dialog box are described below.

**Device Name:** Allows you to enter a device name. The device name will display in the upper area of the template in the normal font. You may press the *Return* key to insert a carriage return.

The Device Name field has an auto centering capability. If you wish to center the Device Name, check the Device Names box in the Auto Centering field in the **Configuration Properties** dialog box.

Note that the name used in the Device Name field may be part of an alarm message. Be aware that only 22 characters for the Device Name will appear when the alarm message displays in Run Mode. The Device Name field allows you to enter more than 22 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the **Font Editor** topic.
Template Size In Cells

Height: Allows you to enter the height of the Line Trend Template as 1, 2, or 3. The height of the Line Trend Template determines the number of trend samples that can be displayed at one time.

Width: Allows you to enter the width of the Line Trend Template as 2, 3, 4, or 5.

Trigger Type: Allows you to select the trigger type for the trending. The selections are described below.

Interval: Allows you to sample a trend value when a time period has elapsed. The Interval in conjunction with the Trend Scan Delay designates the time interval between trend samples. (The Trend Scan Delay is configured in the System Parameters - Communications Tab dialog box.)

The following equation is used to calculate the time interval between trend samples:

\[ \text{Trend Scan Delay} \times \text{Interval} = \text{Sample Rate} \]

For example, if the Trend Scan Delay is 2 seconds and the Interval is 3, the sample rate will be 6 seconds.

If the Interval trigger type is selected, the Interval Expression field will be displayed.

Discrete: Allows you to sample a trend value when an external value (e.g., a bit reference in the PLC) changes resulting in the Interval Expression value changing from false to true. If the Discrete trigger type is selected, the Discrete Expression field will be displayed.

Change: Allows you to sample a trend value when the Value 1 Expression (trend value) changes. If the Change trigger type is selected, the Interval/Discrete Expression field will not be displayed.
**Interval Expression:** Appears only when the Interval trigger type is selected. The Interval Expression field determines the trend value sample rate. The result of the Interval Expression multiplied by the Trend Scan Delay (set in the **System Parameters - Remote Tab** dialog box) determines the trend value sample rate. The sample rate can range from 1 to 2,147,483 seconds.

For example, if the Trend Scan Delay is configured for 2 seconds and the Interval Expression evaluates to 5, the trend will be updated every 10 seconds. If the resulting sample rate is 0, the data collection for the trend template will be disabled. If the Trend Scan Delay is 0, it is assumed as 1 second when calculating the sample rate.

Note that if an interval is selected that is too rapid for the PanelMate unit or PLC to keep up with the request, a blank space will appear where any interval has been missed. Low sample values might also cause a blank space to appear. To distinguish as low sample value from a missed interval, configure the minimum calibration lower than the lowest expected minimum value.

- For PanelMate Grayscale units, Interval is the value that displays as a medium intensity horizontal bar to the right of the Value 1 bar.
- For PanelMate Color units, Interval is the value that displays as a blue horizontal bar to the right of the Value 1 bar.

Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

Refer to the list of Conditional Expression Operators for more information.

**Discrete Expression:** Appears only when the Discrete trigger type is selected. The Discrete Expression field allows you to enter an expression so that a trend will be sampled when the result of the expression changes from false to true.

**Deadband Range:** Allows you to enter a number between 0-99 that will represent the percentage of the high alarm value minus the low alarm value that defines the width of the deadband.

The deadband range is an area below the high alarm value and above the low alarm value, that must be crossed before Value is considered to have returned to normal status (go out of alarm). The deadband range prevents multiple alarm messages from being generated when Value is hovering around an alarm threshold.
**Alarm Acknowledge:** Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.

**Chart Bg:** Allows you to select the background color or intensity for the chart. The Chart Bg button will display the standard Color Selection Palette.

**Grid Line Setup**

These controls define a grid that displays on the Line Trend Template.

- **Horizontal Lines:** Allows you to elect the number of horizontal grid lines displayed for the Line Trend Template.
- **Vertical Lines Every n Samples:** Allows you to determine the spacing of the vertical grid lines.
- **Color:** Allows you to select the foreground color or intensity for the grid lines. The Color button will display the standard Color Selection Palette.

**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of the template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.

**Enable Conditional Visibility:** Allows you to determine if the Line Trend Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

**Visibility Expression:** Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Line Trend Template – Pen Definitions Tab

The Line Trend Template - Pen Definitions Tab dialog box is shown below.

The fields in the Line Trend Template - Pen Definitions Tab dialog box are described below.

**Name/Max. Cal./Min. Cal. Value Expression:** Line 1 in this list box corresponds to the top pen; line 2 corresponds to the next pen, etc. It is not necessary to use all pens. If you do not want a particular pen, leave the line blank.

**Name:** Allows you to enter a name for the pen. The Name field accepts alphanumeric characters.

**Units:** Allows you to define the type of units that will be displayed to the operator, such as “Deg. F” or “gals”. The Units field accepts alphanumeric characters.

**Pen Color:** Allows you to select the foreground color or intensity for the pen. The Pen Color button will display the standard Color Selection Palette.
**Alarm Color**: Allows you to select the foreground color or intensity for the pen when the monitored value goes into an alarm condition. The **Alarm Color** button will display the standard Color Selection Palette.

**Max Calibration**: Allows you to determine the highest point of the line trend. This value displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed anywhere in the field.

**Min Calibration**: Allows you to determine the lowest point of the line trend. This value displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed anywhere in the field.

**Value Expression**: Allows you to enter a value expression. The result of this expression will be the value displayed in the Line Trend Template. This expression is any mathematical operation to be performed on the monitored value before it is displayed on the screen.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

The following examples of expressions use a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

```
[123]
```

The expression can be a single word reference. This example references word 123.

```
([123]*10)+[124]
```

This mathematical expression includes PLC references and constants that solve to a value.

```
[name1,242]+[name2,243]
```

Information from multiple PLCs can be included in the same expression. In this expression, word 242 in PLC name1 is added to word 243 in PLC name2.

Refer to the list of Conditional Expression Operators for more information.

Note that Line Trend Templates will not update if all references in these templates are unsolicited. If at least one reference in a Line Trend Template is not unsolicited, then all references will update.
**High Alarm Expression:** Allows you to enter a High Alarm Expression. The results of the High Alarm Expression are compared to the results of the Value Expression. If Value exceeds the High Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the trend sample will be displayed as follows:

- For PanelMate Grayscale units, the trend sample is displayed in the color defined in the Alarm Color field. The trend sample will continue to be displayed in the alarm color as other trend samples are being collected as long as Value exceeds the High Alarm Expression value. A High Alarm bar is shown in high intensity to the left of the Line Trend Template.

- For PanelMate Color units, the trend sample is displayed in the color defined in the Alarm Color field. The trend sample will continue to be displayed in the alarm color as other trend samples are being collected as long as Value exceeds the High Alarm Expression value. A High Alarm bar is shown in red to the left of the Line Trend Template.

The High Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank. Refer to the list of Conditional Expression Operators for more information.
**Low Alarm Expression:** Allows you to enter a Low Alarm Expression. The results of the Low Alarm Expression are compared to the results of the Value Expression. If Value is less than the Low Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the trend sample will be displayed as follows:

- For PanelMate Grayscale units, the trend sample is displayed in the Alarm Color field high intensity. The trend sample will continue to be displayed in the alarm color as other trend samples are being collected as long as Value is less than the Low Alarm Expression value. A Low Alarm bar is shown in high intensity to the left of the Line Trend Template.

- For PanelMate Color units, the trend sample is displayed in the Alarm Color field. The trend sample will continue to be displayed in the alarm color as other trend samples are being collected as long as Value is less than the Low Alarm Expression value. A Low Alarm bar is shown in red to the left of the Line Trend Template.

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank. Refer to the list of Conditional Expression Operators for more information.
Line Trend Template – Control Definitions Tab

The Line Trend Template - Control Definitions Tab dialog box is shown below.

The fields in the Line Trend Template - Control Definitions Tab dialog box are described below.

**Input Value Expression**: Allows you to enter any mathematical expression that must be performed on the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is used to designate the operator input. The expression entered here may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.
If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples below.

\[(?\cdot32)^{5/9}\]

The operator’s input is changed from Fahrenheit to Celsius.

\[\text{Target Word Address is } [123]\]

This expression limits entries between 0 and 100 to the PLC register. Any value outside this range has no effect on the value in the register.

Refer to the list of Conditional Expression Operators for more information.

**Target Word Address:** Allows you to define the location of the operator’s input in the PLC as the result of the Input.

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address [364#S16].

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.
**Password Protection:** Allows you to lock out access to numeric entry unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

Password protection must be validated each time the template is selected for numeric entry.

The template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.
Display Template

Display Templates are designed to be used like standard LED or LCD message units or displays. They are most effective when used for informational messages and not as alarm messages. Up to three independent lines of text can be written in a Display Template.

The actual creation of the message is done in the Message Library that can be selected from the Display Template - Expressions Tab dialog box or the Database Treeview Window.

The Display Template consists of three tabbed dialog boxes that are listed below.

- Display Template - Display Attributes Tab
- Display Template - Expressions Tab
- Display Template - Control Definitions Tab
Display Template – Display Attributes Tab

The Display Template – Display Attributes Tab dialog box is shown below.

The fields in the Display Template - Display Attributes Tab dialog box are described below.

Template Size In Cells

Height: Displays the height of the Display Template as 1. This value cannot be changed.

Width: Allows you to enter the width of the Display Template as 3, 4, or 5.
- A 3-wide template can display a message of up to 36 normal font characters
- A 4-wide template can display up to 49 characters
- A 5-wide template can display up to 62 characters.

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and graphics that lie within the area of the template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.
Enable Conditional Visibility: Allows you to determine if the Display Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Display Template – Expressions Tab

The Display Template - Expressions Tab dialog box is shown below.

The fields in the Display Template - Expressions Tab dialog box are described below.

**Line/Message Expression/Test Msg#:** Displays line numbers, message expressions, and test message numbers configured for the Display Template. The Line/Message Expression/Test Msg# box may contain up to three message expressions. Each line represents a single message and is numbered 1, 2, and 3 at the left of the line.

**Message Expression:** Allows you to enter a message expression. The value of the Message Expression selects which message will be displayed. The result of the Message Expression should be a number that represents the number of a message in the Message Library. The message will be displayed in the Display Template. If the Message Expression results in a number greater than the maximum number allowed in the Message Library or less than 0 when running online, the previously displayed message will be erased.
If the message expression results in an invalid equation (e.g., division by a value of zero, etc.), no message displays. If a message expression previously resulted in a valid value, but in a later scan results in an invalid equation, the previously displayed message will be erased.

To display a message based on a bit, multiply the bit reference times the message number to produce the message number. For example, to display message #25 when bit [127 14] is on, enter [127 14]*25 in the Message Expression field.

The message expression can be as simple as a word reference (e.g., [253]) or a mathematical expression which solves to a value corresponding to a message number (e.g., [254]+12). The message expression can contain multiple PLC references. Note that the preceding examples are shown using a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

When the Message Expression is true, embedded references are updated on the screen and not sent to the printer. Messages configured for BOTH or PRINTER are sent to the printer when the Message Expression changes and also when changing pages.

Note that when going to a new page that has non-global messages, messages set for PRINTER or BOTH will print once for each PLC reference in the message expression. Non-global messages on a page set for PRINTER or BOTH will print when returning from the Alarm Page, Screen Blanking, and when pressing the Enable Fault Relay control button, since these actions are treated as page changes.

Refer to the list of Conditional Expression Operators for more information.
The Display Template also supports the display of ASCII strings from the PLC. To display ASCII strings, place the starting address of the ASCII characters within the Message Expression field, followed by the format specifier #ASC which then is followed by the number of characters to be displayed. When the PanelMate unit recognizes an ASCII format specifier (#ASC) in the message expression, the PanelMate unit will display the ASCII string from the PLC. Optionally, a byte-swap format specifier, #BSW, can be added to swap the order of character presentation on a word-by-word basis. The following table shows a block of generic PLC registers and the decimal, hex, and ASCII values for the registers.

<table>
<thead>
<tr>
<th>Registers</th>
<th>Decimal Value</th>
<th>Hex Value</th>
<th>ASCII Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>16706</td>
<td>4142</td>
<td>AB</td>
</tr>
<tr>
<td>101</td>
<td>17220</td>
<td>4344</td>
<td>CD</td>
</tr>
<tr>
<td>102</td>
<td>17734</td>
<td>4546</td>
<td>EF</td>
</tr>
<tr>
<td>103</td>
<td>18248</td>
<td>4748</td>
<td>GH</td>
</tr>
<tr>
<td>104</td>
<td>18762</td>
<td>494A</td>
<td>IJ</td>
</tr>
<tr>
<td>105</td>
<td>19276</td>
<td>4B4C</td>
<td>KL</td>
</tr>
<tr>
<td>106</td>
<td>19790</td>
<td>4D4E</td>
<td>MN</td>
</tr>
<tr>
<td>107</td>
<td>20304</td>
<td>4F50</td>
<td>OP</td>
</tr>
<tr>
<td>108</td>
<td>20818</td>
<td>5152</td>
<td>QR</td>
</tr>
<tr>
<td>109</td>
<td>21332</td>
<td>5354</td>
<td>ST</td>
</tr>
</tbody>
</table>

If the following expressions are entered in the Message Expression field, the string will be displayed as shown below.

<table>
<thead>
<tr>
<th>Message Expression</th>
<th>Displayed String</th>
</tr>
</thead>
<tbody>
<tr>
<td>[100#ASC20]</td>
<td>ABCDEFGHIJKLMNOPQRS</td>
</tr>
<tr>
<td></td>
<td>T</td>
</tr>
<tr>
<td>[100#BSW#ASC20]</td>
<td>BADCFEHIJKLNMOPQRST</td>
</tr>
<tr>
<td></td>
<td>S</td>
</tr>
<tr>
<td>[105#ASC7]</td>
<td>KLMNOPQ</td>
</tr>
<tr>
<td>[105#BSW#ASC7]</td>
<td>LKNMPOR</td>
</tr>
</tbody>
</table>

ASCII registers displayed in this manner will appear in normal font with white foreground and black background. These display attributes (font size, foreground color, and background color) may be changed by defining them in the first two words of the string.
The most significant byte of the first word must contain a 1. This will signal the PanelMate unit that the attributes are to be altered. The least significant byte of the first word must contain the font size key.

01 = Normal  
02 = Graphic  
03 = Double-High  
04 = Quad

The most significant byte of the second word contains the foreground color, and the least significant byte contains the background color. The colors are numbered 1 through 255 and can be determined by using the Color Palette in the Configuration Software, counting left to right and top to bottom (e.g., black=1, blue=2, green=3, cyan=4, red=5, magenta=6, yellow=7, etc.). Refer to the examples below.

Examples:

If register 98 has a value of 260 (Hex 0104), and register 99 has a value of 1287 (hex 0507), then the message [98#ASC6] would display the string ABCDEF in Quad font with red characters on yellow background.

If the byte swap format is used, then the bytes of the first two words need to be swapped. Register 98 will have a value of 1025 (hex 0401) and register 99 will have a value of 1797 (Hex 0705). The message [98#BSW#ASC6] would then display the string BADCFE in Quad font with yellow characters on a red background.

Test Message Number: Allows you to enter a test message number. To view a message on the page during configuration, a message number may be entered into the Test Message field. The message corresponding to this number will be displayed at the Display Template’s origin. If there is not a message defined for that number, the template will be blank.

<Message Library>: Opens the Message Library dialog box. Refer to the Message Library topic for more information.
Display Template – Control Definitions Tab

The Display Template - Control Definitions Tab dialog box is shown below.

The fields in the Display Template - Control Definitions Tab dialog box are described below.

Control Label/PLC Bit Reference: Displays the control labels and PLC bit references and allows you to define the control buttons on the right side of the PanelMate unit. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at a particular location.

If a control button is defined, a small arrow will be displayed in the lower left corner of a template to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the bit to a 0 (zero), thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.
**Control Label:** Allows you to enter a label for a control button. This field accepts three lines of normal-sized alphanumeric characters. The text does not automatically wrap. Press the **Return** key to insert a carriage return.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the **Configuration Properties** dialog box.

**FG:** Allows you to select the foreground color or intensity for the control label. The **FG** button will display the standard Color Selection Palette.

**BG:** Allows you to select the background color or intensity for the control label. The **BG** button will display the standard Color Selection Palette.

**PLC Bit Reference:** Allows you to enter a PLC bit reference for the control button. This field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. You cannot use expressions or conditional logic.
Variable-Sized Templates

In this chapter, you will learn:

- About the Variable-Sized Indicator Template
- About the Variable-Sized Bar Template
- About the Variable-Sized Readout Template
- About the Variable-Sized Display Template
- About the Variable-Sized Graphic Template
- About the Variable-Sized Control Button Template
Variable-Sized Indicator Template

Variable-Sized Indicator Templates provide the ability to create high-density status displays. One of 5 pre-defined indicators can be used to indicate the status of a device. To tie a state to information in the PLC, a conditional expression may be entered which, when evaluated to true, displays the characteristics defined for that line. The expression may be as simple as the condition of a single bit in the PLC (true = ON; false = OFF), a value comparison (register > constant), or a Boolean expression of up to 70 characters in length.

The Variable-Sized Indicator Template consists of two tabbed dialog boxes which are listed below.

- Variable-Sized Indicator Template - VS Indicator Attributes Tab
- Variable-Sized Indicator Template - VS Indicator States Tab
Variable-Sized Indicator Template – VS Indicator Attributes Tab

The Variable-Sized Indicator Template - VS Indicator Attributes Tab dialog box is shown below.

The fields in the Variable-Sized Indicator Template - VS Indicator Attributes Tab dialog box are described below.

Pixel Location

X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Indicator Template.

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Indicator Template.

Template Size In Pixels

Height: Allows you to enter the height in pixels for the Variable-Sized Indicator Template. Note that you can also re-size the template by dragging one of the selection handles (squares) in any direction.

Width: Allows you to enter the width in pixels for the Variable-Sized Indicator Template. Note that you can also re-size the template by dragging one of the selection handles (squares) in any direction.
Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and graphics that lie within the area of the variable-sized template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.

Alarm Device Name: Allows you to enter a device name to be used as part of an alarm message. The Alarm Device Name field accepts normal-sized characters. The name used in the Alarm Device Name field may be part of an alarm message. Be aware that only 25 characters for the Alarm Device Name will appear when the alarm message displays in Run Mode. The Alarm Device Name field allows you to enter more than 25 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the Font Editor topic.

Enable Conditional Visibility: Allows you to determine if the Variable-Sized Indicator Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Variable-Sized Indicator Template – VS Indicator States Tab

The Variable-Sized Indicator Template - VS Indicator States Tab dialog box is shown below.

The fields in the Variable-Sized Indicator Template - VS Indicator States Tab dialog box are described below.

**Alarm Message/Conditional Expression/Alm/Ack**: Displays alarm messages, conditional expressions, alarms, and alarm acknowledgments configured for the Variable-Sized Indicator Template. If the conditional expression evaluates to true, the associated template characteristics will be displayed in Run Mode. Each Variable-Sized Indicator Template can display up to five alarm messages, depending upon conditions you define. Each line in this list represents one of the alarm messages.
**Conditional Expression**: Allows you to enter a conditional expression. The conditional expression can be a numerical, logical or relational expression that evaluates to true or false. When a numerical expression is evaluated if the result is even (least significant bit = 0), the value is false, and if the result is odd (least significant bit = 1), the value is true.

In Run Mode, if an expression is satisfied (true or false), the characteristics defined for that line are used to display the template. If more than one expression is satisfied at the same time, the line with the highest priority displays. Line 1 has the highest priority and line 5 has the lowest.

When an expression results in an invalid equation (e.g., division by zero, etc.), no value or graphics are displayed.

If a true expression goes false in a later scan, the display for the true expression is erased.

Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

Refer to the list of Conditional Expression Operators for more information.

**Colors**

- **Pen**: Allows you to select the foreground color or intensity for the template. The **Pen** button will display the standard Color Selection Palette.

- **Fill**: Allows you to select the background color or intensity for the template. The **Fill** button will display the standard Color Selection Palette.
Alarm

**Alarm**: Allows you to designate any line of the template definition as an alarm state. If the Alarm box is selected and the conditional expression evaluates to be true, an alarm message will be placed in the alarm list and sent to the printer if one is configured.

If the Alarm box is selected, the condition associated with the alarm will be monitored at all times, regardless of the page being displayed. Judicious use of the alarm state is recommended to maximize the response time of the PanelMate unit.

**Acknowledge**: Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.

**Alarm Message**: Allows you to enter the alarm message that will be displayed on the alarm line when the state goes into alarm and to a printer if one is configured.
Variable-Sized Bar Template

Variable-Sized Bar Templates are designed to replace analog meters and face plates found on a conventional control panel. The Variable-Sized Bar Templates can also be used along with Symbols or Graphic elements to simulate tank fills, pipe flow, conveyors, and other specific applications. They also allow for definition of high and low alarm levels.

The Variable-Sized Bar Template consists of three tabbed dialog boxes which are listed below.

- Variable-Sized Bar Template - VS Bar Attributes Tab
- Variable-Sized Bar Template - Expressions Tab
- Variable-Sized Bar Template - Control Definitions Tab
Variable-Sized Bar Template – VS Bar Attributes Tab

The Variable-Sized Bar Template - VS Bar Attributes Tab dialog box is shown below.

The fields in the Variable-Sized Bar Template - VS Bar Attributes Tab dialog box are described below.

**Pixel Location**

**X**: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Bar Template.

**Y**: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Bar Template.

**Template Size In Pixels**

**Height**: Allows you to enter the height in pixels for the Variable-Sized Bar Template. Note that you can also re-size the template by dragging one of the selection handles (squares) in any direction.

**Width**: Allows you to enter the width in pixels for the Variable-Sized Bar Template. Note that you can also re-size the template by dragging one of the selection handles (squares) in any direction.
**Alarm Device Name:** Allows you to enter a device name to be used as part of an alarm message. The Alarm Device Name field accepts normal-sized characters.

The name used in the Alarm Device Name field may be part of an alarm message. Be aware that only 25 characters for the Alarm Device Name will appear when the alarm message displays in Run Mode. The Alarm Device Name field allows you to enter more than 25 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the [Font Editor] topic.

**Colors**

- **Bar:** Allows you to select the foreground color or intensity for the template. The Bar button will display the standard Color Selection Palette.

- **Erase:** Allows you to select the background color or intensity for the template. The Erase button will display the standard Color Selection Palette.

**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of the variable-sized template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.

**Direction:** Allows you to determine which direction the dynamic portion of the bar will move. The selections are Up, Down, Left, and Right.

**Enable Conditional Visibility:** Allows you to determine if the Variable-Sized Bar Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

**Visibility Expression:** Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Variable-Sized Bar Template – Expressions Tab

The Variable-Sized Bar Template - Expressions Tab dialog box is shown below.

The fields in the Variable-Sized Bar Template - Expressions Tab dialog box are described below.

**Expressions**

**Value:** Allows you to enter a value expression. The result of this expression will be the bar height displayed in the Variable-Sized Bar Template.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

Refer to the list of Conditional Expression Operators for more information.
**High Alarm:** Allows you to enter a High Alarm Expression. The results of the High Alarm Expression are compared to the results of the Value Expression. If Value exceeds the High Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the bar color will be displayed as follows:

- For PanelMate Grayscale units, the Variable-Sized Bar template is displayed with medium intensity characters on a blinking high intensity background.

- For PanelMate Color units, the variable-sized template is displayed in white with a blinking red background.

Note that if the high alarm value is greater than or equal to the Max Calibration value, the entire bar will be displayed in white and no blinking red will be shown.

The High Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.
Low Alarm: Allows you to enter a Low Alarm Expression. The results of the Low Alarm Expression are compared to the results of the Value Expression. If Value is less than the Low Alarm Expression value, an alarm message is placed in the alarm list. When in an alarm state, the bar colors will be displayed as follows:

- For PanelMate Grayscale units, the variable-sized template is displayed with medium intensity characters on a blinking high intensity background.
- For PanelMate Color units, the variable-sized template is displayed in white with a blinking red background.

Note that if the low alarm value is less than or equal to the Min Calibration, the entire bar will be displayed in blinking red and no white will be shown.

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.
**Maximum Calibration:** Allows you to determine the highest point of the bar. This value displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed anywhere in the field.

**Minimum Calibration:** Allows you to determine the lowest point of the bar. This value displays on the template. This six-character text box accepts 6 digits, or 5 digits with a decimal point placed anywhere in the field.

**Deadband Range:** Allows you to enter a number between 0-99 that will represent the percentage of the high alarm value minus the low alarm value that defines the width of the deadband.

The deadband range is an area below the high alarm value and above the low alarm value, that must be crossed before Value is considered to have returned to normal status (go out of alarm). The deadband range prevents multiple alarm messages from being generated when Value is hovering around an alarm threshold.

**Alarm Acknowledge:** Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.
Variable-Sized Bar Template – Control Definitions Tab

The Variable-Sized Bar Template - Control Definitions Tab dialog box is shown below.

![Variable-Sized Bar Template](image)

The fields in the Variable-Sized Bar Template - Control Definitions Tab dialog box are described below.

**Control Type:** Allows you to define the control type used for the template. The selections are described below.

- **None:** Allows the template to show a value that the operator cannot control.
- **Buttons:** Requires the operator to use control buttons to change a setpoint value. If you choose Buttons, the dialog box will change. Refer to the Variable-Sized Bar Template - Control Definitions Tab with Button Control topic for more information.
- **Numeric:** Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box will change. Refer to the Variable-Sized Bar Template - Control Definitions Tab with Numeric Control topic for more information.

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.
Variable-Sized Bar Template – Control Definitions Tab with Button Control

The Variable-Sized Bar Templates - Control Definitions Tab dialog box with button control is shown below.

The **Variable-Sized Bar Template - Control Definitions Tab** dialog box with button control defines the control buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.
The fields in the Variable-Sized Bar Template - Control Definitions Tab dialog box with button control are described below.

**Control Indicator**

- **Position**: Allows you to select the position inside of the Variable-Sized Bar Template for control indicator arrow. The selections are listed below.
  - Left
  - Below
  - Right
  - Above

- **Display**: Allows you to determine if the arrow will always be visible or visible only when the template is selected. The selections are Always and On Selection.

**Control Label/PLC Bit Reference**: Displays the control button labels and the associated PLC Bit Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at that location.

**Control Label**: Allows you to enter the control button label. The Control Label field accepts three lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the desired location. Note that on the configuration page, the text displayed in the control button will be truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to the next line, you can eliminate a carriage return in some cases.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the Configuration Properties dialog box.

**FG**: Allows you to select the foreground color or intensity for the control label. The FG button will display the standard Color Selection Palette.

**BG**: Allows you to select the background color or intensity for the control label. The BG button will display the standard Color Selection Palette.

**PLC Bit Reference**: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. Expressions or conditional logic cannot be entered.
Variable-Sized Bar Template – Control Definitions Tab with Numeric Control

The Variable-Sized Bar Templates - Control Definitions Tab dialog box with numeric control is shown below.

![Variable-Sized Bar Template - Control Definitions Tab dialog box](image)

The fields in the Variable-Sized Bar Template - Control Definitions Tab dialog box with numeric control are described below.

**Control Indicator**

- **Position**: Allows you to select the position inside of the Variable-Sized Bar Template for control indicator arrow. The selections are listed below.
  - Left
  - Below
  - Right
  - Above

- **Display**: Allows you to determine if the arrow will always be visible or visible only when the template is selected. The selections are Always and On Selection.
**Input Value Expression:** Allows you to enter any mathematical expression that must be performed on the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is used to designate the operator input. The expression entered here may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples below.

\[(?\cdot32)\times5/9\]

The operator’s input is changed from Fahrenheit to Celsius.

\[?\ast(?\gt0)\ast(?\leq100)+(?\lt0)\ast[123]+(?\gt100)\ast[123]\]

**Target Word Address is [123]**

This expression limits entries between 0 and 100 to the PLC register. Any value outside this range has no effect on the value in the register.

Refer to the list of Conditional Expression Operators for more information.

**Target Word Address:** Allows you to define the location of the operator’s input in the PLC as the result of the Input.

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address [364#S16].

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.
Password Protection: Allows you to lock out access to numeric entry unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

Password protection must be validated each time the template is selected for numeric entry.

The template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the System Parameters - Password Tab dialog box.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.
Variable-Sized Readout Template

Variable-Sized Readout Templates are designed to replace numeric and digital readout devices found on a conventional control panel, and to supply the functionality often provided by CRT-based devices. Displayed values can be scaled by the PanelMate unit without requiring any additional logic in the PLC.

⇒ **RPM: 1600**

The Variable-Sized Readout Template consists of three tabbed dialog boxes that are listed below.

- Variable-Sized Readout Template - VS Readout Attributes Tab
- Variable-Sized Readout Template - Expressions Tab
- Variable-Sized Readout Template - Control Definitions Tab
Variable-Sized Readout Template – VS Readout Attributes Tab

The Variable-Sized Readout Template - VS Readout Attributes Tab dialog box is shown below.

The fields in the Variable-Sized Readout Template - VS Readout Attributes Tab dialog box are described below.

**Pixel Location**

- **X:** Allows you to enter the X-location of the upper-left corner of the Variable-Sized Readout Template.
- **Y:** Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Readout Template.

**Template Size In Characters**

- **Height:** Displays the height of the Variable-Sized Readout Template as 1. This value cannot be changed.
- **Width:** Allows you to enter the width of the Variable-Sized Readout Template. Note that you can also re-size the width of the template by dragging the middle selection handle (square) on the right of the template.
**Alarm Device Name:** Allows you to enter a device name to be used as part of an alarm message. The Alarm Device Name field accepts normal-sized characters.

The name used in the Alarm Device Name field may be part of an alarm message. Be aware that only 25 characters for the Alarm Device Name will appear when the alarm message displays in Run Mode. The Alarm Device Name field allows you to enter more than 25 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the Font Editor topic.

**Colors**

- **FG:** Allows you to select the foreground color or intensity for the template. The FG button will display the standard Color Selection Palette.

- **BG:** Allows you to select the background color or intensity for the template. The BG button will display the standard Color Selection Palette.

**Font:** Allows you to choose the font that is used to display the Variable-Sized Readout Template on the page. The selections are Normal, Double High and Quad.

**Direction:** Allows you to select the orientation in which the readout value is displayed. The selections are Horizontal (left-to-right) and Vertical (top-to-bottom).

**Decimal Places:** Allows you to determine how the number will be formatted when displayed. This field accepts the numbers 0 through 9.

**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of the variable-sized template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.
Enable Conditional Visibility: Allows you to determine if the Variable-Sized Readout Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Variable-Sized Readout Template – Expression Tab

The Variable-Sized Readout Template – Expression Tab dialog box is shown below.

The fields in the Variable-Sized Readout Template – Expression Tab dialog box are described below.

**Expressions**

**Value:** Allows you to enter a value expression. The result of this expression will be the value displayed in the Variable-Sized Readout Template.

The expression entered may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

Note that if a value is too large to display in the variable-size template, a string of Xs (XXXXXX) will be displayed for the value. For example, if a Variable-Sized Readout Template was defined as three characters in length, but the value to be displayed was four characters, XXX would be displayed for the value.

Refer to the list of Conditional Expression Operators for more information.
**High Alarm:** Allows you to enter a High Alarm Expression. The results of the High Alarm Expression are compared to the results of the Value Expression. If Value exceeds the High Alarm Expression value, an alarm message is placed in the alarm list.

- For PanelMate Grayscale units, the variable-sized template is displayed with medium intensity characters on a blinking high intensity background.
- For PanelMate Color units, the variable-sized template is displayed with white characters on a blinking red background.

The High Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.

**Low Alarm:** The results of the Low Alarm Expression are compared to the results of the Value Expression. If Value is less than the Low Alarm Expression value, an alarm message is placed in the alarm list.

- For PanelMate Grayscale units, the variable-sized template is displayed with medium intensity characters on a blinking high intensity background.
- For PanelMate Color units, the template is displayed with white characters on a blinking red background.

The Low Alarm Expression can include multiple PLC word and bit references. Mathematical operations that may be used are multiplication, division, addition, and subtraction. You may also enter a single constant value (e.g., 900) as an expression. Parentheses may be used to change the order of operations.

This is an optional entry. If no alarm is desired for this device, leave this field blank.

Refer to the list of Conditional Expression Operators for more information.
**Deadband Range:** Allows you to enter a number between 0-99 that will represent the percentage of the high alarm value minus the low alarm value that defines the width of the deadband.

The deadband range is an area below the high alarm value and above the low alarm value, that must be crossed before Value is considered to have returned to normal status (go out of alarm). The deadband range prevents multiple alarm messages from being generated when Value is hovering around an alarm threshold.

**Alarm Acknowledge:** Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Alarm Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Alarm Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.
Variable-Sized Readout Template – Control Definitions Tab

The Variable-Sized Readout Template - Control Definitions Tab dialog box is shown below.

The fields in the Variable-Sized Readout Template - Control Definitions Tab dialog box are described below.

**Control Type:** Allows you to define the control type used for the template. The selections are described below.

- **None:** Allows the template to show a value that the operator cannot control.
- **Buttons:** Requires the operator to use control buttons to change a setpoint value.
  If you choose Buttons, the dialog box will change. Refer to the Variable-Sized Readout Template - Control Definitions Tab with Button Control topic for more information.
- **Numeric:** Requires the operator to enter a setpoint value. If you choose Numeric, the dialog box will change. Refer to the Variable-Sized Readout Template - Control Definitions Tab with Numeric Control topic for more information.

Note that if Numeric or Button is selected, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.
Variable-Sized Readout Template – Control Definitions Tab with Button Control

The Variable-Sized Readout Template - Control Definitions Tab dialog box with button control is shown below.

The Variable-Sized Readout Template - Control Definitions Tab dialog box with button control defines the control buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 00] to 1. When the button is released, a separate command is sent to set the bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.
The fields in the **Variable-Sized Readout Template - Control Definitions Tab** dialog box with button control are described below.

**Control Indicator**

**Position:** Allows you to select the position inside of the Variable-Sized Readout Template for control indicator arrow. The selections are listed below.
- Left
- Below
- Right
- Above

When redefined fonts are used, the position of the control indicator arrow for a Variable-Sized Readout Template may appear in the wrong position in Run Mode.

**Display:** Allows you to determine if the arrow will always be visible or visible only when the template is selected. The selections are Always and On Selection.

**Control Label/PLC Bit Reference:** Displays the control button labels and the associated PLC Bit Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at that location.

**Control Label:** Allows you to enter the control button label. The Control Label field accepts three lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the desired location. Note that on the configuration page, the text displayed in the control button will be truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to the next line, you can eliminate a carriage return in some cases.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the **Configuration Properties** dialog box.
**FG**: Allows you to select the foreground color or intensity for the control label. The **FG** button will display the standard Color Selection Palette.

**BG**: Allows you to select the background color or intensity for the control label. The **BG** button will display the standard Color Selection Palette.

**PLC Bit Reference**: Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. Expressions or conditional logic cannot be entered.
Variable-Sized Readout Template – Control Definitions Tab with Numeric Control

The Variable-Sized Readout Templates - Control Definitions Tab dialog box with numeric control is shown below.

The fields in the Variable-Sized Readout Template - Control Definitions Tab dialog box with numeric control are described below.

**Control Indicator**

- **Position:** Allows you to select the position inside of the Variable-Sized Readout Template for control indicator arrow. The selections are listed below.
  - Left
  - Below
  - Right
  - Above

- **Display:** Allows you to determine if the arrow will always be visible or visible only when the template is selected. The selections are Always and On Selection.
**Input Value Expression**: Allows you to enter any mathematical expression that must be performed on the operator’s input before the number is stored in the PLC. A question mark inside brackets, [?], is used to designate the operator input. The expression entered here may include as many PLC word or bit references as needed, as well as mathematical operations. Parentheses may be used to change the order of operations.

If the operator input is to be entered in the PLC as-is, enter [?] in the field. Refer to the examples below.

\[(?\cdot32)\cdot5/9\]  
The operator’s input is changed from Fahrenheit to Celsius.

\[?(0)\cdot((?\leq100)\cdot((?\leq0)\cdot[123]\cdot((?\leq100)\cdot[123])\cdot[123])\cdot[123]\]  
**Target Word Address is [123]**  
This expression limits entries between 0 and 100 to the PLC register. Any value outside this range has no effect on the value in the register.

Refer to the list of Conditional Expression Operators for more information.

**Target Word Address**: Allows you to define the location of the operator’s input in the PLC as the result of the Input.

For example, to store a value in register 364 as a signed, 16-bit integer, use Target Word Address [364#S16].

Note that the example uses a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.
**Password Protection:** Allows you to lock out access to numeric entry unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit. The selections are listed below:

- None
- Keyswitch Only
- Keyswitch and Password A
- Keyswitch and Password B
- Keyswitch and Password A or B
- Password A Only
- Password B Only
- Password A or B

Password protection must be validated each time the template is selected for numeric entry.

The template will not be displayed unless the operator provides the correct password or unlocks the security keyswitch wired to the PanelMate unit.

Password A and Password B are defined in the **System Parameters - Password Tab** dialog box.

The security keyswitch is an option that may be ordered as a spare part from the Cutler-Hammer Customer Service Department. Note that a security keyswitch cannot be connected to the PanelMate Power Series 1500 and are not available for PanelMate PC.
Variable-Sized Display Template

Variable-Sized Display Templates are designed to replace LED or LCD message units or display readouts. They are most effective when used for informational messages (e.g., prompting or diagnostic information).

![Motor Overtemperature]

The actual creation of the message is done in the Message Library selected from the Variable-Sized Display Template - Expressions Tab dialog box.

The Variable-Sized Display Template consists of three tabbed dialog boxes that are listed below.

- Variable-Sized Display Template - VS Display Attributes Tab
- Variable-Sized Display Template - Expressions Tab
- Variable-Sized Display Template - Control Definitions Tab
Variable-Sized Display Template – VS Display Attributes Tab

The Variable-Sized Display Template - VS Display Attributes Tab dialog box is shown below.

The fields in the Variable-Sized Display Template - VS Display Attributes Tab dialog box are described below.

Pixel Location

X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Display Template.

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Display Template.
Template Size In Characters

Height: Displays the height of the Variable-Sized Display Template as 1. This value cannot be changed.

Width: Allows you to enter the width of the Variable-Sized Display Template. Note that you can also re-size the width of the template by dragging the middle selection handle (square) on the right of the template.

Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and graphics that lie within the area of the variable-sized template to be refreshed to properly reflect the layering of objects on the page whenever the template is updated.

Direction: Allows you to select the orientation in which the message is displayed. The selections are Horizontal (left-to-right) and Vertical (top-to-bottom).

Enable Conditional Visibility: Allows you to determine if the Variable-Sized Display Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Variable-Sized Display Template – Expressions Tab

The Variable-Sized Display Template - Expressions Tab dialog box is shown below.

The fields in the Variable-Sized Display Template - Expressions Tab dialog box are described below.

**Message Expression:** Allows you to enter a message expression in the Variable-Sized Display Template. The result of the Message Expression represents the number of the message from the Message Library that will be displayed.

If the Message Expression results in a number greater than the maximum number allowed in the Message Library or less than 0 when running online, the previously displayed message will be erased.

If the message expression results in an invalid equation (e.g., division by a value of zero, etc.), no message displays. If a message expression previously resulted in a valid value, but in a later scan results in an invalid equation, the previously displayed message will be erased.

To display a message based on a bit, multiply the bit reference times the message number to produce the message number. For example, to display message #25 when bit [127 14] is on, enter [127 14]*25 in the Message Expression field.
The message expression can be as simple as a word reference (e.g., [253]) or a mathematical expression which solves to a value corresponding to a message number (e.g., [254]+12). The message expression can contain multiple PLC references. Note that the preceding examples are shown using a generic format. Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

When the Message Expression is true, embedded references are updated on the screen and not sent to the printer. Messages configured for BOTH or PRINTER are sent to the printer when the Message Expression changes and also when changing pages.

Note that when going to a new page that has non-global messages, messages set for PRINTER or BOTH will print once for each PLC reference in the message expression. Non-global messages on a page set for PRINTER or BOTH will print when returning from the Alarm Page, Screen Blanking, and when pressing the Enable Fault Relay control button, since these actions are treated as page changes.

When running online, if the message expression results in a value less than 0 or greater than permitted, then the previously displayed message will be erased.

Refer to the list of Conditional Expression Operators for more information.
The Variable-Sized Display Template also supports the display of ASCII strings from the PLC. To display ASCII strings, place the starting address of the ASCII characters within the Message Expression field, followed by the format specifier #ASC which then is followed by the number of characters to be displayed. When the PanelMate unit recognizes an ASCII format specifier (#ASC) in the message expression, the PanelMate unit will display the ASCII string from the PLC. Optionally, a byte-swap format specifier, #BSW, can be added to swap the order of character presentation on a word-by-word basis. The following table shows a block of generic PLC registers and the decimal, hex, and ASCII values for the registers.

<table>
<thead>
<tr>
<th>Registers</th>
<th>Decimal Value</th>
<th>Hex Value</th>
<th>ASCII Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>16706</td>
<td>4142</td>
<td>AB</td>
</tr>
<tr>
<td>101</td>
<td>17220</td>
<td>4344</td>
<td>CD</td>
</tr>
<tr>
<td>102</td>
<td>17734</td>
<td>4546</td>
<td>EF</td>
</tr>
<tr>
<td>103</td>
<td>18248</td>
<td>4748</td>
<td>GH</td>
</tr>
<tr>
<td>104</td>
<td>18762</td>
<td>494A</td>
<td>IJ</td>
</tr>
<tr>
<td>105</td>
<td>19276</td>
<td>4B4C</td>
<td>KL</td>
</tr>
<tr>
<td>106</td>
<td>19790</td>
<td>4D4E</td>
<td>MN</td>
</tr>
<tr>
<td>107</td>
<td>20304</td>
<td>4F50</td>
<td>OP</td>
</tr>
<tr>
<td>108</td>
<td>20818</td>
<td>5152</td>
<td>QR</td>
</tr>
<tr>
<td>109</td>
<td>21332</td>
<td>5354</td>
<td>ST</td>
</tr>
</tbody>
</table>

If the following expressions are entered in the Message Expression field, the string will be displayed as shown below.

<table>
<thead>
<tr>
<th>Message Expression</th>
<th>Displayed String</th>
</tr>
</thead>
<tbody>
<tr>
<td>[100#ASC20]</td>
<td>ABCDEFGHIJKLMNOPQRS</td>
</tr>
<tr>
<td></td>
<td>T</td>
</tr>
<tr>
<td>[100#BSW#ASC20]</td>
<td>BADCFEHGJILKNMPOQRST</td>
</tr>
<tr>
<td>[105#ASC7]</td>
<td>KLMNOPQ</td>
</tr>
<tr>
<td>[105#BSW#ASC7]</td>
<td>LKNMPOQR</td>
</tr>
</tbody>
</table>

ASCII registers displayed in this manner will appear in normal font with white foreground and black background. These display attributes (font size, foreground color, and background color) may be changed by defining them in the first two words of the string.
The most significant byte of the first word must contain a 1. This will signal the PanelMate unit that the attributes are to be altered. The least significant byte of the first word must contain the font size key.

- 01 = Normal
- 02 = Graphic
- 03 = Double-High
- 04 = Quad

The most significant byte of the second word contains the foreground color, and the least significant byte contains the background color. The colors are numbered 1 through 255 and can be determined by using the Color Palette in the Configuration Software, counting left to right and top to bottom (e.g., black=1, blue=2, green=3, cyan=4, red=5, magenta=6, yellow=7, etc.). Refer to the examples below.

Examples:

If register 98 has a value of 260 (Hex 0104), and register 99 has a value of 1287 (hex 0507), then the message [98#ASC6] would display the string ABCDEF in Quad font with red characters on yellow background.

If the byte swap format is used, then the bytes of the first two words need to be swapped. Register 98 will have a value of 1025 (hex 0401) and register 99 will have a value of 1797 (Hex 0705). The message [98#BSW#ASC6] would then display the string BADCFE in Quad font with yellow characters on a red background.

**Test Message Number:** Allows you to enter a test message number. To view a message on the page during configuration, a message number may be entered into the Test Message field. The message corresponding to this number will be displayed at the Variable-Sized Display Template’s origin. If there is not a message defined for that number, the template will be blank.
**Global Message:** Allows you to determine if the Variable-Sized Display Template will be a global message. To make a Variable-Sized Display Template global, select the Global Message box. The selection allows the PanelMate unit to monitor other Variable-Sized Display Templates not on the page being displayed in Run Mode. (Normally, the PanelMate unit only monitors the Variable-Sized Display Templates on the currently-visible page in Run Mode.) Templates on other pages are referred to as "global" templates.

Any Global Message triggered during online operation will be sent to the printer if they have destination settings of Printer or Both. Global Messages are not sent to the screen if the page where they were configured is not visible.

Global Messages only print when the Message Expression changes, not when the embedded references change. When you change to a page with Global messages, the Global Message will not print. If a hard-coded value (e.g. 100) is placed in the Message Expression, the Global Message will print only once at bootup.

*<Message Library>*: Opens the **Message Library** dialog box. Refer to the **Message Library** topic for more information.
Variable-Sized Display Template – Control Definitions Tab
The Variable-Sized Display Template - Control Definitions Tab dialog box is shown below.

The Variable-Sized Display Template - Control Definitions Tab dialog box defines the control buttons on your PanelMate unit. If a control button is defined, a small arrow will display in the lower left corner of the template to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 00] to 1. When the button is released, a separate command is sent to set the bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.
The fields in the **Variable-Sized Display Template - Control Definitions Tab** dialog box are described below.

**Control Indicator**

**Position:** Allows you to select the position inside of the Variable-Sized Display Template for control indicator arrow. The selections are listed below.

- Left
- Below
- Right
- Above

**Display:** Allows you to determine if the arrow will always be visible or visible only when the template is selected. The selections are Always and On Selection.

**Control Label/PLC Bit Reference:** Displays the control button labels and the associated PLC Bit Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at that location.

**Control Label:** Allows you to enter the control button label. The Control Label field accepts three lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the desired location. Note that on the configuration page, the text displayed in the control button will be truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to the next line, you can eliminate a carriage return in some cases.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the **Configuration Properties** dialog box.

**FG:** Allows you to select the foreground color or intensity for the control label. The FG button will display the standard Color Selection Palette.

**BG:** Allows you to select the background color or intensity for the control label. The BG button will display the standard Color Selection Palette.

**PLC Bit Reference:** Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. Expressions or conditional logic cannot be entered.
Variable-Sized Graphic Template

Variable-Sized Graphic Templates are similar in function and purpose to Indicator Templates except that the Indicator Template uses a pre-defined graphic while the Variable-Sized Graphic Template uses user-defined symbols for status indication. For more information on creating symbols, refer to the Make Symbol topic.

Variable-Sized Graphic Templates can be used to indicate the status of a device and to control the device (e.g., by turning it ON or OFF). There are five lines to define the various states of the device. To tie a state to information in the PLC, a conditional expression may be entered which, when evaluated to true, displays the characteristics defined in the Pen and Fill fields for the Variable-Sized Graphic Template. The expression may be as simple as the condition of a single bit in the PLC (true = ON; false = OFF), a value comparison (register > constant), or a Boolean expression of up to 70 characters in length.

Note that when you select the Variable-Sized Graphic Template from the tool palette and click on the configuration page, the Select Symbol dialog box will appear. Select a symbol and click the OK button. The symbol you select is only a placeholder for the Variable-Sized Graphic Template you will configure.

The Variable-Sized Graphic Template consists of three tabbed dialog boxes that are listed below.

- Variable-Sized Graphic Template - VS Graphic Attributes Tab
- Variable-Sized Graphic Template - VS Graphic States Tab
- Variable-Sized Graphic Template - Control Definitions Tab
Variable-Sized Graphic Template – VS Graphics Attributes Tab

The Variable-Sized Graphic Template - VS Graphics Attributes Tab dialog box is shown below.

The fields in the Variable-Sized Graphic Template - VS Graphics Attributes Tab dialog box are described below.

**Pixel Location**

- **X**: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Graphic Template.
- **Y**: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Graphic Template.
**Alarm Device Name:** Allows you to enter a device name to be used as part of an alarm message. The Alarm Device Name field accepts normal-sized characters.

The name used in the Alarm Device Name field may be part of an alarm message. Be aware that only 25 characters for the Alarm Device Name will appear when the alarm message displays in Run Mode. The Alarm Device Name field allows you to enter more than 25 characters to allow for control key combinations for the redefined characters in the Font Editor. For more information on redefined characters, refer to the **Font Editor** topic.

**Refresh Affected Graphics Online:** Allows all other templates, variable-sized templates, and graphics that lie within the area of variable-sized template to be refreshed to properly reflect the layering of objects on the page whenever the variable-sized template is updated.

**Enable Conditional Visibility:** Allows you to determine if the Variable-Sized Graphic Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

**Visibility Expression:** Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Variable-Sized Graphic Template – VS Graphic States Tab

The Variable-Sized Graphic Template - VS Graphic States Tab dialog box is shown below.

The fields in the Variable-Sized Graphic Template - VS Graphic States Tab dialog box are described below.

Symbol Name/Conditional Expression/Alm/Ack: Displays symbol names, conditional expressions, alarms, and alarm acknowledgments configured for the Variable-Sized Graphic Template. If the conditional expression evaluates to true, the associated symbol will be displayed in Run Mode. Each Variable-Sized Graphic Template can display up to five symbols, depending upon conditions you define. Each line in this list represents one of the symbols.

Symbol: Allows you to enter the name of the symbol to be displayed when the corresponding conditional expression becomes true.
Conditional Expression: Allows you to enter a conditional expression. The conditional expression can be a numerical, logical or relational expression that evaluates to true or false. When a numerical expression is evaluated if the result is even (least significant bit = 0), the value is false, and if the result is odd (least significant bit = 1), the value is true.

In Run Mode, if an expression is satisfied (true or false), the characteristics defined for that line are used to display the template. If more than one expression is satisfied at the same time, the line with the highest priority displays. Line 1 has the highest priority and line 5 has the lowest.

When an expression results in an invalid equation (e.g., division by zero, etc.), no value or graphics are displayed.

If a true expression goes false in a later scan, the display for the true expression is erased.

Refer to the appropriate Communication Driver Manual for information regarding the format for specific PLC word references.

Refer to the list of Conditional Expression Operators for more information.

Override Colors: Allows you to select colors for a symbol that displays as a result of a conditional expression. These colors are used instead of the colors defined when the symbol was created. A symbol’s objects for which the foreground or background is configured as None (transparent) are not affected by the Override Colors.

Pen: Allows you to select the foreground color or intensity for the symbol. The Pen button will display the standard Color Selection Palette.

Fill: Allows you to select the background color or intensity for the symbol. The Fill button will display the standard Color Selection Palette.
Alarm

**Alarm:** Allows you to designate any line of the template definition as an alarm state. If the Alarm box is selected and the conditional expression evaluates to be true, an alarm message will be placed in the alarm list and sent to the printer if one is configured.

If the Alarm box is selected, the condition associated with the alarm will be monitored at all times, regardless of the page being displayed. Judicious use of the alarm state is recommended to maximize the response time of the PanelMate unit.

**Acknowledge:** Allows you to determine if the associated alarm must be acknowledged before the alarm is removed from the alarm list.

If the Acknowledge box is selected, the operator must acknowledge the corresponding alarm message before the alarm will be removed from the alarm list. If the Acknowledge box is not selected, the alarm message will be automatically removed from the list when the alarm condition clears.

Note that a cleared alarm message will be sent to the printer if one is configured.

**<Symbol Library>:** Opens the Select Symbol dialog box. Refer to the Select Symbol topic for more information.
Variable-Sized Graphic Template – Control Definitions Tab

The Variable-Sized Graphic Template - Control Definitions Tab dialog box is shown below.

The Variable-Sized Graphic Template - Control Definitions Tab dialog box defines the control buttons on your PanelMate unit. If a control button is defined, a control arrow will display inside the symbol at its origin to indicate to the operator that a control function is available.

When a control button is pressed, the PanelMate unit sends a command to the PLC to set the referenced bit (e.g., [120 00]) to 1. When the button is released, a separate command is sent to set the bit to 0, thus providing a momentary input to the PLC. If a maintained input is desired, the bit may be latched in PLC logic.
The fields in the **Variable-Sized Graphic Template - Control Definitions Tab** dialog box are described below.

**Control Indicator**

Since the default location of the control arrow for a Variable-Sized Graphic Template is placed inside the symbol at its origin, the control arrow may be overwritten even if the Control Indicator Display field is configured as Always. To avoid overwriting the control arrow, reposition the control arrow to the left of the symbol origin by eight pixels by configuring the Control Indicator Arrow X and Y fields.

- **X**: Allows you to move the control indicator arrow in the Variable-Sized Graphic Template to the left or right. Note that this field is disabled until you configure the Control Label field or the Bit Reference field.

- **Y**: Allows you to move the control indicator arrow in the Variable-Sized Graphic Template up or down. Note that this field is disabled until you configure the Control Label field or the Bit Reference field.

**Arrow**: Allows you to choose the position of the control indicator arrow. The selections are listed below.

- Right
- Left
- Up
- Down
- Right/Up
- Right/Dn
- Left/Up
- Left/Dn

**Display**: Determines if the arrow is always visible or visible only when the template is selected.

**Control Label/PLC Bit Reference**: Displays the control button labels and the associated PLC Bit Reference. Line 1 corresponds to the top control button; line 2 corresponds to the next control button down, etc. It is not necessary to use all control buttons. Simply leave a line blank if you do not want a control button at that location.
**Control Label:** Allows you to enter the control button label. The Control Label field accepts three lines of normal-size alphanumeric characters. Use spaces or a carriage return to move the text to the desired location. Note that on the configuration page, the text displayed in the control button will be truncated; but when in Run Mode, the text will automatically wrap to the next line. If the text wraps to the next line, you can eliminate a carriage return in some cases.

The Control Label field has an auto centering capability. If you wish to center the Control Label, check the Control Button Labels box in the Auto Centering field in the Configuration Properties dialog box.

**FG:** Allows you to select the foreground color or intensity for the control label. The FG button will display the standard Color Selection Palette.

**BG:** Allows you to select the background color or intensity for the control label. The BG button will display the standard Color Selection Palette.

**PLC Bit Reference:** Allows you to enter a PLC bit reference. The PLC Bit Reference field accepts alphanumeric characters that define the PLC bit to be set while an operator presses the corresponding control button. Expressions or conditional logic cannot be entered.
Variable-Sized Control Button Template

The Variable-Sized Control Button is a one-touch button you can place anywhere a template or element can be placed. The Direct Select (Touchscreen Only) feature is intended for use on PanelMate touchscreen units and PanelMate NT units only. This template is intended for use with touchscreen units and should be used with the Direct Select feature in the System Parameters - General Tab dialog box. If the Direct Select feature is not enabled or if you use the Variable-Sized Control Button Template on a touchpanel unit, it becomes a two-step (select and execute) button.

The Variable-Sized Control Button Template is used to provide a momentary control to the PLC (e.g., start and stop machinery) or to issue a local page change command.

⚠️ CAUTION: When placing a Variable-Sized Control Button on a page to issue a page change command, make sure there is not a Variable-Sized Control Button occupying the same location on the destination page. If multiple touches are attempted on the Variable-Sized Control Button, all touches after the first will be applied to the destination page. This will cause the Variable-Sized Control Button on the destination page to be executed, thus possibly resulting in unintended machinery operation or unintended page changes.
When using the Variable-Sized Control Button Template to start machinery or to perform page changes, make sure you label the template clearly so it can be easily recognized and make the template large enough to ensure easy one-touch operation. This button is not labeled the same as standard control buttons. You must supply the appropriate dynamics graphics, static graphics, and/or text for the button. Note that if you wish to use a dynamic graphic to label the Variable-Sized Control Button, you must follow the steps below.

- Configure the Lens Color field in the **Variable-Sized Control Button - VS Control Button Attribute Tab** dialog box as transparent by selecting None for the color.

- Place the dynamic graphic and/or text behind the Variable-Sized Control Button by selecting the button and choosing the Bring to Front selection in the Object Menu.

If these steps are not performed, the areas in the Variable-Sized Control Button covered by the dynamic graphic used in the label will not respond to the touch.

The Variable-Sized Control Button Template consists of two tabbed dialog boxes that are listed below.

- Variable-Sized Control Button Template - VS Control Button Attributes Tab
- Variable-Sized Control Button Template - Control Definitions Tab
Variable-Sized Control Button Template – VS Control Button Attributes Tab

The Variable-Sized Control Button Template - VS Control Button Attributes Tab dialog box is shown below.

The fields in the Variable-Sized Control Button Template - VS Control Button Attributes Tab dialog box are described below.

Pixel Location

X: Allows you to enter the X-location of the upper-left corner of the Variable-Sized Control Button Template.

Y: Allows you to enter the Y-location of the upper-left corner of the Variable-Sized Control Button Template.

Size in Pixels

Height: Allows you to enter the height of the Variable-Sized Control Button Template in pixels.

Width: Allows you to enter the width of the Variable-Sized Control Button Template in pixels.
Refresh Affected Graphics Online: Allows all other templates, variable-sized templates, and graphics that lie within the area of the variable-sized control button to be refreshed to properly reflect the layering of objects on the page whenever the variable-sized control button is updated.

Lens Color: Allows you to select the color of the area inside the Variable-Sized Control Button. This button displays the standard Color Selection Palette.

Enable Conditional Visibility: Allows you to determine if the Variable-Sized Control Button Template will appear on a page based on the value of the Visibility Expression. If the Enable Conditional Visibility box is not checked, the template will always appear on the page.

It is important to note that a template, which is invisible because the Visibility Expression evaluates to false, will still impose the same memory and polling response impact as when the template is visible. Therefore, the visibility feature should not be used to circumvent page number or capacity limitations.

Visibility Expression: Allows you to enter a conditional expression if the Enable Conditional Visibility box is checked. If the Visibility Expression evaluates to false (equal to zero), the template will be erased and all template updating will be deactivated when in Run Mode. If the Visibility Expression evaluates to true (not equal to zero), the template will appear and all template updating will be activated when in Run Mode.
Variable-Sized Control Button Template – Control Definitions Tab

The Variable-Sized Control Button Template - Control Definitions Tab dialog box is shown below.

The fields in the Variable-Sized Control Button Template - Control Definitions Tab dialog box are described below.

**Type:** Allows you to select the type of control definition. The selections are described below.

- ** Normally Open, Momentary:** Defines the PLC bit reference to be set to 1 when the corresponding control button is pressed. When the control button is released, the PLC bit reference will be set to 0.

- ** Normally Close, Momentary:** Defines the PLC bit reference to be set to 0 when the corresponding control button is pressed. When the control button is released, the PLC bit reference will be set to 1.

- ** Normally Open, Maintained:** Defines the PLC bit reference to be set to 1 when the corresponding control button is pressed. When the control button is released, there is no action.
**Normally Close, Maintained:** Defines the PLC bit reference to be set to 0 when the corresponding control button is pressed. When the control button is released, there is no action.

**Toggle:** Defines the PLC bit reference to be set to the inverse of the last setting when the corresponding control button is pressed.

**Page Change:** Determines the page to be displayed when the page number is calculated in the Expression field. Note that the Expression field appears on the Variable-Sized Control Button Template – Control Definitions Tab dialog box when Page Change is selected in the Type field.

**Reference or Expression:** Depending upon your selection in the Type field, this box will be labeled Reference or Expression. The Reference field will be displayed if you select Normally Opened Momentary, Normally Closed Momentary, Normally Opened Maintained, Normally Closed Maintained, or Toggle in the Type field. The Expression field will be displayed if you select Page Change in the Type field. The selections are described below.

**Reference:** Allows you to enter the PLC bit to be set while an operator presses the corresponding control button. This field accepts alphanumeric characters. Expressions or conditional logic cannot be entered.

**Expression:** Allows you to determine the destination page when the corresponding control button is pressed. This field accepts numeric characters. Note that brackets are not required.
In this chapter, you will learn:

- About the Conditional Expression Operators
Conditional Expression Operators

The operators are listed in order of precedence. Level 1 has the highest precedence and level 14 has the lowest precedence. All operators on the same level are evaluated left to right. You can use parentheses to change the order of operation. For more information on the conditional expressions, refer to the Conditional Expression Examples topic.

<table>
<thead>
<tr>
<th>No.</th>
<th>Operator</th>
<th>Description</th>
<th>No.</th>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>sqr()</td>
<td>Square root</td>
<td>1</td>
<td>abs()</td>
<td>Absolute value</td>
</tr>
<tr>
<td>1</td>
<td>log()</td>
<td>Base 10 log</td>
<td>1</td>
<td>nlog()</td>
<td>Natural log</td>
</tr>
<tr>
<td>1</td>
<td>sin()</td>
<td>Sine</td>
<td>1</td>
<td>cos()</td>
<td>Cosine</td>
</tr>
<tr>
<td>1</td>
<td>tan()</td>
<td>Tangent</td>
<td>1</td>
<td>asin()</td>
<td>Arcsine</td>
</tr>
<tr>
<td>1</td>
<td>acos()</td>
<td>Arccosine</td>
<td>1</td>
<td>atan()</td>
<td>Arctangent</td>
</tr>
<tr>
<td>2</td>
<td>~</td>
<td>NOT (bit-wise)</td>
<td>3</td>
<td>exp</td>
<td>Exponential</td>
</tr>
<tr>
<td>4</td>
<td>**</td>
<td>Power</td>
<td>5</td>
<td>*</td>
<td>Multiply</td>
</tr>
<tr>
<td>5</td>
<td>/</td>
<td>Divide</td>
<td>5</td>
<td>%</td>
<td>Modulo</td>
</tr>
<tr>
<td>6</td>
<td>-</td>
<td>Subtract</td>
<td>6</td>
<td>+</td>
<td>Add</td>
</tr>
<tr>
<td>7</td>
<td>&gt;&gt;</td>
<td>Shift right</td>
<td>7</td>
<td>&lt;&lt;</td>
<td>Shift left</td>
</tr>
<tr>
<td>8</td>
<td>&lt;</td>
<td>Less than</td>
<td>8</td>
<td>&lt;=</td>
<td>Less than or equal to</td>
</tr>
<tr>
<td>8</td>
<td>&gt;</td>
<td>Greater than</td>
<td>8</td>
<td>=&gt;</td>
<td>Greater than or equal to</td>
</tr>
<tr>
<td>9</td>
<td>=</td>
<td>Equal to</td>
<td>9</td>
<td>&lt;&gt;</td>
<td>Not equal to</td>
</tr>
<tr>
<td>10</td>
<td>&amp;</td>
<td>AND (bit-wise)</td>
<td>11</td>
<td>^</td>
<td>XOR (bit-wise)</td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td>OR (bit-wise)</td>
<td>13</td>
<td>&amp;&amp;</td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td>Logical OR</td>
<td></td>
</tr>
</tbody>
</table>

Note the following items:

- All operators must be lower case when entered in a conditional expression.
- The results of all trigonometric functions are in radians.
- A space is required before and after the exp operator. For example: 2 exp 5.
Conditional Expression Examples
The following conditional expression examples are grouped into categories. Refer to
the sections below.
Note that spaces are not required between references.

General Examples
The following general examples are shown using a generic format. See the
appropriate Communication Driver Manual sent with your PanelMate software for
more specific information.

[204 06]
A conditional expression can be as simple as a single bit reference that resolves
to true if the bit is on.

[204 03] && [204 04] && [205 07]
This conditional expression resolves to true if bit 3 of word 204, bit 4 of word
204, and bit 7 of word 205 are all on.

[35] >500
This conditional expression resolves to true if the value of word 35 is greater
than 500.

[?]*(?[?]>=0)*([?]<100)+([?]<0)*[123]+([?]>100)*[123]
This conditional expression limits entries between 0 and 100 to the PLC register.
Any value outside this range has no effect on the value in the register.

Trigonometry Function Examples

sin([1]) will return the sine of the contents of register 1.

abs([1]) will return the absolute value of the contents of register 1.
Bit-wise Function Examples (using 8 bits)

Bit-wise functions produce numerical answers based on the numerical values of the operands and the operation being performed. Assume [1] contains the value 5 (0000 0101 binary) and [1] contains the value 6 (0000 0110 binary).

\[-[1] = -(0000 0101) = 1111 1010\]

\[[1] \& [2] = 0000 0101 \& 0000 0110 \]
\[--------------\]
\[0000 0100 = 4\]

\[[1] | [2] = 0000 0101 | 0000 0110 \]
\[--------------\]
\[0000 0111\]

\[[1] ^ [2] = 0000 0101 ^ 0000 0110 \]
\[--------------\]
\[0000 0011\]

\[[1] >> 2 = 0000 0101 >> 2 = 0000 0001 = 1.\]

\[[1] << 3 = 0000 0101 << 3 = 0010 1000 = 40.\]
Logical Function Examples
Logical functions produce answers that are either TRUE (1) or FALSE (0) by performing operations on their operands using either their numerical value for comparisons or their logical value such that FALSE = 0 and TRUE = anything but 0 (zero). Assume that the address [1] contains the value 5, the address [1] contains the value 6, and the address [3] contains the value 0.

\[ \begin{align*}
[1] > [2] & = 5 > 6 = \text{false} = 0. \\
[1] < [2] & = 5 < 6 = \text{true} = 1. \\
[1] \| [2] & = 5 \| 6 = \text{true} \| \text{true} = \text{true} = 1. \\
[2] \&\& [3] & = 6 \&\& 0 = \text{true} \&\& \text{false} = \text{false} = 0.
\end{align*} \]

Note that =, <>, >=, and <= work similarly.

Exponential Function Examples

\[ \begin{align*}
[1] ** [2] & = 5 ** 6 = 5 \text{ raised to the } 6^{th} \text{ power.} \\
[1] \exp [2] & = 5 \exp 6 = 5 \times 10 \text{ raised to the } 6^{th} \text{ power.}
\end{align*} \]
In this chapter, you will learn:

- About the Communication Driver Help Files
Communication Driver Help Files

Cutler-Hammer provides an online help file for some of the PLC models that can communicate to a PanelMate unit. These PLC help files provide detailed information about the configuration of your PLC. Refer to the PLC driver list in the Configuration Editor help file.

Note that if you click on a PLC driver help file in the list below and the PLC driver help does not appear, either the PLC driver and the associated help file was not installed or the PLC driver help file has been deleted.

For help on PLCs not listed, see the appropriate Communication Driver Manual.

For additional information on PLC communication, refer to the PLC Communication Guidelines topic.
PLC Communication Guidelines

In this chapter, you will learn:

- About the PLC Communication Guidelines
PLC Communication Guidelines

- Use the Correct Cables
  For proper communications, cables used to connect the PanelMate unit to the PLC must match the cable diagram shown in the manual. You may encounter cases where a cable worked in a previous PanelMate version but not on a newer version. Cable pinouts must match the cable as documented.

- Communication Error 1702
  If using unsolicited messages over Data Highway or Data Highway Plus and a communication error 1702 is received, check the part number of the EPROM on your Allen Bradley AcceleratI/On board. The EPROM needs to be upgraded to revision 06 (P/N 85-00285-06).

- Baud Rates Of 300 And Below
  Baud rates of 300 and below are not supported for PLC drivers.

- Serial Port Termination
  PanelMate units are shipped without serial port termination. For PanelMate Power Series RS422 and RS485 communication, you may have to change the termination on the PanelMate unit to 120 or 220 Ohm depending on PLC type and network.

  Refer to the PanelMate Power Series Hardware Installation Guide to set desired termination.

  For PanelMate Power Series 1500, termination is not done internally but is done externally at the communication port. Refer to the PanelMate Power Series 1500 Hardware Installation Guide for more information.
Word and Bit References

In this chapter, you will learn:

• About the Word and Bit References
Word and Bit References

This topic describes the word and bit formats used by the PanelMate unit for reading and writing data to/from the PLC.

PLC Word References

All of the editors use the same format for referencing PLC words. To refer to a specific word in any expression, use the following format ...

`[plcname,word#format]`

The fields plcname and #format are optional. If no information is entered in these fields, default values are used.

PLC Word Format Fields

- **plcname**
  
  The six character (or less) name of the designated PLC followed by a comma. The PLC name is defined in the PLC Name and Port Table dialog box. See the PLC Name and Port Table topic for more information about this name.

  If plcname is omitted, the default PLC (defined in the PLC Name and Port Table dialog box) is used.

  This field is optional.

- **word**

  The actual PLC reference number of the word to be read or written, using the addressing nomenclature of the PLC defined by plcname.

  See the specific PLC section for more information about word reference numbers.

- **#format**

  A three-character or four-character code preceded by a number sign (#). This code specifies the format of all PLC data read or written.

  If #format is omitted, the default formats will be used as noted in the Communication Driver Manuals.
The PanelMate unit recognizes the following formats ...

- **#S16**: Signed, 16 bit integer between -32768 and 32767 inclusive. The sign is defined by the high order bit.
- **#U16**: Unsigned, 16 bit integer between 0 and 65535 inclusive.
- **#S32***: Signed, 32 bit integer between -2,147,483,648 and 2,147,483,647 inclusive. The sign is defined by the high order bit.
- **#U32***: Unsigned, 32 bit integer between 0 and 4,294,967,295 inclusive.
- **#BCD3**: Three-digit binary coded decimal number between 0 and 999.
- **#BCD4**: Four-digit binary coded decimal number between 0 and 9,999.
- **#BCD6***: Six-digit binary coded decimal number between 0 and 999,999. The number is stored in two contiguous registers, three digits per register.
- **#BCD8***: Eight-digit binary coded decimal number between 0 and 99,999,999. The number is stored in two contiguous registers, four digits per register.
- **#BIN3**: Three-digit decimal number between 0 and 999.
- **#BIN4**: Four-digit decimal number between 0 and 9,999.
- **#BIN6***: Six-digit decimal number between 0 and 999,999. The number is stored in two contiguous registers, three digits per register.
- **#BIN8***: Eight-digit decimal number between 0 and 99,999,999. The number is stored in two contiguous registers, four digits per register.
32-bit floating point number between +/-1.20x10^-38 and 3.40x10^38 using the IEEE format. The 32 bits contain three fields:

1 sign bit

Eight-bit biased exponent

23-bit mantissa with a 24th implicit normalized bit.

The normalized bit is always 1 for non-zero numbers. The bit is recognized implicitly and not stored. The decimal point is placed immediately to the right of the implicit normalized bit.

The exponent has a bias of 7F HEX (127 decimal).

The mantissa is precise to seven decimal places.

The PanelMate unit does not convert the bits in the PLC to any other data type, but reads the bits as they are stored in the PLC. The PLC stores the bits as shown below ...

<table>
<thead>
<tr>
<th>MSB...</th>
<th>LSB</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Bit</td>
<td>8 Bits</td>
</tr>
<tr>
<td>Sign</td>
<td>Exponent</td>
</tr>
</tbody>
</table>

When the number of significant digits in a value exceeds the number of digits for the display, the value is displayed in exponential notation provided the length of the value field is equal to or greater than ...

- five for positive numbers
- six for negative numbers

The exponential format is ...

- [-]n.nnE-nn for negative exponents
- [-]n.nnE nn for positive exponents

Note that seven significant digits (not including the sign and decimal point) are valid. If the field is longer than seven significant digits, the additional information may be erroneous.
* When specifying these data formats, the address specified for word defines the first of the two registers (the one with the lower reference). This register will contain the most significant portion of the number.

When you send data to the PLC, the PanelMate unit deletes any high order bits above the range allowed.

BCD and BIN formats do not support negative values. Expressions can be used to scale values in the PanelMate unit so the operator enters and reads negative numbers, but positive numbers are written to or read from the PLC.

**PLC Bit References**

All of the editors use the same format for referencing PLC bits. To refer to a specific bit in any expression, use the following format ...

[plcname,bit]

The field plcname is optional. If no information is entered in this field, default values are used.

**PLC Bit Format Fields**

- **plcname**, the six character (or less) name of the designated PLC followed by a comma. The PLC name is defined in the PLC Name and Port Table dialog box. See the PLC Name and Port Table topic for more information about this name.

  If plcname is omitted, the default PLC (defined in the PLC Name and Port Table dialog box) is used.

  This field is optional.

- **bit** The actual PLC reference number of the bit to be read or written, using the addressing nomenclature of the PLC defined by plcname.

  See the specific PLC section for more information about word reference numbers.
Using Graphics from other Software

In this chapter, you will learn:

• About using graphics from other software
Using Graphics from other Software

You can cut and copy graphics from other window-based packages (such as CorelDraw and AutoCad) and paste the graphics into the Configuration Software using the Windows clipboard. The graphic will be converted to a bitmap or PowerGraphic. Once the graphic has been inserted, you can make it a symbol.

The other application must be able to output to the Windows clipboard in a Windows bitmap or metafile format.
Editing Graphics

In this chapter, you will learn:

• About editing graphics
Editing Graphics

You can use the keyboard keys to move, resize, or select objects. The following lists some suggestions for using the keyboard keys.

- The **Arrow** keys will move the selected object(s) one pixel.
- The **SHIFT** key with the **Arrow** keys will move the selected object(s) five pixels.
- The **CTRL** key with the **Arrow** keys will re-size the selected object(s) one pixel.
- The **CTRL** and **SHIFT** keys with the **Right Arrow** and **Down Arrow** keys will re-size the selected object(s) five pixels. The object is re-sized proportionately in both axes.
- The **TAB** key will select the next object that was created on a page.
- The **SHIFT** and **TAB** keys will select the previous object that was created on a page.
- The **F2** key will open the **Object Properties** dialog box when the object is selected.

Keyboard keys used to select, resize, move, select next, or select previous objects will not function on a configuration page when another window has been selected. For example, if an object is selected and the cursor is placed inside of the color selection palette and the **Arrow** keys are used to select different colors on the palette, the **Arrow** keys cannot be used to move the selected object unless the configuration page and the object are re-selected. This also applies when an object is selected and the cursor is placed inside of the Select Font box or the Pen Width box on the toolbar.
Configuration Editor Problems

In this chapter, you will learn:

• Solutions to some common Configuration Editor problems
Configuration Editor Problems

Some common configuration editor problems and solutions are listed below.

For information on online or transfer problems, refer to the Online Operation User’s Guide or the Transfer Utility User’s Guide.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
</table>
| Configuration Editor could not open the database. | 1. Share.exe is not loaded.  
2. The NetNamePath in the win.ini file under [Paradox Engine] is not pointing to a valid pathname.  
3. pmconfig.db is not found in the specified directory.  
4. The database path in pmconfig.ini (in Windows directory) does not point to a valid database. | 1. Load share.  
2. Change the path to the correct database directory.  
3. Ensure the path points to a valid database directory.  
4. Ensure the database path points to a valid database.  
Note that this is updated automatically when the database path is changed within the Configuration Editor. |
### Appendix G: Configuration Editor Problems

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause</th>
<th>Corrective Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>5. The database resides on a shared drive on a network and is currently open by another user.</td>
<td>5. Once the other user closes the database, you will be able to open it.</td>
<td></td>
</tr>
<tr>
<td>6. The Configuration Editor terminated abnormally through a General Protection Fault or hardware power failure and left the database in a “locked” state.</td>
<td>6. If you are <strong>absolutely sure</strong> the database is not open on your system, or another system from a network connection: delete the two lockfiles in the database, paradox.lck and pdoxusr.s.lck. Then, re-open the database.</td>
<td></td>
</tr>
<tr>
<td>The pull down menu font selection does not display all options when a large font video driver is used.</td>
<td></td>
<td>Use the arrow keys to view all font selections.</td>
</tr>
<tr>
<td>The error “General Protection Fault” occurs during an export of a configuration containing bitmaps.</td>
<td>Incompatibility with the video driver.</td>
<td>Replace the video driver with a standard Windows (VGA) driver and re-export.</td>
</tr>
<tr>
<td>The error “File exception occurred while reading database” appears in the Configuration Software while trying to export a configuration.</td>
<td>Insufficient disk space.</td>
<td>Ensure there is sufficient disk space where the Temp directory or folder is located.</td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause</td>
<td>Corrective Action</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Colors or blinks shown in the editor do not match those shown in the online unit.</td>
<td>1. Switching between Windows applications that use different color palettes.</td>
<td>1. Try switching out of the editor and back again or close the editor and re-open it. If these actions correct the problem, then the video driver has a bug. Proceed to corrective action 3.</td>
</tr>
<tr>
<td></td>
<td>2. The video driver selected in the Windows Control Panel is not a 256-color driver.</td>
<td>2. Select a 256-color driver from the video driver list in the Windows Control Panel.</td>
</tr>
<tr>
<td></td>
<td>3. The selected video driver has a bug.</td>
<td>3. Contact the video card manufacturer for an updated version that corrects this driver bug.</td>
</tr>
<tr>
<td>PanelMate Series 1500 unit has sluggish performance when layered symbols are used and the Conditional Visibility feature is enabled.</td>
<td></td>
<td>Install the Dynamic Graphics option and use Variable-Sized Graphic objects instead of layered symbols.</td>
</tr>
</tbody>
</table>
# Index

## A
- AB DH-485 Maximum Node Address, 133
- About This Manual, II
  - Purpose, II
  - What's Inside, II
- About PanelMate Configuration Editor, 44
- Active Rack Example, 137
- Advanced Trending Template Option, 3
- Allen-Bradley DH-485 Option, 4
- Allen-Bradley Remote I/O Setup, 134
- Arc Tool, 51

## B
- Backup Database, 11
- Bar Template, 200
  - Bar Template – Bar Attributes Tab, 201
  - Bar Template – Control Definitions Tab, 207
  - Bar Template – Expressions Tab, 203
- Bar Template Tool, 55
- Bar Trend Template, 220
- Bar Trend Template - Bar Trend Attributes Tab, 221
- Bar Trend Template – Control Definitions Tab, 230
- Bar Trend Template – Expressions Tab, 225
- Bar Trend Template Tool, 55
- Bit References, 331
- Bitmap Tool, 54
- Bulletin Board Service, IV

## C
- Clock and Calendar References within Messages, 155
- Color Display Option, 3
- Color Selection Palette, 47
- Communication Driver Help Files, 324
- Conditional Expression Examples, 319
  - Bit-wise Function Examples, 320
  - Exponential Function Examples, 321
  - General Examples, 319
  - Logical Function Examples, 321
  - Trigonometry Function Examples, 319
- Conditional Expression Operators, 318
- Configuration Editor Problems, 338
- Configuration Editor Reports, 26
- Configuration Editor Report Options, 28
- Configuration Properties, 69
- Conversion, 13
- Correspondence Address, V
- Customer Support Center, V

## D
- Danish1 Font, 83
- Database Treeview Window, 60
- DCSNet Interface Drop, 139
- DeviceNet Setup, 140
- DH-485 Maximum Node Address, 133
- Display Template, 247
  - Display Template – Control Definitions Tab, 254
  - Display Template – Display Attributes Tab, 248
  - Display Template – Expressions Tab, 250
- Display Template Tool, 56
- Driver Help Files, 324
- Dynamic Graphics Option, 4

## E
- Edit Menu, 31
- Editing Graphics, 336
- Ellipse Tool, 51
- E-mail and Website Address, IV
- Emergency Technical Support, III
- English Font, 81
- Export As, 19
- Export, 18
F
File Menu, 7
Font Editor, 78
French1 Font, 85
French2 Font, 87

G
GE Fanuc Genius I/O, 138
Generic Protocol, 132
Genius I/O, 138
German1 Font, 89
Graphic Font, 95
Graphics Editing, 336
Graphics from other Software, 334
Greyscale/Color Option, 4

H
Help Menu, 43
High Capacity Unit Option, 3

I
Import, 16
Indicator Template, 180
Indicator Template – Control Definitions Tab, 186
Indicator Template – Indicator Attributes Tab, 181
Indicator Template – Indicator States Tab, 183
Indicator Template Tool, 55
Information Fax-Back Service, III
Installing the Configuration Software, 2

K
Keyboard Shortcuts, 336

L
Line Tool, 51
Line Trend Template, 235
Line Trend Template – Control Definitions Tab, 244
Line Trend Template – Line Trend Attributes Tab, 236
Line Trend Template – Pen Definitions Tab, 240
Line Trend Template Tool, 56

M
Main Screen, 6
Make Symbol, 39
Message Library, 144
Modicon Modbus Option, 4

N
New Configuration, 62
New Configuration Page, 65

O
Object Menu, 33
Object Properties, 35
Object Properties – Attributes Tab, 36
Object Properties – Location and Size Tab, 37
Object Properties – Visibility Tab, 38
Online Labels, 158
Open Bitmap File, 54
Open Database, 9
Options, 3

P
Page Change with Delay Example, 124
Page Properties, 73
PLC Communication Guidelines, 326
PLC Name and Port Table, 126
PLC References, 328
Polygon Tool, 52
Port Settings, 130
Preface, I
Printing a Configuration Page, 30
Problems with the Configuration Editor, 338
Product Options, 3
256 Color/Greyscale Option, 3
Advanced Trending Temple Option, 3
Index

Product Ordering Service, IV

R

Readout Template, 188
Readout Template – Control Definitions Tab, 195
Readout Template – Expressions Tab, 191
Readout Template – Readout Attributes Tab, 189
Readout Template Tool, 55
Rectangle Tool, 51
Register References within Messages, 148
   Binary-Based Formats, 152
   Decimal Place Formats, 152
   Decimal-Based Formats, 152
   General Formats, 149
Reliance DCSNET Interface Drop, 139
Remote I/O Setup, 134
Repair and Upgrade Service, IV
Reshape Tool, 50

S

Save As, 12
Select Symbol, 53
Selection Tool, 50
Software Update Service, IV
Spanish1 Font, 91
Status Bar, 48
Support Services, III
Swedish1 Font, 93
Symbol Library, 98
Symbol Origin, 103
Symbol Origin Offset Example, 105
Symbol Properties, 100
Symbol Tool, 52
System Online Labels, 158
   System Online Labels – Alarm Text, 172
   System Online Labels – Contrast Adjustment Soft Key Prompts, 173
   System Online Labels – Display System/Configuration Info., 170
   System Online Labels – Error Messages, 167
   System Online Labels – Maintenance Template Soft Key Prompts, 162
   System Online Labels - Miscellaneous Soft Key Prompts, 160
   System Online Labels - Miscellaneous Text, 168
   System Online Labels – Setup Page, 165
   System Online Labels – Touchscreen Button Templates, 174
   System Online Labels – Touchscreen Control Keys, 176
   System Online Labels – Touchscreen Keypad Entry Labels, 175
   System Online Labels - Touchscreen Keypad Entry Soft Keys, 162
   System Online Labels - User Entry Soft Key Prompts, 163
   System Parameters, 108
   System Parameters – Communications Tab, 117
   System Parameters – General Tab, 109
   System Parameters – Password Tab, 113
   System Parameters – Remote Tab, 120

T

Table Template, 212
Table Template – Table Attributes Tab, 213
Table Template – Table Entries Tab, 217
Table Template Tool, 56
Technical Support Fax, III
Technical Support, III
Text Tool, 52
Tool Palette, 49
Toolbar, 45
Troubleshooting the Configuration Editor, 338
U
Unsolicited Device, 131
Upgrade Database, 10
Using Graphics from other Software, 334

V
V2.11 Export Errors, 24
V2.11 Export Guidelines, 22
Variable-Sized Bar Template, 264
  Variable-Sized Bar Template – Control Definitions Tab, 271
  Variable-Sized Bar Template – Expressions Tab, 267
  Variable-Sized Bar Template – VS Bar Attributes Tab, 265
Variable-Sized Bar Template Tool, 57
Variable-Sized Control Button Template, 310
  Variable-Sized Control Button Template – Control Definitions Tab, 314
  Variable-Sized Control Button Template – VS Control Button Attributes Tab, 312
Variable-Sized Control Button Tool, 57
Variable-Sized Display Template, 291
  Variable-Sized Display Template – Control Definitions Tab, 299
  Variable-Sized Display Template – Expressions Tab, 294
  Variable-Sized Display Template – VS Display Attributes Tab, 292
Variable-Sized Display Template Tool, 57
Variable-Sized Graphic Template, 301
  Variable-Sized Graphic Template – Control Definitions Tab, 307
  Variable-Sized Graphic Template – VS Graphic States Tab, 304
Variable-Sized Graphics Template – VS Graphic Attributes Tab, 302
Variable-Sized Graphic Template Tool, 57
Variable-Sized Indicator Template, 258
  Variable-Sized Indicator Template – VS Indicator Attributes Tab, 259
  Variable-Sized Indicator Template – VS Indicator States Tab, 261
Variable-Sized Indicator Template Tool, 56
Variable-Sized Readout Template, 277
  Variable-Sized Readout Template – Control Definitions Tab, 284
  Variable-Sized Readout Template – Expressions Tab, 281
  Variable-Sized Readout Template – VS Readout Attributes Tab, 278
Variable-Sized Readout Template Tool, 57
Verification Status, 21
Verify Application, 15
View Menu, 41

W
Website and E-mail Address, IV
Window Menu, 42
Word References, 328